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Preface

Preface

The EZ-C1 is the operation software for the Nikon Confocal Microscope C1.
The EZ-C1 can easily display not only simple 2D images, but also 3D images as well as 2D and 3D time series
images. And it can be accomplished by pressing a button once or twice.

Chapter 1, “Getting Started with EZ-C1,” describes the system configuration, how to switch between spectral and
standard modes and installation procedures for a C1-si system.

Chapter 2, “Basic Operations” describes basic operations and provides an overview of screen elements.
Chapter 3, “Common Tool Dialog Boxes” describes major functions.

Chapter 4, “Menu Functions” provides a detailed overview of display and analysis functions.

Chapter 5, “Hardware-related Settings” describes the configuration and use of the supported devices.
Chapter 6, “Visual Basic for Applications Support Functions” describes the use of macros in EZ-C1.

“A Experiment Sequence Macro” describes the methods to create and execute various macros.
“B Data File Formats” provides information on the file formats supported by EZ-C1.
“C Troubleshooting” includes information for solving hardware and software problems.

* EZ-C1 Version 3.90 for Vista does not support TE2000.

No part of this manual may be reproduced without Nikon’s permission.

The content of this manual is subject to change without notice.

Nikon has carefully prepared this manual. However, we make no expressed or implied warranty of any kind and assume
no responsibility for such errors or omissions.

Be sure to read the instruction manuals for the microscope and PC you plan to use with the EZ-C1.

HRequired knowledge
This manual was prepared for users having entry-level knowledge of Windows. If you encounter terms or tasks you do
not understand, refer to your Windows instruction manuals for more information.

BMTrademarks
Microsoft®, Windows® and Windows NT® are either registered trademarks or trademarks of Microsoft Corporation in the
United States or other countries.
Pentium is either a registered trademark or trademark of Intel Corporation.
Products and brand name are trademarks or registered trademarks of their respective companies.
The “TM” and ® marks are not used to identify registered trademarks and trademarks in these instructions.



Limitations and About the Viewer

Limitations and About the Viewer

HLimitations
EZ-C1 is subject to the following limitations, depending on system, connected dongles and analog output board
(PC attachable board for control of laser output) settings.

Four-laser unit Three-laser unit

Line sequential function

- Acquire Settings dialog box Enabled Disabled
- Line Channel observation mode
- Line Lambda tab

For the three-laser unit (when the four-laser unit is connected, the analog output board is required.)
With analog output board Without analog output
board

Laser light brightness control function

- Laser Control Bar dialog box Enabled Disabled

- “Laser Control” settings on the Laser tab in
the Confocal C1 option in the Configure
menu

Bleach function

- “Bleach” settings in the Variable Delay setup
sequence of the Time Series option in the
Acquire Settings dialog box

- “Bleach” settings on the Spots Of Interest
tab of the View Settings dialog box

- Bleach tab of the Confocal C1 option in the
Configure menu

HAbout the Viewer
The EZ-C1 Viewer software can be used to browse or process images acquired and saved by EZ-C1. Unlike
EZ-C1, EZ-C1 Viewer can be used without the C1 set. Only the hardware dongle (copy protection device) is
needed. However, EZ-C1 Viewer lacks the image acquisition and device control functions provided by EZ-C1.

Listed below are EZ-C1 menus not available in EZ-C1 Viewer:

- Under Configure
Confocal C1
Microscope Ti-E
Microscope TE2000-U/S
Microscope TE2000-E
Microscope E1000
Z-drive RFA
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- Under Tools
Acquire Bar
Acquire Mode Bar
Acquire Position Bar
Acquire Settings
Bi-Directional Scan
Gain Bar
Laser and Detector
Laser Control Bar
Laser Power Monitor
Time Series Progress
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Getting Started with EZ-C1

This chapter contains general information and directions on how to install and setup the software. Initially, this
chapter may be skipped if your dealer installed the software and setup the hardware. However, it remains a
valuable reference when you need to install the software on a new computer.

1.1 Parts

EZ-C1 Software is delivered with the following parts:
- EZ-C1 CD-ROM
- EZ-C1 dongle (hardware protection key)
- EZ-C1 instructions

1.2 Requirements

To run EZ-C1, we recommend a personal computer with the following specifications:
- OS: Version 3.90 for Vista ... Microsoft Windows Vista Business Service Pack1 32bit edition
Version 3.90 for XP ... Microsoft Windows XP Professional Service Pack3 or later
- CPU: Pentium IV operating at 3.4GHz or higher with Hyper Threading technology
- RAM: 2 GB or more
- HDD: SATA Il (SATA150), 7200rpm, 8MB Cache
At least 40MB of available disk space is required for installation.
Sufficient large and fast hard disk is required to save the images
Ex.) 4-ch image (512x512): 2MB, 32-ch image (512x512): 16MB
Monitor: a monitor and video adapter for 1600 x 1200 (UXGA) pixels in true color mode (24-bits)

Note
- Some PCs might not work in this environment. If this happens, please consult Nikon or its local
representatives.

The EZ-C1 software comes on a CD-ROM disk. Install the EZ-C1 software on your computer following the
instructions below. You may skip over this item if C1 hardware setup, installation of the application, and all
settings are complete.
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1.3.1 Network Settings

In order to use the C1 hardware, it is necessary to change your PC’s network settings. Please change the
settings according to the following example. The description of the following procedure assumes that there are
two network cards installed in the PC and that one of them is directly connected to the C1 controller with a
cross cable.

(1) Log in as a user account with administrator rights.
Network settings cannot be changed unless you log in as the administrator.
(2) Select “Network” from the Start menu, and right-click on the Network folder to select “Properties.”

Select “Manage Network Connections” from the Task menu in “Properties” dialog box. A “Network
Connections” dialog box (Figure 1.3-1) will appear.

Note
- For Windows XP, right click on the icon “My Network” on the desktop, and select “Properties” from the
popup menu. A “Network and Dial-up Connections” dialog box (Figure 1.3-1) will appear.

~iai
OO |@ ~ Control Panel ~ Metwork and Internet ~ Metwork Connections - - m ISearch @J

Organize =3 Yiews ¥ (7]
Mame |v| Stakus |v| Device Mame |v| Conneckivit

LAN or High-Speed Internet {1)

@ Local Area Connection Metwork, Broadcom Metktreme Gigabit Ethernet Access to Local and Internet

1 | i

Figure 1.3-1 Network Connections dialog box

(3) Confirm that the network card used to connect to the C1 controller appears in the name field in the
Network Connections dialog box (Figure 1.3-1). After confirming that the network card is registered, right
click on its name. Select “Properties” from the popup menu. If the “User Account Control (UAC)” dialog
box appears, click [Continue] button.

The “Local Area Connection 2 Properties” dialog box (Figure 1.3-2) will appear.
X

Metworking |

Connect using:

I El? Broadcom Met<treme Gigabit Ethernet

This connection uses the following itemns:

& Cliertt for Microsoft Metworks

Q Trend Micro MDIS 6.0 Filker Driver

QQDS Packet Scheduler

Q File: and Printer Sharing for Microsoft Networks
& |nternet Protocol YWersion B [TCP/PvE
- ) 4
<& Link-Laper Topology Discovery Mapper 1/0 Driver
& Link-Layer Topology Discovery Responder

Install Whirstall Properties

r— Description

Tranzmiszion Contral Protocol/nternet Protocol. The default
wide area network. protocol that provides communication
across diverse interconnected netwarks.

oK | Cancel |

Figure 1.3-2 Local Area Connection 2 Properties dialog box
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(4) Select “Internet Protocol Version 4 (TCP/IPv4)” on the “Local Area Connection 2 Properties” dialog box
(Figure 1.3-2). Then, select “Properties.”
The “Internet Protocol Version 4 (TCP/IPv4) Properties” dialog box (Figure 1.3-3) will appear.

Internet Protocol Yersion 4 (TCP/IP¥4) Properties d |

General

‘¥ou can get IP settings assigned automatically iF your network supports
this capability. Otherwise, vou need to ask vour network administratar
for the appropriate IP settings.

" Obtain an IP address automatically

—* lge the Following IF address:

IP address: I 192 168 , 255 253
Subnet mask: |255 L 255 255 . 248
Default gakeway: I . . .

= Ohbain DHE setver address automatically

—* Use the Following DMS server addresses:

Preferred DMS server; I . . .
Alternate DNS server; I . . .

Advanced. .. |
QK I Cancel |

Figure 1.3-3 Internet Protocol Version 4 (TCP/IPv4) Properties dialog box

(5) Set the IP address and subnet mask just as shown on the “Internet Protocol Version 4 (TCP/IPv4)
Properties” dialog box (Figure 1.3-3).

IP address *++192.168.255.253

Subnet mask ¢+ 255.255.255.248

1.3.2 Installing the software

Log in as a user account with administrator rights and load the EZ-C1 CD-ROM into the CD-ROM drive of the
PC. The installer will start automatically.

(1) First, click on “Install Hardware Protection Driver” and install the driver for the dongle.

Note
- If the selectable menu is not displayed, select “My Computer” - “Tools” - “Folder Options” - “View,”
uncheck “Hide file extensions for known file type.”

(2) Next, click “Install EZ-C1.”
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(3) A screen similar to the one shown below (Figure 1.3-4) will appear. Press the upper button in this screen

to install EZ-C1 or the lower button to install only Viewer.

i% Nikon EZ-G1

Welcome to the E2-C1 installation wizard.

Please press one of the buttons to make a selection of the features. l!ﬂ

L)
m Install EZ-C1 with C1 Contral and Yiewer modes,

'.a Install EZ-C1 with Viewer mode only.

Installzhield

Cancel

Figure 1.3-4 Installer screen

(4) Perform the steps indicated by the respective installer’s installation wizard.

Note

- If the installer does not launch automatically, launch the setup.exe program found on the EZ-C1
CD-ROM.

- If you purchased the AOM unit, you need to install the driver for NI-DAQ cards (one that is inserted
into the PC to control the laser power) separately from EZ-C1.

1.3.3 Setting up the EZ-C1 Dongle License

To run the EZ-C1 program, the EZ-C1 dongle must be plugged on a USB port of the PC.

1.3.4 Setting the C1 Hardware

Referring to Chapter 5, “Hardware-related Settings,” make the following settings for the items listed below.
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1.3.4.1 Setting the laser type

Select “Confocal C1” on the EZ-C1 “Configure” menu to display the “Configure Confocal C1” dialog box. Set
the wavelength corresponding to each of the lasers on the “Lasers® tab (Figure 1.3-5) of this dialog box (see

5.2.1).
For the three-laser unit system

Trigger ] Bleach ] Standard Detector ] Spectral Detector ]
Lazers Power Monitor ] Pinhole ] Mirrors ] Infor mation ]
Wizvelenath Shutter Laser Control
F"I |632.8 nm j |closed j m zetup ..
V¥ 2 [4880nm  w| |closed | m zetup .
W 3 [B436rm v | [closed | [z =] setup..
For the four-laser unit system
Trigger ] Bleach ] Standard Detector ] Spectral Detector ]
Lasers Power Monitor ] Pinhole ] Mirrors ] Infior mation ]
Wiavelength Shutter Laser Contral
F"I |63'.".D nm ﬂ |closed ﬂ l—_l setup ..
v 2 |4DB.EI nm ﬂ |closed ﬂ l—_l zetup ..
W a-1: [4579 nm | |closed | l—_l zetup ..
W3-z |4'."6.5 il ﬂ |c|osed j l__l setup ...
¥ 3-% |488.D nm ﬂ |closed ﬂ l—_l zetup ...
W 3-4 [B145nm | [closed ] [ =] setup..
¥ 4 |543.D hit ﬂ |closed ﬂ l—_l zetup ...
Figure 1.3-5 Lasers tab

1.3.4.2 Check the pinhole break delay

Set the pinhole on the “Pinhole” tab of the “Configure Confocal C1” dialog box.
Select the size of the pinhole in the “Selection” field shown in Figure 1.3-6 and check the pinhole stops in the

correct location with a catching sound.

Trigger ] Standard Detector l Spectral Detectar ]
Lazers ] Paower b anitor Finhole I tirrars Infarmation ]
Selection

" Use thiz fized pinhole:

30 um small

{+ Use the optimal pinhale

Break Delay

tode initial zetting ﬂ
Clockwise 3
Counter Clockwise 3

Figure 1.3-6 Pinhole tab

10
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1.3.4.3 Check the controller’s IP address

Check the controller’s IP address on the “Information” tab of the “Configure Confocal C1” dialog box.
The IP address set initially at startup will appear, not necessarily the one shown in Figure 1.3-7. Check
whether or not the IP address shown is as follows, and if it is different, correct it.

[IP address = 192.168.255.254

Trigger ] Standard Detector ] Spectral Detector ]
Lasers ] Pawer Manitar Pinhale ] Mirrars Infarmation
Information
Firrnwsare Y ersion: 300
IP address: | 192. 168 255 254

Standard Detector with 4 channels
Spectral Detector [WMHS45000)
Matorized Transmitted D etector

Figure 1.3-7 Information tab

1.3.4.4 Setting the channels

Set the number of channels to be used in the Channels in the Image field on the Standard Detector tab (Figure
1.3-8) on the Configure Confocal C1 dialog box.

Note
- Select “Trans” in Channels when the transmission detector is selected to acquire transmission
detector data to EZ-C1.

Lazers | Powser Monitor Prhols | Mirrors hfwmation |
Trigger | Bleach Stardard Detector | Spacteal Detechor |
Trarcemithed Light
Fitters & Mirors oM 1: OM 2 BA 2
[om 540 v|—[oMa®m -] —[BASEOLF =]
BRG] BA3 ]
BA BIBSD - [B-"' Bl -
Offzat
% Manual [Ted [ g [ arg [ e
Furto O fut |
Gain

F 1 Lirear Gain Mode
[¥ Pixel Time Cormsstion

Image
G e | o oo o e
Label [E1570 Fa0/E0 [sEDLP [Trans

Defaull Uolar - -

Figure 1.3-8 Standard Detector tab

11
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1.4 Uninstalling the EZ-C1

It is possible to remove the EZ-C1 software from the hard disk using the “Add/Remove Programs” utility found on
the “Control Panel” under “Settings” on the “Start” menu. To remove, use the “Add/Remove Programs” utility to
select the EZ-C1 entry, and press the [Change/Remove] button.

1.5 Starting the EZ-C1

CAUTION
- Turn on the C1 controller before starting up EZ-C1.

To start the EZ-C1 program, select the Windows “Start” — “Programs” — “Nikon” — “EZ-C1 3.90” —

“EZ-C1” menu entry (or the “EZ-C1 Viewer” menu entry to start Viewer) or double click the “EZ-C1 3.90” (or
“EZ-C1 3.90 Viewer” to start Viewer) shortcut on the desktop.

If the program does not start correctly, refer to the “C Troubleshooting” to solve the problems.

- When macros are installed at the first start-up of the EZ-C1 immediately after installation, a dialog box
prompting for your confirmation to load the macros appears. The macros selected here are automatically
loaded at the following start-up.

Auto-—Load New YBA Frojects

There are new projects in the shared projects folder.
Please indicate which prajects wou would like to load by default on startup.

Project
AutomatedGainezm
Golocalization.ezm
FRAPEzm

FRET.ezm

launcher Thumbnailler ezm
MultiPointTimeLapzeszm

[ B I

<

Select All Select Mone Cancel

- When the EZ-C1 starts, the profile selection dialog box appears. If the EZ-C1 has just been installed and
“C1.ezi” alone appears, select “C1.ezi.” (See 1.5.1.)

- Not all control dialogs may be visible after starting EZ-C1. The Tools menu lists the full range of available
toolbar (see 4.6). To hide or show one of the tool windows, select the corresponding entry from the Tools
menu.

- Best display results for images are obtained by setting the image color to “True Color.” To optimize the colors
of an image, open the “Image property” found on the “Control panel,” select the “Settings” tab, and select “True
Color” for the item “Image color.”

12
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Note
- Log in as a user account with administrator rights or Power User. Device settings cannot be
performed and EZ-C1 may not operate stably if you log in with other rights.

1.5.1 Selectiing a Profile

When the EZ-C1 starts, the Profile selection dialog box appears.
By selecting a profile, you can reuse previously saved settings and apply or modify them to launch the EZ-C1
in the desired configuration.

Profile: The Profile function allows you to save and reuse ini file settings. The ini file primarily contains
hardware configuration settings and screen layout. (For details, see Section 4.2.5, “Startup
Profile.”)

Select Startup Profile

W Show this dislog on startup

Mama | Path Duate
Clezi  C¥Program Files¥MikorWShared¥Profiles¥  2007/03/05 19:37€

Broweze Diefault

1.6 Exiting the EZ-C1

To exit the EZ-C1, quit the EZ-C1 application with the “Exit” on the “File” menu.

CAUTION
- Exit EZ-C1 before turning off the C1 controller.

1.6.1 Saving a Profile

When the EZ-C1 exits, it displays a dialog box prompting for your confirmation to save a profile.

Once a profile is saved, the settings in the profile can be reused the next time you start the EZ-C1.
Settings can be saved separately for each user, each experiment, or any other classification. Determine how
to save the ini file settings in the ezi file.

13
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Save the changes o the profile "C17 7

[~ Gave . ] Save Az Ho

Save: Saves the settings by overwriting the currently selected profile

Save As: Saves the settings as a profile with a different name from the currently
selected profile.

No: Does not save the profile.

14



2 Basic Operations

Basic Operations

Chapter 2, “Basic Operations” provides information on functions from acquiring spectral data to unmixing.

2.1 Structure of EZ-C1

The menu and tool dialog boxes of the EZ-C1 are shown below:

s8] 22 (0]
B ci-Live [
: 1 g | Lire Chanrl \
Sirgle |.Mera|u é.ﬂ i

o/
| Frae O !
T Tt | oy epieck 875

Cles | i Tire o
Y B

plions: [ine [ roomal  fesd | bindi 'l
pical devsll 240z ]| o TERD s
Finld sonm #A22un 1] »I 100 =
weps [ G2 v:[ w2 160 | 2 |[BZ | 2om|
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Menu functions:
(1) File (2) Configure (3) Data (4) Launcher (5) Macro (6) Tools (7) VBA (8) Window (9) Help
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2 Basic Operations

Tool dialog box functions:

(10) Acquire Settings tool dialog box
(11) Laser and Detector tool dialog box
(12) Gain Bar tool dialog box

(13) View Settings tool dialog box

The menu structure and primary functions are shown below.

Name Function Overview

(1) | File Open or save an image file. (See 4.1.)
(File related)

(2) | Configure Software setup should be based on the hardware configuration (e.g., device
(Device settings) or laser setup). (See 4.2.)

(3) | Data Process and analyze images (e.qg., filter processing and histogram). (See
(Image processing) 4.3)

(4) | Launcher Register and start other software. This function allows you handle images

acquired by C1 using the registered software. (See 4.4.)

(5) | Macro Use the default macro function.
(See 4.5))
(6) | Tools Select a tool dialog box to be used. See the diagram below for the tool
(Tool dialog box) dialog boxes displayed by default. (See 4.6.)
(7) | VBA Create new macros or bring up macros.
(macro) (See 4.7.)
(8) | Window Perform operations such duplicating and lining up image windows.

(Window operation) (See 4.8.)

(9) | Help Display EZ-C1 help or version information.
(See 4.9))
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2 Basic Operations

The structure and primary functions of tool dialog boxes are shown below.

Name Function Overview
(10) | Acquire Settings - Start and finish scanning.
(1: Scan control) - Select image acquisition mode.
- Set the scanning area.
- Set the laser irradiation time (scanning speed).
- Set the acquisition resolution.
- Select the objective data.
(See 3.3.)
(2: Image acquiring - Average (acquire averaged image)
mode settings) - Channel Series (acquire images for each channel)
- Z-stack (acquire XYZ images)
- Time Series (acquire images at set intervals)
(See 3.4.)
(11) | Laser and Detector Set the laser shutters, pinholes and make other settings (see 3.1).
(Detector status (See 3.1.)
display)
(12) | Gain Bar Adjust the Gain of each detector.
(Gain settings) (See 3.2.)
(13) | View Settings - Info: (image information)
(Image Display) - Color: (image colors and contrast)
- View: (image display format (1D, 2D, or 3D))
(See 3.5.)
Note

- To display another dialog box, select it from the Tools menu.
- A detailed description of the Laser Control Bar dialog box used to control the laser is given in Section

(see 3.6).

- A detailed description of the Laser Power Monitor dialog box used to monitor the laser power is given

in Section (see 3.7).
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3 Common Tool Dialog Boxes

Common Tool Dialog Boxes

Chapter 3, “Common Tool Dialog Boxes” describes major functions.

3.1 Laser and Detector (Laser and Detector Status Display)

Use the Laser and Detector dialog box to set laser shutters, pinholes and other settings for the standard

mode.
Lazer and Detector
Laser l_ j <00 ]l <57 | 476 J{IRTEAN 51+ i
Detectar Ch 2 Ch 3 Ch 4 TD
> e > >
Pirkiole o L -
Figure 3.1-1 Laser and Detector dialog box
Name Function Overview
@ This icon indicates the state of the laser safety interlock state of the microscope.
Interlock For safety, all laser shutters are closed when the microscope optical path is
switched to enable eyepiece observations and this button ﬁ flashes. (Laser
shutter opening/closing and image acquisition functions in applications are then not
operational.)
To return to confocal mode, press this button after switching the optical path of
the microscope to confocal acquisition mode.
Lol 514 IBTER 637 Open and close the laser shutters.
[Laser shutter] Turning this button ON and OFF switches the laser shutter between Close and

Automatic.

- The button indicates “laser wavelength” and its “color.”
- Black buttons indicate buttons for lasers that have been closed.

diE>» @Ay 88 | Specify the channel to be refreshed.

[Detector] - When a channel is specified to be refreshed, its button is shown in a color of
the channel display.
When a channel button is shown in the black, the channel will not be
refreshed.

- The button indicates a “Label for each channel.”
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3 Common Tool Dialog Boxes

TD in

[TD in/out]

Use this button to switch the optical path when a motorized transmitted light

detector is connected.

- When set to IN (depressed), the optical path is switched to the transmission
detector.

- When set to OUT (not depressed), the optical path is switched to the
diascopic illumination lamp.

n This button appears only when the motorized transmitted light detector is

installed.

0s -~

Pinhole

Set pinhole diameter.
S (30um), M (60 um), L (100 um), O (150um)

CAUTION

Please be sure to check that a transmitted illumination lamp is OFF before setting a Transmitted

Light Detector to IN.

(When your microscope has a Motorized Transmitted Light Detector, please check before pushing
the [PT] button or the [TD] button for making it IN. When your microscope has a Manual Transmitted
Light Detector, please check before making it IN manually. )

However, if your microscope is a “Motorized microscope” and is equipped with a Motorized
Transmitted Light Detector then you can only push the [PT] button or the [TD] button for making it IN
without consideration a transmitted illumination lamp is ON or OFF, it will turn OFF automatically.

3.2 Gain Bar (Gain Setting)

3.21 Gain Tab

Use the Gain tab of the Gain Bar tool dialog box to adjust the gain (i.e., the voltage to be applied to the photo

multipliers (PMTs)).

Use the Gain Bar to adjust detector gain. Set gain adjustment for each channel. Gain settings are assigned to
channels 1, 2, 3, and so on, in sequence, beginning with gain 1.

Gain | Offset |

® me/ [0 ] ] reset]

= mm [ B 4 J 2| reset|

* o [ ® 4 ] ] resst |
Trane | W00 4| | ks

Figure 3.2-1  Gain Bar dialog box

Gain Bar for the
standard detector

Name Function Overview
® 515750 Adjusts the gain for each standard detector that is the gain for all PMTs.
% 590/50 HV can be adjusted from 0 to 1250 V. Values are indicated in 255 steps.
®  E0LP
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3 Common Tool Dialog Boxes

reset

When the gain voltage is set too high for the intensity of light reaching the PMT,

[reset] the gain voltage is forcibly shut down to protect PMT. When this occurs, the
reset button flashes red.
Press the flashing button to readjust the gain. (The value returns to 0 after the
reset for safety reasons.)
Tranz

Transmission detector
Gain Bar

Adjusts the gain of the transmission detector.

n The image window flashes when too much gain is applied to the
transmission detector. The flashing stops when the gain is reduced to
permissible levels.

CAUTION

- The transmission detector Gain Bar dialog box appears when “Trans” is set in Order in the Configure |
Confocal C1 | Standard Detector tab (and transmission detector data is acquired).
It is not available when “Trans” is not set.

- The data appears in the order selected in Configure | Confocal C1 | Standard Detector tab.

- When the Linear Gain Mode in the Configure | Confocal C1 | Standard Detector tab is on, gain values
are indicated as logarithmic values (for example, 0.158 = 10%'° or5.08=10"").

3.2.2 Offset Tab

Use the Offset tab of the Gain Bar tool dialog box to set offset values for the voltages output from the photo

multipliers (PMTSs).

Gains can only be set with the PMTs in the standard mode.

Gain Bar %
Gain  Offset | fusto Offset [~
o sEm —TT 4 | —
o gpmy [ 10T 4 4 i
w emolp [ 187 4 i |
Trana | 12 Al A -

Figure 3.2-2 Offset tab of Gain Bar dialog box

Offset Bar for the
standard detector

Name Function overview
& 515730 Adjusts the offset value for the PMT output voltage of each standard detector.
®  500/50 Values are indicated in 255 steps.
®  650LP

Trang
(Transmission Detector
Offset Bar)

Adjusts the offset value for the PMT output voltage of each transmission
detector.
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3 Common Tool Dialog Boxes

Auto Offset Sets the offset values for PMT output voltage based on the PMT Calibration data

created by the Offset Calibration function.

n The C1 Offset Calibration dialog box opens if PMT calibration data has not
been created yet. For all PMTs excepting one for the transmission detector,
the offset values for PMT output voltage are measured by adjusting gain
and pixel dwell, until a calibration table is created.

(Incident light to the PMT must be blocked when creating this calibration
table.)

n For the C1 Offset Calibration dialog box, see the description of the [Auto
Offset] button in Section 5.2.8, “Standard Detector Tab.”

CAUTION
- The offset value for PMT output voltage of the transmission detector can only be adjusted manually. It
cannot be adjusted automatically by the Offset Calibration function.

3.3 Acquire Settings (1: Scan control)

3.3.1 Acquire Settings dialog box

The Acquire Settings dialog box (Figure 3.3-1) is used to control image acquisition. The Acquire Settings
dialog box is displayed by selecting Acquire Settings from the Tools menu.

Images can be acquired in various ways depending on the selected image acquisition mode. Check the
checkbox for the desired image acquisition mode in the Acquire Settings tool to set the parameters for each
mode. (See 3.4 “Acquire Settings (2: Image acquiring mode settings)”.) You can check multiple checkboxes to
enable a combination of multiple acquisition modes. Note that the order of processing is set such as first
Average, then Z-stack, and finally Time.

Keep in mind that if no image acquisition mode or line scan option is selected, 2D images are acquired (X and
Y) one slice at a time.
3.3.7
Scan range 3'3'!.! . .
3.3.3 indication Navigation window
Image acquisition mode

s | /

3.3.2 Lve >
Scan control Sinele :Hﬂii’?"“e' 0/4 -
0/?2
0/1
0/?2

3.34
Scan settings —

/

3.35 3.3.6
Line scan Scan mode

Figure 3.3-1 Acquire Settings dialog box
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3 Common Tool Dialog Boxes

3.3.2 Scan Control

The Scan control contains the following buttons.

Scan control Tz idle
# M Line Channel I
ingle || ml Averaee 0/4 a1 7
=]
= Trigeer | =;r—2rtnaecfh H ; % -
Clear W Time 0/? X Y
K Basic
options: [~ line | normal bi-dir |
pixel dwell | 240us < | » I 1590 fps
field zoom | 2122 um 4| [+ 1.00 x
steps  X:[ 512 v:[ 512 160 | 266 |[512 1024 | 2048 |
Name Function Overview
Live | Press this button to start or stop image acquisition. Images are repeatedly
acquired until the [Live] button is pressed again.
Single | Press this button to start image acquisition in a single sequence. Searching will
stop after a full scan is completed.
I Trigeer | This check box is checked to allow input of a trigger signal. Image input is
started after receiving a trigger. (See 3.3.2.1.).
_ Olesr | Press this button to clear the image data displayed on the selected window.
CAUTION

- Note that the above buttons perform different functions, depending on the image acquisition mode
selected. See 3.4 for more information of each mode.

3.3.2.1 Trigger Settings

To input trigger signals, enable the Trigger checkbox in the Acquire Settings dialog box. By using the [Trigger]
button, trigger settings can be made. In the Trigger function, an image acquisition starts triggered by a trigger
signal. (This function is only available when the trigger device is set.)

[T Trieeer |
Hardware Trieeer Setup @

[~ Enable Trigeered Acquisition;

Trigger timing

Each First
o ' (Frequency)

oK I GCancel |

Trigger timing _[ [Frame ~|
(observation mode)

Fig. 3.3-2 Trigger Setup dialog box
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3 Common Tool Dialog Boxes

The Trigger Setup dialog box provides the following functions.

Name Function Overview
Enable Triggered Enable or disable the Trigger function. This checkbox is changed together with the
Acquisition checkbox in the Acquire Settings dialog box.
Trigger timing The observation mode is set as a trigger timing. (See Note below.)
(observation mode) Frame: Waits a trigger for each frame acquisition. Minimum unit for a trigger
timing.
Frame/ Average/ Average: Waits a trigger for each Average image acquisition when the
Channel/ Z-Stack/ Average mode is selected.
Time Series Channel: Waits a trigger for each Channel Series image acquisition when the

Channel Series mode is selected.

Z-Stack: Waits a trigger for each Z-Stack image acquisition when the Z-Stack
mode is selected.

Time Series: Waits a trigger for each Time Series image acquisition when the
Time Series mode is selected.

Trigger timing Select a trigger timing according to the observation mode specified above.
(Frequency) Each: Waits a trigger for each observation mode when the selected mode is
executed.
Each/ First First: Waits a trigger for each observation mode when the selected mode is
started.
Note

- If the selected observation mode is not used, a trigger waiting is not performed.

- Start trigger setting when the observation mode is used:
Set “the observation mode” and “First” when the observation mode is used.
Set “the observation mode to be executed last” and “First” when multiple observation modes are
set. Note that the “execution order” of the observation mode is as follows: Average, Channel,
Z-stack, and Time Series.

- Trigger setting when the observation mode is not used:
Set “Frame” and “Each” or “First” when Single scanning is performed without using the
observation mode.
If “Frame” and “Each” or “First” is set when Live scanning is performed without using the
observation mode, trigger waiting is performed for each frame.

Example) When the Z-stack mode and Time Series mode are used:
To set a start trigger only: “Time Series” and “First”
To set a trigger for each interval of the Time Series mode: “Time Series” and “Each”
(=TZz-Stackl+TFirst])
To set a trigger for each Z slice of the Z-Stack mode: “Z-Stack” and “Each”
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3 Common Tool Dialog Boxes

3.3.3 Image Acquisition Modes

The Acquire Settings dialog box offers the following image acquisition modes.

Image acquision modes

T

Live 1/ idle —
T =Line Channel 071 [

nele Average - —
™ Trgasy MiFrame Ch 077 P ‘

———— Wl Z-stack 0/1

Clear \_ | Time 072 ¥ Y

XY Basic

options: [~ line | normal bi-dir |

pixel dwell 240us <] _+| 1590 fps

field zoom 2122 um 4 | 3| 1.00 x

steps  X:[ §12 v:[ 512 160 | 266 |[512 1024 | 2048

Name

Function Overview

Idle field

Displays the scanning status or warnings.

Idle: Scanning stops.

Scanning: Scanning

n When a long period of time is set for “pixel dwell,” if the scan speed
becomes 0.5 fps or lower, the progress bar is displayed. The progress bar
shows which line is being scanned in one frame.

Line Channel

Acquires the frame data while switching PASS (shutter, channel) when each line
is scanned. (See 3.4.2)

Average

Averages the acquired image to improve signal-to-noise ratios. (See 3.4.3)

Frame Channel

Acquires the frame data while switching PASS (shutter, channel, or pinhole) for
each frame. (See 3.4.4)

Z-stack

Allows 3D (X, Y, and Z) image acquisition (available only when Z-drive RFA or
Microscope TE2000-E is selected for Devices in the Configure menu; see 3.4.5).

Time (Time Series)

Records from 1D to 3D time series images. (See 3.4.6)

CAUTION

- For information on Image Acquisition modes, refer to Section 3.4, “Acquire Settings (2: Image acquiring

mode settings).”
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3 Common Tool Dialog Boxes

3.3.4 Scan Settings

The Scan control on the Acquire Settings dialog box (see 3.3.1) are used to set the scan period, field of view,
and scan resolution. The field of view and position are displayed in um. For a correct display of the physical
distances, the correct objective power is required.

Scan settings are following setting items.

Live | idle

M Line Channel |
Sinele | W Average 0/4 = w— 7
- Ml Frame Ch /2 I
I Trigger | o tack 077 <
Clear | miTime 072 x Y
XY Basic
options: [~ line | normal bi-dir
. pixel dwell 240 us ;u » I 1590 fps
seansettings field zoom 2122 um 4 | [ » I 1.00 x

steps  ¥:[ &12 ¥:[ 12 1ﬁEI| 255||512 1024|2t|48|

Name Function Overview

line This option acquires a mono-dimensional image in the X direction. The laser
executes scanning lines along with the X-axis (See 3.3.5.).

[normal] Scanning is performed in the normal scan mode (See 3.3.6.1.).

[bi-dir] Scanning is performed in the bi-directional scan mode (See 3.3.6.2.).

pixel dwell In this field, set a laser irradiation time for each pixel. If the amount of light is

small, the period is increased and the signal is integrated for an extended period

of time.

On the right side of the scroll bar, “a number of acquired frames per one second”

is displayed.

n The minimum period of time for the laser irradiation time setting varies
between in normal scan and bi-directional scan mode.

field zoom/ crop Decrease the field of view to zoom in. Increase the field of view to zoom out.

Alternatively, click on the zoom icon g| using the mouse to specify a new field

of view and position.

On the right side of the scroll bar, “a zoom ratio” is displayed. The ratio can be set

by entering a value

n When Zoom is selected on the XY tab, “field zoom” is displayed. When Crop
is selected, “field crop” is displayed.

steps Select the number of pixels along the X and Y-axes. Press the [160], [256], [512],
[1024], or [2048] button to obtain the square images with the indicated number of
pixels.

A number of pixels for 16 pixel step can be entered in the X or Y text box.

n Only [256] or [512] can be set for X in the bi-directional scan mode.
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3 Common Tool Dialog Boxes

3.3.5 Line Scanning

Enable the line checkbox in the Acquire Settings dialog box to perform the Line scanning. In the Line scanning,
a scan is performed along the X-axis and then one-dimensional image in the X direction is acquired. Set the Y
position of this line by using the Y position on the Navi tab or the Navigation window.

[ line

Note

- The Live window shows an 1D graph or 2D image according to the View setting in the View Settings
window. The 2D image is the image which displays the acquired line image in the Y direction in time
sequence.

- Line scanning is not possible for Z stack observation.

3.3.6 Scan Mode

“The normal scan mode” and “bi-directional scan mode” are switched by using the [normal] or [bi-dir] button in
the Acquire Settings dialog box. The scanning speed becomes faster in the following order: “the normal scan
mode” and “bi-directional scan mode.”

CAUTION
- Only the normal scan mode is available in the spectral mode.

3.3.6.1 Normal Scan Mode

The scanning is performed in the normal scan mode.

narmal

Name

Function Overview

[normal]

Scanning is performed in the normal scan mode.
(Scanning speed: approx. 1.0 f/s at 512 x 512)
Data of the maximum field of view can be acquired.

3.3.6.2 Bi-directional scanning

Scanning is performed in the bi-directional scan mode.

To set the bi-directional scan mode, select the [bi-dir] option in the Acquire Settings dialog box or the
Bi-Directional option in the Bi-Directional Scan bar (see 3.3.9). In the single directional scanning, the laser
scans in only outgoing path. In the bi-directional scan mode, both the outgoing and return paths are scanned.
This reduces the time required for scan acquisition.

bi-dir

Name

Function Overview

[bi-dir]

Scanning is performed in the bi-directional scan mode.
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CAUTION
- Single directional scanning and bi-directional scanning

X X

»
pune®®

.
2| [ e——

Single directional scanning  Bi-directional scanning

Bi-directional scanning:

- When the bi-directional scanning is performed, image shift occurs between the left-to-right scan and
the right-to-left scan. This shift can be corrected with the Adjust Scan setting on the Bi-Directional
Scan bar. (See 3.3.9.) Correct the shift while checking the image.

Twenty correction values can be saved for twenty sizes of field zoom. (See 3.3.4) The saved
correction value will be applied unless new correction value is saved for the field of view. (See
3.3.9))

- In the bi-directional scanning, [Bleach mode setting] and [Allow Rotation by mouse] are disabled.
(See 3.6 and 3.3.8.1.)
- In the bi-directional scanning, available pixel number by steps is 256 or 512.

Single directional scanning:

- For the four-laser unit, a special function works automatically. With this function, the specimen is
shielded from the laser light when moving the laser scanning point from the end point of a scan to
the next start point. When the three-laser unit and AOM are connected, this shielding function can
be turned on and off as desired. (See 5.2.1, “Lasers tab.”)

Note: CLEM mode
When CLEM equipment is connected, another scan mode is added: “CLEM” mode.
Select “CLEM” mode to scan using the CLEM equipment.

CLEM mode: CLEM scanning is possible under a lower than usual level of irradiation from
excitation light, which enables image acquisition without as much fluorescence
photobleaching of the sample. The dynamic range can be enlarged, and this mode
helps prevent loss of image quality. (See 3.9.)

nu:urmall clem bi-dir I

Name Function Overview

[clem] Scan in scan mode using CLEM equipment.
The CLEM equipment can be used in data acquisition.

n CLEM functions cannot be used when the four-laser unit is connected. They are enabled only
when the three-laser unit is connected.

27



3 Common Tool Dialog Boxes

3.3.7 Displaying the Scan Range

The currently set scan area is indicated by a rectangular parallelepiped (or a rectangle) inside the black
rectangular parallelepiped in the Acquire Settings dialog box (see 3.3.1).

The yellow line indicates the currently scanned position. For XYZ scan, the yellow line moves from top to
bottom along with the focal plane of the sample.

Live idle
[ Line Channel Scan range
Single Wl Average H :j gD indication
[ Trieeer | p z-stack 0/1
Clear W Time 0/2

Note

- A scan area on the XY plane is set by the x and y coordinates (see 3.3.8.2) or from the Navigation
window (see 3.3.8). The component of the scan area in the Z direction is set in Z-stack (see 3.4.5).

- To scan from bottom up in XYZ scanning, select the check box “Start Scan at Bottom” on the Z-Scan
tab (see 5.1.3) of the Configure menu Z-drive RFA (or Microscope TE2000-E).

3.3.8 Navigation window

3.3.8.1 Specifying a Scanning Area (Navigation Window)

When you click the [Navigation] button located in the Acquire Settings dialog box (see 3.3.1), a Navigation
window is displayed.

You can specify the position and size of a scanning area in the Navigation window and set the method for
specifying those positions and sizes on the XY tab.

Navigation button

ive idle
g I Line Channel
Single Wl Average B :i gﬂ
I Trieeer ¥ Z-stack 0/1
Clear W Time 0D/?

L WA« 512 piveld]
Specify the size:
Drag a white spot.
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Move:
Drag a spot inside
the white border.

Rotation:

Drag the handle (the white
spot protruding from the
border).

Figure 3.3-3 Navigation Window

Name

Function Overview

Specify the size

The size of a scanning area can be specified by dragging a white spot on the
white dotted line border in the image displayed in the Navigation window (see
Figure 3.3-3). While you are dragging, the size of the actual scanning area (um),
a ratio to the original image (x), and the size of the image (number of pixels) are
displayed on the right side of the cursor.

n Holding down the Shift key while dragging allows to zoom in or out with the
center of the scanning area fixed.

Move A scanning area can be moved by holding and dragging a spot inside the white
border (see Figure 3.3-3).
Rotate Select the option “Allow Rotation by mouse” (see 3.3.8.2) on the Navigation tab

to specify that the scanning area will be rotated.
Drag the handle (the white spot protruding from the border) to rotate the
scanning area. Angle of rotation can be specified in the range of —90 degrees to

90 degrees with respect to the horizontal position that is defined to be 0 degrees.
Rotating the scanning area cannot be used during a reciprocal scanning
(see 3.3.6.2).

3.3.8.2 Specifying a Scanning Area (XY Tab)

Scanning area can be specified on the XY tab. (See Figure 3.3-4.)
Use the XY tab to make the following settings.

' ] Like Lambda] P.verage] Frame Lambda ] s ] Time ]

wiriclom Show [ Allow Rotation by mouse

Zoom Fezet | Copy | Restore |

mode Loom Cirap

pixel-size axan nmE MOM-OPTIMAL PTHEL SI7E !

¥ position 00um 4| 1 |
Y position 00um 4| 1 v
angle 04 1 | resat

Figure 3.3-4 XY tab
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Name

Function Overview

Window group

[Show]

Display in the Navigation window appears or disappears by this button. This
button functions the same as the [Navigation] button in the Acquire Settings
dialog box.

Allow Rotation by
mouse

To rotate the scanning area, check this check box.
n This function is disabled in the bi-directional scan mode.

Zoom group

[Reset] Press this button to reset all settings to the initial condition at the start-up of the
Navigation window. The image on the Navigation window disappears.
[Copy] Press this button to capture the image in the Live window to the Navigation
window. The captured image is used as the reference to specify an area.
n If the scan settings are changed, this button is disabled until new image is
captured using [Live] or [Single].
[Restore] Press this button to specify the scanning area to the full image in the Navigation
window.
Mode group
[Zoom] The specified area is scanned with the number of pixels specified by steps in the
Acquire Settings dialog box. The resolution increases.
512 512
256 |-
- Zoom
[Crop] The specified area is scanned with the number of pixels existing in the specified

area. Although the resolution does not increase, the scanning time is reduced.
512
256 256

Crop

Try to use best pixel
size

If you select this option, an optimum pixel size is set based on the wavelength of
the laser and the N.A. of the objective.

However, the software may not be able to set the optimum pixel size. In such
cases, the message “WARNING: NON-OPTIMAL PIXEL-SIZE!” is displayed in
white at the mouse position being dragged or in red below this option.

pixel-size

Displays the size of 1 pixel. The size can be adjusted by entering a value.
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X position When the X position is increased, the scanning area moves in the positive
direction of the X-axis. When the X position is decreased, the scanning area
moves in the negative direction of the X-axis. It is also possible to specify the
position on the Navigation window by clicking the zoom icon ﬂ with the
mouse.

y position When the Y position is increased, the scanning area moves in the positive
direction of the Y-axis. When the Y position is decreased, the scanning area
moves in the negative direction of the Y-axis. It is also possible to specify the
position on the Navigation window by clicking the zoom icon ﬂ with the
mouse.

angle Specify the angle of the scanning area. The horizontal scanning angle is 0
degree. This value can be specified from -90 degree to 90 degree.
n This option cannot be used for the bi-directional scanning.

[reset] Resets the angle to zero.

3.3.9 Bi-Directional Scan bar

When you select Bi-Directional Scan from the Tools menu, a Bi-Directional Scan bar (Figure 3.3-5) is
displayed. In this bar, you can switch between reciprocal scanning (see 3.3.6.2) and one-way scanning and
correct a drift in images during reciprocal scanning.

Bi-Directional Scan =
BiDirectional: [~ Adjust Soan I 0.0 ﬂﬂ Feset |

Figure 3.3-5 Bi-Directional Scan bar

The Bi-Directional Scan toolbar provides the following functions.

Name Function Overview

Bi-Directional Switches between reciprocal scanning (see 3.3.6.2) and one-way scanning.
When you press the [Live] (or [Single]) button in Acquire Settings while this
check box is selected, reciprocal scanning is performed.

Adjust Scan Corrects a drift in the images scanned in the outgoing and return paths during
the reciprocal scanning. Select the “Live” and change the value while monitoring
the captured image to eliminate a drift.

[Reset] Sets the Adjust Scan value (drift correction value in the current field of view) to
0.0.

Note
- You cannot use Adjust Scan and [Reset] unless Bi-Directional on the Bi-Directional Scan bar or bi-dir
in Acquire Settings dialog box is selected.
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3.3.10 Acquire bar

The Acquire bar contains shortcut buttons for the Acquire Settings dialog box (see 3.3.1). The Acquire bar is
one of the dialog boxes (see 4.6) that can be displayed by checking the EZ-C1 “Acquire bar’ command of the
“Tools” menu. The Acquire bar contains the following buttons.

Acquire Bar X
OECED

Figure 3.3-6  Acquire Bar

Name

Function Overview

Show/hide Acquire Settings tool.

Start/stop scanning.

Increase Pixel dwell value (the acquisition speed is decreased).

Decrease Pixel dwell value (the acquisition speed is increased).

Displays the Navigation window (see 3.3.8).

\1@@@'&"”

Specify the CTE marker (current time event marker), which is one of time event markers.
This marker is used to set an event before or during an observation.

Clicking this button displays a period of time from “the time at which a marker is set” to “the
time at which frame data acquisition starts” for each frame.

(Refer to “3.4.6 Time Series.”)

3.3.11 Acquire Position bar

The Acquire Position bar contains shortcut buttons for the Acquire Settings dialog box (see 3.3.1). The Acquire
Position bar is one of the dialog boxes (see 4.6) that can be displayed by checking the EZ-C1 “Acquire
Position bar” command of the “Tools” menu. The Acquire Position bar contains the following buttons

Acquire Position Bar

€[] #]9[] 3]

Figure 3.3-7 Acquire Position Bar

Name

Function Overview

Decrease X-position; move left.

Increase X-position; move right.

ERIEES

Decrease Y-position; move backwards.
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Increase Y-position; move to the front.

[

Increase field of view: zoom out.

+

Decrease field of view: zoom in.

Increase Z-position: move up: only with a Z-drive.

Decrease Z-position: move down: only with a Z-drive.

Increase Z-range: only with a Z-drive.

Decrease Z-range: only with a Z-drive.

Increase number of Z-steps: only with a Z-drive.

ISR E

Decrease number of Z-steps: only with a Z-drive.

3.3.12 Acquire Mode bar

If you wish to display the captured image over the entire screen, items displayed at the right-hand side (such
as the Acquire Settings dialog box) can get in the way. In this case, you may choose not to display such items.
When the Acquire Settings dialog box is not displayed, you can still select an image-capture mode from the

Acquire Mode bar.

Each of the buttons is linked to the following check boxes. Note also that when you click on a given box, the
corresponding check box is activated.

Acquire Mode Bar £
| | wA | Rz | T

Figure 3.3-8 Acquire Mode Bar

Name Function Overview
LT Line scan check box
LC Line channel check box
A Average check box
FC Frame channel check box
V4 Z-stack check box
T Time check box
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3.4 Acquire Settings (2: Image acquiring mode settings)

3.41 XY

Use the Navigation tab in the Acquire Settings dialog box to set the position and size of the scanning area.
(See 3.4.8 “Navigation Window".)

3.4.2 Line Lambda

CAUTION

- This function is not available in the spectral mode. Use this mode only in the standard mode.
- This function cannot be used when Bleach is performed.

- This feature is unavailable when the three-laser unit is connected.

To acquire images in line sequential scanning, enable the Line Channel checkbox (a checkbox for an image
acquisition mode) in the Acquire Settings dialog box. In line sequential scanning, scanning is performed while
switching the PASS settings for each line. A shutter and channel can be set for each PASS. The current value
in the Gain bar is set for Gain.

Use image acquisition in line sequential scanning if cross talk between channels presents problems. In
comparison with frame sequential scanning, line sequential scanning has the advantage of simultaneity in data
between channels.

®¢¥  Line Lambda | Average | Frame Lambda | 2 | Time |
Passes: | 3:'_', Chi Ch2 Ch 3 Ch 4
Laser Settings Pass  Lager 515730 59050 GS0LP Trans | =
Lt] 1 |5’-*'-"—L| = r = o Channel Settings
2 [e61 = m s w
3 483 - [ o - |
4 ' =l i | [

Figure 3.4-1 Line Lambda tab

Line Channel mode’s image acquisition buttons allow you to perform the following tasks.

Name Function Overview

Live Live scanning is performed in line sequential scanning. Press the [Live] button
once again to stop scanning.

Single | Single scanning is performed in line sequential scanning.
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The actions and meaning of various buttons and parameters in the Line Lambda tab are shown below.

Name Function Overview

Passes Specify the PASS count.

Laser settings Specify the laser for each PASS.
The settings in the Laser and Detector dialog box can be used here.

(Example: ‘== [5 [E | E |lasa’ I | 543 | [EED )

Channel settings Specify the channel data for each PASS. Two or more channels can be used for
one channel.

The settings in the Laser and Detector dialog box can be used here.

(Example: P=t==tr  5is/sp «HE> <66l < > )

Note

- The settings in the Laser and Detector dialog box are linked to those on the Line Lambda tab.
Lasers and detectors selected in the Laser and Detector dialog box are automatically set in
respective fields in PASS on the Line Lambda tab “in descending order of laser wavelength.” PASS
can be set and changed on the Line Lambda tab.

Ex.) When “Laser = 488, 543, 637” and “channel = 515/30, 590/50, 650LP” are set in the Laser and
Detector dialog.

Pass1=637, 650LP, Pass2=543, 590/50, and Pass3=488, 515/30 are automatically set.

3.4.3 Average

To acquire averaged images, enable the Average checkbox (a checkbox for an image acquisition mode) in the
Acquire Settings dialog box. You must specify real-time averaging parameters in the Average tab (Figure
3.4-2). Averaging has been made available as an addition following the assignment of weights to new and

averaged images. This command provides improved signal-to-noise ratios for images, with no changes over
time.

Y ] Line Lambda Average lFrame Lambda] z ] Time ]

Current Count: 1

Stop at Count: 4 ﬂJ j
Current Quality: 00 de

[~ Stop at quality: 12 dB ﬂ J ﬂ

¥ Stop when Gluality decreases

Figure 3.4-2 Average tab

Acquire Average mode’s image acquisition buttons allow you to perform the following tasks.

Name Function Overview

Live | Press this button to begin image acquisition and repeat averaging. Press the
[Live] button once again to stop image acquisition.
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Single |

Press this button to start image acquisition. In this case, averaging will
automatically stop according to the selected averaging option. Press the [Single]
button once again to stop image acquisition.

The following averaging options are available on this tab.

Name

Function Overview

Current Count

The number of images acquired for the purpose of calculating the average

Stop at Count

Check this option to stop the averaging at the preset number of images.

Current quality

The signal to noise ratio of the averaged image. The most optimal average
image is obtained when the signal to noise ratio does not improve anymore.

Stop at quality

Check this option to stop the averaging at the preset quality.

Stop when Quality
decreases

If you enable this option, averaging calculation stops if the image quality is found
to be degraded compared to the value obtained from the previous averaging
calculation, restoring the image to the highest quality.

Automatic Best Color
Fit

Check this option to perform the “Best Intensity Fit” operation after each
calculation. (Same operation is obtained when | button on the Color tab in
the View Settings dialog box. See 3.5.2.)

Note

machine.

- At first, color mapping is optimized about the black picture anything does not have an image.
Therefore, although the first Average calculation picture looks very bright, it is not failure of a

3.4.4 Frame Lambda

To acquire images in frame sequential scanning, enable the Frame Ch checkbox (a checkbox for an image
acquisition mode) in the Acquire Settings dialog box. In frame sequential scanning, scanning is performed
while switching the PASS settings for each frame. Use image acquisition in frame sequential scan if crosstalk

between channels presents problems.

The Laser and Detector dialog box is used to make settings for each PASS. Settings can be made for the laser

shutter, channel, gain, and pinhole for each PASS.

K | Line Lambda | Aversge Frame Lambda |2 | Time |
Optionz: [~ Preview Pass
Paszes: Pasg Finhols | Channel. | Channel., | Channel. | Ch
Pass 1 30 um_ off on o 4—— Pass settings
.ﬂj Pass 2 30 um off on aff g
b |
< ¥
Fils ot saved el

Figure 3.4-3 Frame Lambda tab
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Acquire Frame Lambda mode’s image acquisition buttons allow you to perform the following tasks.

Name

Function Overview

Live I

Live scanning is performed in frame sequential scanning.
Press the [Live] button once again to stop scanning.

Single |

Single scanning is performed in a frame sequential scanning.

The actions and meaning of various buttons and parameters in the Frame Lambda tab are shown below.

Name Function Overview

Preview Pass Acquires images for a single PASS that has been selected.

[Delete] Deletes the selected PASS.

[Add] Adds a new PASS.

File Displays the saved filename.

[Open] “Passes” settings can be saved in files with extension *.ech. Press this button to
open a dialog box for selecting one of these files so that settings can be loaded.

[Save] Saves “Passes” settings in a file.

Path settings

“PASS” can be set in the Laser and Detector dialog box.
The actions and meaning of various buttons and parameters in the Frame Lambda tab are shown below.

Name

Function Overview

Channel 1 to 4

Specifies the channel assigned to the PASS. Multiple selections are possible.
Parameter values are changed using the buttons

Detector  ¢SiSdany o ZQIED> «ES0IB» < on the “Laser and Detector”

tool bar while a PASS has been selected.

Pinhole

Specifies the size of the pinhole in each PASS. Parameter values are changed

using the I O S v| button on the “Laser and Detector” tool bar while a PASS
has been selected.

Shutter 1to 3

Specifies whether the laser shutter is opened or closed for each PASS.
Parameter values are changed using the buttons

Lese ,@ | 438 | 543 m on the “Laser and

Detector” tool bar while a PASS has been selected.

Gain1to 4

Specifies the gain value for each PASS. Parameter values are changed by
manipulating the “Gain” bar values while a PASS has been selected.
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To acquire 3D images (X, Y, and Z), enable the Z-stack checkbox (a checkbox for an image acquisition mode)
in the Acquire Settings dialog box. In this case, you can specify Z-axis drive parameters on the Z-stack tab
(Figure 3.4-4). This control field is available only if the Z-axis drive unit is installed.

Xf | Line Lambds | Average | Frame Lambds Z | Time |
Z-drive RFA

FEPRei | 000

- T 000
LRk | Step Sie 010 um—=— M——Nyquistbuﬁnn
(3 Bottom 000 Rage [ 070 um=]

" [T) Index 1 -| FileSge 2007 MB

. FESEt hutton

-

Figure 3.4-4 Z-stack tab

CAUTION

When the Nikon perfect focus system for the TE2000-E is used with the system, the Z-stack settings have
limitations. (For details about the perfect focus system, refer to the TE2000 PERFECT FOCUS SYSTEM
instruction manual.)

- The offset value of the perfect focus system cannot be moved with the Z-axis driving.

Acquire Z-stack mode’s image acquisition buttons allow you to perform the following tasks.

Name Function Overview

Live | Press this button to acquire images from uppermost to lowermost slices
according to the settings for the parameter listed below. When image acquisition
at the lowermost slice is complete, image acquisition restarts from the
uppermost slice. Press the [Live] button once again to stop image acquisition.

Singls | Press this button to acquire images from uppermost to lowermost slices
according to the parameter settings. Unlike Live, image acquisition stops when
the lowermost slice is reached. Press the [Single] button to stop image
acquisition.

Note

<Z-Stack mode with the perfect focus system>

Start an image capturing with the status of the [PFS] button is shown as EJ (An offset value is specified.)
Move the Z position to the reference position. Focus on the reference position. And then, capture an image
while the focusing control is running.
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The actions and meaning of various buttons and parameters in the Z-tab are shown below.

Name

Function Overview

Ref (Reference)

Check this option and move slider bar to move the position of whole scanning
area. You can move the position by using the knob on the Z-drive device.
When the perfect focus system is used,

the focusing control is performed so that the reference position is the focus
position.

Top

Check this option to move the scanning position to the top of scanning area.
Move the slider with this option is checked to change the top position of the
scanning area. In this time, the scanning volume is defined again with new top
position and original bottom position. You can move the position by using the
knob on the Z-drive device.

Bottom

Check this option to move the scanning position to the bottom of scanning area.
Move the slider with this option is checked to change the bottom position of the
scanning area. In this time, the scanning volume is defined again with original
top position and new bottom position. You can move the position by using the
knob on the Z-drive device.

Index

The number of the currently displayed scanning image. The first scanning plane
is “17.

Reset button

Press the upper one to restore Reference value to its initial setting.

Press the bottom one to restore Top, Bottom and Index values to their initial

settings.

- Do not use the reset button on the controller. This will cause it unable to
measure Z position in the application. If you use it by mistake, press the
bottom reset button on this window to reset settings.

Position The physical position in the Z direction. This is the relative distance from the
position where Z-drive is started.

Steps Set the number of steps to be scanned.

Step Size Set the physical distance between steps.

Nyquist Sets the optimum value for the step size based on the resolution of the objective
as specified by the “Objective” command on the “Configure” menu.

Range Specifies the scanning range in the Z-direction.

File Size Displays the file size of acquired image based on the above parameter settings.

Scroll bar This bar is used to operate the Z-drive and move the Z position of the Z-axis.

When the perfect focus system is used,
adjust the offset value of the perfect focus system.
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3.4.6 Time Series

To acquire images in time series mode, enable the Time check box (a checkbox for image acquisition mode) in

the Acquire Settings dialog
Displays a Time Series win

box. Click the Time tab to set parameters (Figure 3.4-5).
dow, showing images acquired at specific points in time.

Image data from 1D to 3D can be acquired at each specific point in time depending on the mode selected in

the Acquire Settings dialog

M

Count: [ 2= Pause | ol 5

Speed: |with variabls delay: v |

B frm
Storage: [ | Save to File 629 ms
Frame time 4145 = Frame 5 done
Tatal titme § min Mezxt in 1:000 ms
File gize: 314.6 ME Finigh in 2000 ms

box.

| Line Lambda | #verage | Frame Lambda | 2 Time l

Wariable Delay Settines ... |

Figure 3.4-5 Time tab

Acquire Time Series mode’s image acquisition buttons allow you to perform the following tasks.

Name

Function Overview

Live I

Press this button to start time series image acquisition. Press the [Live] button
once again to stop image acquisition.

Single |

Press this button to acquire images in a single time series sequence. Press the
[Single] button to stop image acquisition.

The Time Series options on

this tab are shown below.

Name

Function Overview

Count

The number of frames acquired.

Speed

As fast as possible

Images are acquired in succession with no intervening delays when multiple
frames need to be obtained.

Count: | 20— Pauze | I.I:I.IJ| E |
speed s fast as possible ¥ [

With fixed delay

Multiple frames are acquired at fixed intervals. Set an interval between the time
at which frame scan starts and the time at which the next frame scan starts.

Court; 0= Pause | I.I:I.IJ| E |

SRS Wih ixed celoy S
| 4146 |seconds  +|
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With variable delay

Multiple frames are acquired at variable intervals. Creates a sequence.
(See 3.4.4.1 “Variable Delay Settings”.)

Ciaurt: I—Zl Pause | "':"u| B |
speed. o Twith var o -

Wariable Delay Settines . |

Press Next Button

During scanning of each frame, the [Next] button functions like a trigger to start
scanning.

Caunt: BEIE | ..Eu..| E |
Speede JPress Noxt Buton ¥
_Mext |

Mext

n If Time Series settings are changed when operation is paused, observations
are halted and resumed from the beginning.

Storage

Save to File Select this check box to save each image to a file at the time it is acquired.
- If you do not select this check box, use Save or Save As on the File menu to

save each image to a file after the sequence has finished.

[Pause] Pauses observation during Time Series observation (under settings of As fast as
possible, With fixed delay, or With variable delay).
n If Time Series settings are changed when operation is paused, observations

are halted and resumed from the beginning.
T Shows time schedules for the currently set image acquisition with a progress

bar. During image acquisition, the yellow arrow moves to indicate the current
status of image acquisition.

Time Series P ess
Frame:1 6 12 16 20 23 5 27 9

{8 Y Y I | | | | | | | | |
Period: | 1 3 | 3

——r
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E | Event marker
(CTE)

Specify the CTE marker (current time event marker), which is one of time event
markers. This marker is used to set an event before or during an observation.
Clicking this button displays a period of time from “the time at which a marker is
set” to “the time at which frame data acquisition starts” for each frame.

LB Gi-Live Time Series 1 [2)[E][X]

E: +2:412 ms

(Time displayed = “the time at which frame data acquisition starts” - “the time at
which a marker is set”)

harker is set, Each frame acquisition

‘lagﬁ:"_‘#\\Jr"LL l t

n The shortcut button that functions in a same manner is provided on the
Acquire bar.

n An ATE marker E | (acquisition time event marker) is provided on the
Annotate bar.
This marker targets only the Time Series data after the observation and is
used to set an event in the acquired data.
Clicking this button displays a difference from the time at which frame data
acquisition starts” for each frame based on “the time, for which a marker is
set, at which frame data acquisition starts.

GE G1-Live Time Series 1 (=13

(Time displayed = “the time at which frame data acquisition starts” - “the time, for
which a marker is set, at which frame data acquisition starts”)

Marked frame acouisition]

Frame acguisition Frame acguisition
+

[Status]

The status field contains current information that is updated during acquisition and when the settings are
changed. The field may contain the following items.

Frame time

The minimal acquisition time for one frame. Note that for some devices, the
actual acquisition time will be longer due to starting and stopping procedures.

Total time

An estimated total acquisition time for the entire series. (If Z-stack and Time

Series modes are both selected, the time displayed is total acquisition time.)

n These values should be considered as only a rough guideline since the
time it takes to acquire the data depends on CPU and network loads.

File size

The size of the time-series image file. (Shows total file size if Z-stack and Time
Series modes are both selected.)
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Frame The index of the frame last acquired. The red large hand of the dial clock also
shows this number.
Next in The time period after which the next frame will be acquired. The blue small hand
of the dial clock also shows this number.
Finish in The time period after which the time series will be completed.
Note

<Saving images during execution of Time Series>
Images composed of the number of acquired frame data are saved.

3.4.6.1 Variable Delay settings

Select “With variable delay” for Speed in the Time Series tab, then press [Variable Delay Settings] to display
the Variable Delay Settings dialog box (Figure 3.4-6). Set a time series sequence with different interval times

in this dialog box.

Yariahle Delay Settings ..

Wariable Delay Settines |
Mumber of Delay Groups: I 332
Group | Mumber | Dela: | Unit | Bleach |
1 10 5 rireE
2 10 M0 s
3 10 0 =

out spots

Gancel | K I

Figure 3.4-6 Variable Delay Settings dialog box

Sets bleach for each step.

Name Function Overview
Group Step number
Number Number of acquired frames
Delay Frame acquisition interval
Unit Unit of delay time (ms, s, min, or hr)
Bleach

none No bleaching is performed.

all The entire scan area is bleached.

in spots The area inside the target spots is bleached.
out spots The area outside the target spots is bleached.
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Note

increases.

<Image display while performing the Bleach step as a part of a sequence>
- EZ-C1 actively switches off the gain voltage supply when incidence laser intensity significantly

When performing the bleach step as part of a sequence, check “Block Detectors during Bleaching” on
the Bleach tab in the Configure Confocal C1 dialog box to automatically set the gain to “0” to prevent
a loss of the gain voltage. The image is not displayed during bleaching.

3.5 View settings

Set the method for displaying an image window in the View Settings dialog box. Choose View Settings from
the EZ-C1 Tools menu or press |i| in the View bar (see 3.5.4) to display this dialog box. The View Settings
dialog box has the following tabs.

- Info: Shows information related to images. (See 3.5.1)

- Color: Use this tab to set channel display. (See 3.5.2)

- View: Use this tab to set display mode. (See 3.5.3)

The View Settings | Info tab (Figure 3.5-1) shows information on currently active windows.

Spots Of Intesest Info | Cokr | View |
[1] a0 C1 Spectral Live Vohume 1
Displayed —* .
information foemat
dat Thursday. Janian 27, 2005 16:49:45
dalstvoe: 16 bets:
charnads: 2
Infornation los sach drension
fors] fedl ciffpet
x 512 222un 061 um
(2) . B2 222w 06T um
Information z 5  05uwn  05um
for each
dimension
Descriphons:

Figure 3.5-1 Info tab in the View Settings dialog box
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(1) Displayed Information

This function shows information on active images.

Name Function Overview
image The name of the image.
file The file name of the image. The file name is not shown when the image is not
saved.
format The default file format.
date Date of data acquisition.
datatype The number of bits of a pixel brightness value.
channels The number of channels in the image.
Dezcnptions This button opens the Description dialog box used for entering comments on
[Descriptions] images. . _ o
n This dialog box can also be opened with the File menu | Description
command or View bar| & button.
n Comments are saved with images in the ids or Tiff format, but not with other
image formats. (See 4.1.9)

(2) Information for each dimension
This function shows the physical size of each dimension.

Name Function Overview
size The number of pixel.
field A value that indicates image size in physical units.
offset The origin (top left corner for a 2-dimensional image) of the image pixel

coordinate system expressed in visual field coordinates.

3.5.2 Color Tab

Use the View Settings | Color tab to set the channel display in the currently active image window.
Assign channel color, turn channel display on/off, set the upper and lower brightness limits and make other

settings.

- In the spectral mode, this tab provides the following two color modes:

(1) Multi Channel Pseudo Color

(2) Single Channel LUT

Assigns pseudo colors to each channel data and uses multiple channel
data to display images.

It also groups channels in specific ranges and assigns colors to groups
in images acquired in the spectral mode.

Assigns pseudo colors to one channel data and displays such channel
data images.
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3.5.2.1 Multi Channel Pseudo Color Mode

Use this dialog box to assign pseudo colors to channel data and use multiple channel data to display images.

() Spots Of Interest | Info  {Cio ]| view |
Color Mode 1 g ColorMode:  [Mubi Chamnel Pseudo Color ]
Settings : fi E
{2} Dplicez I Add saburalion ndicabo
Pseudo Color e Channel Coli | |ntansiy Seaing |
Settings ik P St
Spot el
Fraph
Ch 1 Ch? Chi 3 DIC
Chamnel e N W J
ooy i 2 F ) 4 i
. 1] ) | a [ ar | -
ShowH ide ok Links
Seltings Number  [4=]
5 eyan-puiple-yelaw-DIC of Calors:
-
Rename | Mew | Delete |
Figure 3.5-2 Color tab of the View Settings dialog box
Channel Cole  Irkensily Sealing | -
ch1 ch2 ch3 che -
Charael 1 2 3 ]
Coarse: = ] )| | Intensity
% Reser | | Scaling
@ Bast = Settings
e | 2
B | 5
1] Image Data Valies 4095
Fira:
Bright Button

(1) Color Mode Settings

2 Dark Lewel | O 3
Bright Satwaton | 0 3
Gamma | 10 I

Options: & Apply to all Views

Use this function to set a color mode.

Name

Function Overview

Color Mode

Select the following mode from the three color modes.
(1) Multi Channel Pseudo Color mode

Add saturation indicator

Set a saturation indicator.
Pixels in the image with brightness values exceeding the Saturation Level of

any channel are displayed in a color complementary to that of the channel.

Add black level indicator

Specify whether or not a pixel with no brightness value is displayed in white.
A pixel with no brightness value in each channel image is displayed in white.
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(2) Pseudo Color Settings

Use this function to assign colors to channels and show and hide settings.

Name

Function Overview

Spot Graph Indication

Show a spectral graph for a spot in an active image.

The vertical axis indicates Intensity and the horizontal axis indicates

wavelength.

n PMT output data for each channel is specified on the Standard Detector
tab of the Confocal C1 dialog box in the Configure menu.

Channel Color

Display the currently selected color for any channel.

Click on a channel used as a button (standard color button) to use a color
palette to set colors.

(A detailed description of standard color buttons is given in the Section,
“Number of Colors.”)

| @ |
Show/Hide Settings

Show or hide data for a channel.

Color Lists

Show lists of color settings.
- When the C1 Live window is active, the following colors are set by
default.

- green-red-blue-DIC :
Use these settings to set the default color of PMT output data set in
Configure | Confocal C1 | Standard Detector tab.

Use the above tab to change settings, if required.
- cyan-purple-yellow-DIC :
Sets cyan, purple, yellow and white for 4-channel data.
- When a saved image is active, the following colors are set by default.
- Pseudo Color :
Displays the colors from the last save.
n Use the [New] button to generate a new color list to set colors other than
the default colors given above.

Note

<For making user color settings>

(1) Press the [New] button to create a new color list.

(2) Use Number of Colors when a new list is selected to determine the number of colors (the number of
standard color buttons) to be set.

(3) Click a standard color button to set a color.

Renama Changes the name of a selected color setting.
[Rename]
Hew Creates new color settings.
[New]
[ elete Deletes selected color settings.
[Delete]
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Number of Colors

Specify the number of colors to be used as a standard for setting colors.

Color buttons for the specified number of colors are displayed.

- Click a Standard Color Button to open a color palette for setting colors.

- When Group Channels is set to OFF, the channels between standard
color buttons are displayed using color interpolation.

- When Group Channels is ON, the area is divided by the number of
channels. The channel of each area appears in the same color.

Group Channels

A number determined by the Number of Colors that divide areas and are

used for setting area colors.

- When ON, the dividers (black line) between groups can be grabbed by
mouse to expand or contract an area.

- When OFF, the channels between color buttons are displayed using color
interpolation.

n In Intensity Scaling setting, adjustment is made using the group set in

this section.

(3) Intensity Scaling Settings

Use these functions to adjust color brightness.

Name Function Overview
al 1 | 2 .| 4 .| 4 .| Selects the channel whose Dark Level, Saturation or Gamma you want to
Channel adjust.
|AII _____ Adjusts the Dark Level, Saturation or Gamma for all channels. Adjustments
[All] are made relative to the values set for each channel.
% Fazet Returns all Intensity Scaling settings to their default values.
[Reset] (Image Data Values, Dark Level, Saturation and Gamma are returned to
4095, 0, 0 and 1.0, respectively)
2 Bast A function that works with “standard data.” Automatically sets a range of
[Best] brightness values to which colors are to be assigned.
The highest brightness data of an active image constitutes the upper limit of
brightness used in assigning colors.
Sets the upper limit for all slices of 3D and 4D data.
S at Sets a range of brightness levels to which colors are to be assigned based
[Set] on the numbers a user enters in the text boxes below.

Coarze Dark Level: I 0
Coarze Saturation Level: I 4095

Coarse Dark Level: Sets the lower-limit value.
Coarse Saturation Level: Sets the upper-limit value.
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2 This function works with “spectral data.”

Bright It automatically sets the range of brightness levels to which colors are to be
assigned.

[Bright] Sets 0.05% of the pixels in the brightest area of an active image (2D) to the
upper limit (0.05% can be assumed to be noise).
n Determines the upper limit for currently displayed slice images of 3D and

4D data and sets this level for all slices. To change the level for a
currently displayed slice, press the [Bright] button again.

Dark Level Sets the lower-limit value (dark level) of brightness for input data.
The dark level is adjusted in the range from —100 to +100 with a baseline set
to 0. Contrast is reduced for negative values and data is clipped for positive
values.

Saturation Sets the upper-limit value (saturation level) for input data.
Saturation is adjusted in the range from —100 to +100 with a baseline set to
0. Contrast is reduced for positive values and data is clipped for negative
values.

Gamma Changes the y curve for input data. Increasing the y value brightens the
image throwing its dark areas into relief.

v The Intensity Scaling setting is applied to all images linked to the active

Apply to all Views image.

3.5.2.2 Color Select Dialog Box RGB tab

Press a standard color button in the Multi Channel Pseudo Color mode to open the dialog box shown below.
Use the color palette and wavelength data to set the desired colors.

(1) J Palette | Hup Sanration | Wavelerath

it | | el [l
ot
3 et |
ﬁ-’ﬂe ot fiiue Saturaton |Waveleneth |
Saturation [ |
Tah
o

(3) T esbesuauglneee

Tah

Wotengt oo [ 5 [

A s s e

wor [
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(1) Palette Tab
Select colors from the color palette.

Name

Function Overview

Color Palette

Select colors from red, green, blue, yellow, purple, cyan and white.
Yellow, purple and cyan are for partial color blindness.

Sample

Displays currently selected colors.

(2) Hue Saturation Tab

Use this tab to set colors by selecting hues.

Name Function Overview
Hue Sets a hue. Between 0 to 240 hue gradations can be set.
Sample Displays currently selected colors.
(3) Wavelength/Dye Tab

Select a color from a wavelength.

Name

Function Overview

Wavelength

Set a color based on wavelength.
Enter a numeric value for the wavelength or use the rod to select a wavelength.

Sample

Displays currently selected colors.
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3.5.2.3 Single Channel LUT Display Mode

Use this mode to assign pseudo colors to a channel data item and display that data item.

View Settings
Infa Colar l\-"lew | Spots Dflrleresl]
Eolor Mod Colo Modes: | = Channel
olor Mode Rj ColorMode:  |Single Channel LUT i | ;
Settings T A Settings
Chaninel LuT
(2) > o [
Single Color Bl false-color nd Lookup Table
Settlngs Intenszity Scaling
Channet All _I 2 ﬂ
(3) — P Coaze:
Intensity B Reset | |5
Scaling 1 |
: 2 Best E
Settings P
g [Z]5et i
: g
Fire:
v Apply to 4l 0 Image D ata ' alues 4095
Views
D ank Level 0 |
Bright Button —}—— 2 Satwaion | 0 j
Bright
ke Gamma 1.0 1

(1) Color Mode Settings
Use this mode to set the color mode.

Name Function Overview

Color Mode Select the following mode from the three color modes.
(2) Single Channel LUT mode

(2) Single Color Settings
Use this setting to select channels and assign pseudo colors.

Name Function Overview
Channel Setting Select a channel to display images.
Lookup Table Specify a lookup table for the selected channel. The following tables are
available.

- Gray-scale: A gray-scale table in which the monochrome tones from the
darkest black to the brightest white is represented by 256 shades of gray.

- False-color: Tones ranging from the darkest black to the brightest white are
represented by blue, green, yellow, orange, red, purple, etc.

The following lookup tables are also provided.

- Rainbow - Rainbow Contrast - lron - Green Fire
- Green Fire Blue - Red Fire - Red Hot - Magenta Hot
- Brown - Lemon Hot - Yellow Pale - Blue Red

- Black Blue Red White - RCM8000
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(3) Intensity Scaling Settings
Use these functions to adjust color brightness.

A detailed description is given in “(3) Intensity Scaling Settings” under “When Images Acquired by the Spectral
Detector are Active” in Section 3.5.2.1, “Multi Channel Pseudo Color Mode.”

3.5.3 View Tab

Use the View Settings | View tab  (Figure 3.5-4) to set display modes for currently active image windows.

- This tab provides the following five View modes.
For Image window

(1) 1D graph shows an intensity graph for currently set axis and position.

(2) 2D image shows data for the currently selected axis plane.

(3) 3D orthogonal shows the three orthogonal sections of 3D data.

(4) 3D tiled shows image planes for 3D data or data with more dimensions in tile fashion.
(5) 2D channel tiled shows channel images for 2D data or data with more dimensions in tile fashion.

For Spot data t/z axis graph window
(1) Multi Line shows an intensity graph for currently set axis and position.

3.5.3.11D graph Mode

Use this mode to display an intensity graph for currently set axis and position.

Wiew Settings

Spotz Of Interest | Infe | Colr  View |
(1) —1 (R R, -
View Settings R hd
Bats [«
Zoom mx |
2) e Position
Position s 3=
Settings : 'WTJI =
i
i
v Update Position to new Acquired Data
W Synchronize Pozition of other Wiews
I~ Show Curzor
?} t Layout
ayou
Y . [ Use Units
Settings :
[~ Ignore Aspect Fstio

Figure 3.5-4 The View tab of the View Settings dialog box
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(1) View Settings

Use these functions to set the View mode.

Name Function Overview
View Select the following View mode.
(1) 1D Graph mode
Axis Set the horizontal axis (line) for the intensity graph to be displayed.
Select x, y, zand t. (z and t are used only for data with 3 or more dimensions.)
Zoom Zooms the currently set axis.

(2) Position Settings

Use these functions to set positions.

Name

Function Overview

X, ¥,2,t

Use x, y, z and t to specify dimensional locations. (z and t are used only for data

with 3 or more dimensions.)

- When placed on the axis, the zoom operates using the axis as the center
point.

Update Position to new
Acquired Data

Select this checkbox to display the most recent view of the acquired image.
When this option is not selected, the window will show the image according to
position slider and cursor settings at all times making it possible to trace image
changes manually.

Synchronize Position of
other Views

When this checkbox is selected, the position settings of other views of the same
image are synchronized.

Deselect this checkbox to enable different positions of other views of the same
image.

Show Cursor

Select this checkbox to display the cursor at all times.
Deselect this checkbox to show the cursor only when the screen is clicked.

(3) Layout Settings

Use these functions to calculate indicator unit and window size adjustments.

Name

Function Overview

Use Units

Select this checkbox to display labels and axes in physical units and not in pixel
units.

Ignore Aspect Ratio

By default, the width of an image expands to meet the horizontal and vertical
ratio of the “field” value (see 3.5.1) on the View Settings Info tab.

Select this checkbox to ignore “field” data and display images without horizontal
expansion. When only this option is selected and the Layout option is also on,
the image expands to fill the entire window area.
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3.5.3.22D image Mode

Use this mode to display currently set axis plane data.

Spotz Of Inberest | Info | Cokr  View |
{1} N i — —
. . Wim xa w |
View Settings — i
B P s
Zoom 0% |
2} g rosition
Position % %, s
Settings o 5 . E
. 24 — |
4 | |
[+ Update Pozition to new Data Animate
¥ Syncheonize Fosition of ather Views [ =] ﬂ =
[~ Show Cursor I —
{3} — Fazt Display Options Scale
'(:)ast::o?:ssplay [ Forca Window Heaght to DataDocument Hei Horizantal
Sptt' I Force ktegral Zoom factor I Wertical
etlings [ lenare Aspect Fato W Usza Unitz

e

U 1 Spectral Live

=10

| {4
Scale
Settings

(1) View Settings

Use these functions to make View mode settings.

Name

Function Overview

View

Select the following View mode.
(2) 2D image mode

Axis

Select a surface to display a 2D image.
Select using xy, yx, etc. (z and t are used only for data with 3 or more
dimensions.)

Zoom

Zooming is performed with the position location on the currently set axis held in
the center.

(2) Position Settings
Use these functions to set positions.

Name

Function Overview

x! y! z!t

Use X, y, z and t to specify dimensional locations. (z and t are used only for data
with 3 or more dimensions.)
- When placed on the axis, the zoom operates using the axis as the center

point.

Data

Update Position to new

Select this checkbox to display the most recent view of the acquired image.
When this option is not selected, the window will show the image according to
position slider and cursor settings at all times making it possible to trace image
changes manually.
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Synchronize Position of
other Views

When this checkbox is selected, the position settings of other views of the same
image are synchronized.

Deselect this checkbox to enable different positions of other views of the same
image.

Show Cursor

Select this checkbox to display the cursor at all times.
Deselect this checkbox to show the cursor only when the screen is clicked.

Animate

Animated displays are possible for data with three or more dimensions.
z = | Selectan axis for an animated display.

ﬂ / ..........

once the animated display starts.

ﬂ / | 4% Sets the direction of an animated display. This button toggles
between single and bi-directional display.

-1 Adjusts the speed of an animated display (slow — fast)
n This setting is available only for data with three or more dimensions.

..........

(3) Fast Display Options Settings

Use these functions to set calculations performed when window size is adjusted. When the Force Window
Height to DataDocument Height option is selected, the image is displayed in a 1:1 scale that does not require
any calculation and speeds up image display.

Name

Function Overview

Force Window Height
to DataDocument
Height

This option locks the window size to the same number of lines and pixels.
Deselect this option to enable image resizing by dragging the image frame.

Force Integral Zoom
factor

This option zooms in images in integral multiples and zooms them out by an
integer factor of 1(1/2, 1/3, 1/4 ...) The image is displayed in the largest factor
that fits in the window.

Ignore Aspect Ratio

By default, the width of an image expands to meet the horizontal and vertical
ratio of the “field” value (see 3.5.1) on the View Settings Info tab.

Select this checkbox to ignore “field” data and display images without horizontal
expansion. When only this option is selected and the Fast Display option is also
on, the image expands to fill the entire window area.

(4) Scale Settings

Use these functions to set scale display and indicator units.

Name Function Overview
Horizontal Show the X-axis in the image window.
Vertical Show the Y-axis in the image window.
Use Units Select this checkbox to display labels and axes in physical units and not in pixel
units.
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3.5.3.3 3D orthogonal Mode

Use this mode to display the three orthogonal sections of 3D data.

\.l;iu- Settings

[E C1 Spectral Live Volum... g@

info | Coln  Veew |
M Ly T |
View Settings ; ;
L Wz - .
Zoom I
2} — > Fosition
Position X [ 26 4| ]
Settings ¥ [ 256 4| -
: ' 2 =) = |
s |+
W Update Position 1o new Data
W Synchronize Pogition of other Views
™ Show Cursor
EN L
Layout Tt
Settings [~ Harizontal Scala
[ Wertical Scale
[ Ignore Scpect Ratio

(1) View Settings
Use these functions to make View mode settings.

Name Function Overview

View Select the following View mode.
(3) 3D orthogonal mode

Axis Set three axes to display the orthogonal sections of 3D images.
Select x,y, z (and t) ory, X, z (and t). (z and t are used only for data with 3 or
more dimensions.)

(2) Position Settings
Use these functions to set positions.

Name Function Overview

X, y,2t Use x, y, z and t to specify dimensional locations. (z and t are used only for data
with 3 or more dimensions.)

Update Position to new | Select this checkbox to display the most recent view of the acquired image.
Data When this option is not selected, the window will show the image according to
position slider and cursor settings at all times making it possible to trace image
changes manually.
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Synchronize Position of
other Views

When this checkbox is selected, the position settings of other views of the same
image are synchronized.

Deselect this checkbox to enable different positions of other views of the same
image.

Show Cursor

Select this checkbox to display the cursor at all times.
Deselect this checkbox to show the cursor only when the screen is clicked.

(3) Layout Settings

Use these functions to set the calculations used for adjusting scale displays and window size.

Name

Function Overview

Horizontal Scale

Show the X-axis in the image window.

Vertical Scale

Show the Y-axis in the image window.

Ignore Aspect Ratio

By default, the width of an image expands to meet the horizontal and vertical
ratio of the “field” value (see 3.5.1) on the View Settings Info tab.

Select this checkbox to ignore “field” data and display images without horizontal
expansion. When only this option is selected and the Layout option is also on,
the image expands to fill the entire window area.

3.5.3.4 3D tiled Mode

Use this mode to show image planes in tiled mode for data with 3 or more dimensions.

Info | Color Ve | e
e EE - |
View i —
Settings R T =
Zaoim I
(2} g Positien
Paosition X [ 76 . |
Settings y 5 « |+
4 F LJ I _'j
i |+
w Lpdate Poziton fo new Data
w Synchronize Pozition of ather WViews
I Showe Curzor
(3) Lot
Lay<_>ut sicestoskp [ 0 =| W Show Index and Position
Settings I Ienore Aspect Ratio
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(1) View Settings

Use these functions to make View mode settings.

Name Function Overview
View Select the following View mode.
(4) 3D tiled mode
Axis Set three axes to display the orthogonal sections of 3D images.

Select x,y, z (and t) ory, X, z (and t). (z and t are used only for data with 3 or
more dimensions.)

(2) Position Settings

Use these functions to set positions.

Name

Function Overview

x! y! z!t

Use X, y, z and t to specify dimensional locations. (z and t are used only for data
with 3 or more dimensions.)

Update Position to new
Data

Select this checkbox to display the most recent view of the acquired image.
When this option is not selected, the window will show the image according to
position slider and cursor settings at all times making it possible to trace image
changes manually.

Synchronize Position of
other Views

When this checkbox is selected, the position settings of other views of the same
image are synchronized.

Deselect this checkbox to enable different positions of other views of the same
image.

Show Cursor

Select this checkbox to display the cursor at all times.
Deselect this checkbox to show the cursor only when the screen is clicked.

(3) Layout Settings

Use these functions to set the calculations for adjusting the number of images to display, index and window

size.

Name

Function Overview

Slices to skip

Set the number of images to be skipped during image display.

Show Index and
Position

Shows labels indicating Index and physical position (or time) on each tiled
image.

Ignore Aspect Ratio

By default, the width of an image expands to meet the horizontal and vertical
ratio of the “field” value (see 3.5.1) on the View Settings Info tab.

Select this checkbox to ignore "field" data and display images without horizontal
expansion. When only this option is selected and the Layout option is also on,
the image expands to fill the entire window area.
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3.5.3.52D channel tiled mode

Use this mode to show channel images in tiled mode for data with 2 or more dimensions.

\I'i-l- Settings
Info | Color Vieew | Spote OFf Interest |

‘B Spectral Live Volume 1

(1) —iiew |20 channel tiled -

View

Settings B aych =l

Toam I

.[2]. Position

Position =) 1/ ]

Seftings El 161 d
¥ | Bl s N _':.l
z | 10 .

W Lpdate Pozition to reve Acguired Data
W Synchronize Pozition of other Views

(3) [ Bhow Cursce

Display » Display Options

Options shees to skip | ] [ Show Indes and Pozition
Settints [~ lerore Aspect Patio

(1) View Settings
Use these functions to make View mode settings.

Name Function Overview

View Select the following View mode.
(5) 2D channel tiled

Axis Specify a plane to display the tiled channel data.
X, Y, and ch are fixed.

(2) Position Settings
Use these functions to set positions.

Name Function Overview

Ch,x,y,zt Use ch, x, y, z and t to specify dimensional locations. (z and t are used only for data
with 3 or more dimensions.)

Update Position to Select this checkbox to display the most recent view of the acquired image. When
new Acquired Data | this option is not selected, the window will show the image according to position
slider and cursor settings at all times making it possible to trace image changes

manually.
Synchronize When this checkbox is selected, the position settings of other views of the same
Position of other image are synchronized.
Views Deselect this checkbox to enable different positions of other views of the same image.
Show Cursor Select this checkbox to display the cursor at all times.
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(3) Display Options Settings

Use these functions to set the calculations for adjusting the number of images to display, index and window

size.

Name

Function Overview

Show Index and
Position

Shows labels indicating Index and physical position (or time) on each tiled
image.

Ignore Aspect Ratio

By default, the width of an image expands to meet the horizontal and vertical
ratio of the “field” value (see 3.5.1) on the View Settings Info tab.

Select this checkbox to ignore "field" data and display images without horizontal
expansion. When only this option is selected and the Display option is also on,
the image expands to fill the entire window area.

3.5.3.6 Multi Line mode

When the Time Series graph or the Z-stack graph is active, the View tab enters in the Multi Line mode
enabling you to set the graph display method.

(1)
Display
Settings

2)

Position —

Settings

(3)
Layout
Settings

Viem Sellings

Irifia

L P iew

Bz

[Multi Lines ~|

3 Saats in 01 Live Velums |

Loom 100 &

+ Pagition

ch |marge |

2 b o4 ¥
spotz |bile -

Synchronize Position of other Views
I Show Cursor

—P Lavout
W Uze Unitz ™ Square graph

I Ignore Agpect Ratio % Sawtoath graph
v Show file indices

(1) Display Settings

“Multi Line” mode is displayed in “View.
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(2) Position Settings

Position settings are made in this area as follows.

Name Function Overview

ch The display method of each channel data is set.
Current: Displays a graph for one channel data.

Select channel data by using a slider bar.
z K

Tile: Graphs for each of the channel data are
separately arrayed in tile display.

enabled. Specify a numeric value.

t/z Set a cursor position to be displayed when the “Show Cursor” checkbox is

spots The display method of each Spot data is set.
Current: Displays a graph for one Spot data.

Tile: Graphs for each of the Spot data are separately
arrayed in tile display.
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Synchronize Position of
other Views

When this checkbox is enabled, the Position settings for one image are linked in
the other views.

Disable this checkbox to make different Position settings for one image in the
other views.

Show Cursor

When this checkbox is enabled, a cursor is always displayed.
When this checkbox is disabled, a cursor is only displayed when the screen is
clicked.

(3) Layout Settings

Use these functions to set the calculations for adjusting the number of images to display, index and window

size.

Name

Function Overview

Use Units

Check this check box to display the image with units of length not with pixels.

Ignore Aspect Ratio

By default, the width of an image expands to meet the horizontal and vertical
ratio of the “field” value (see 3.5.1) on the View Settings Info tab.

Select this checkbox to ignore “field” data and display images without horizontal
expansion. When only this option is selected and the Layout option is also on,
the image expands to fill the entire window area.

Show tile indices

Check this check box to display the indices in the tiled images.

Square graph

Displays graph with bar graph-style lines.

Sawtooth graph

Displays graph with broken lines.
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3.5.4 View bar

The View bar contains shortcut buttons for the View Settings dialog box (see 3.5). The View bar is the one of
the tool window that can be displayed with the EZ-C1 “View bar” on the “Tools” menu.

View Bar X

0 o268 [mfe Ao e [o | 2|3 x| [E & |

Figure 3.5-5 View Bar

The View bar contains the following buttons.

Name Function Overview

1D graph display mode (see 3.5.3.1).

2D image display mode (see 3.5.3.2).

3D orthogonal display mode (block display) (see 3.5.3.3).

3D tiled display mode (montage display) (see 3.5.3.4).

E = o0E

2D channel tiled display mode (see 3.5.3.5).

Gray scale for single channel data (see 3.5.2).

Pseudo color for single channel data (see 3.5.2).

Pseudo color for multi-channel data (see 3.5.2).

True color for spectral data (see 3.5.2).

These buttons are used to show or hide respective display channel (see 3.5.2). The
buttons from left to right correspond to Channels 1 to 4.

Reset button (left): sets the default color mapping.
Best button (right): automatically sets the range of brightness levels to which colors
are assigned (see 3.5.2).

9:9 | 9¢§|. | = Bright button (left): automatically sets the range of brightness levels to which colors
are assigned mainly in spectral images (see 3.5.2).

Contrast + button (center): raises the saturation level by 1.

Contrast — button (right): lowers the saturation level by 1.

=] Show/hide the View Settings tool (see 3.5).
ﬂ Show the Description window (see 4.1.9).
|ﬁ| Create a new window for the active image (see 4.8).
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3.6 Laser Control

The Laser Control Bar dialog box (Figure 3.6-1) is used to control the brightnesses of lasers and to specify the
bleach mode settings. The Laser Control Bar dialog box is displayed by selecting the Laser Control Bar
command on the Tools menu of EZ-C1.

(1
Bleach
Mode

Settings

(2)
Laser —™

—

i4d
T

Brightness
Adjustment

(1) Bleach Mode Settings

. = Sequence
Mociod Settings
Bleach [Home A1 | Inspots | Oul spots | Sevies: i 2] a |
i Lasei 1 67% 4] | O [ inde
Laser 2 128% 4| | O T indes nger
lwer3 [T 4 A onder | monitor
Figure 3.6-1 Laser Control Bar dialog box

Specify the settings for the bleach mode. (This setting is used only for a case where no sequence is created.)
To adjust the laser brightness of the standard scanning, select [None].

Name

Function Overview

[None]

Not bleached.
To adjust the laser brightness of the standard scanning, select this option.

[All]

All scanning area is bleached.
n The laser power is the specified value in the bleach mode settings for [All],
[In spots], and [Out spots].

[In spots]

The area in the spot is bleached.
n The laser power is the specified value in the bleach mode settings for [All],
[In spots], and [Out spots].

[Out spots]

The area out of the spot is bleached.
n The laser power is the specified value in the bleach mode settings for [All],
[In spots], and [Out spots].
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Note
(1) Spots to be bleached:

Only the spots that are specified as ON in the Bleach field on the Spot of Interest tab of the View
Settings dialog box will be bleached. (Refer to 4.3.6.1.)
(2) Laser power for areas not to be bleached:

The laser power for areas not to be bleached is set to 0%.
(3) Example of bleaching:

(The ON area and OFF area are specified in the Bleach field. See the Note (1) above.)

(1) In spots (2) Out spots
ON _' O oFf ON

(3) In spot (Two spots are overlapped.)

OFF
ON o OFF G— OFF
(4) Out spot (Two spots are overlapped.)

(2) Laser Brightness Adjustment

Adjust the brightness of the lasers for the standard scanning and the bleaching.
Specify the bleach mode in (1) Bleach Mode Settings and then, adjust the laser brightness.

When the bleach mode is [None],
adjust the laser brightness for the standard scanning.

zu

Blesch {| None } A1 | Inspots | Out spots | Seies il =] g |
Laser [ 7% 4] | 2 | € undes
ez [ 125% 4 | o | e
Lasers [T 4 2 €T ndes

When the bleach mode is [All], [In spots], or [Out spots],

adjust the laser brightness for the bleaching. The color of the control bar becomes red, and the brightness
settings are used in common among three modes.

Lsser Control Bar ]

Bleach -.1- m =| i |
W Laserl Tn 4] v | [ unde
Colwez [ | | [
O w3 [ | |
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Name

Function Overview

v
M (Checkbox)

Check the laser to be used for bleaching. Only the laser checked here is

adjustable for the brightness.

n To adjust the laser brightness, specify the details on the Lasers tab of the
Configure Confocal C1 dialog box. On the Laser tab, the laser can be
controlled in % or Voltage unit. (Refer to 5.2.1.)

(3) Power monitor

This area can be used for the laser brightness adjustment for the standard scanning and bleaching.

Name

Function Overview

Monitor

The laser power at the moment will be displayed. It can be used as a guideline of
the brightness adjustment.

AL A

Every laser power is monitored once in sequence.

" (Checkbox for each
laser)

Check the checkbox for a laser to be monitored. Images can be viewed in real

time. A laser power can be checked while adjusting the brightness.

If the checkbox is not checked, no laser power is monitored.

- No laser power can be monitored when scanning. A laser power can be
monitored when scanning is stopped. Besides, check the “Park mirrors when
idle” option on the Mirrors tab of the Configure Confocal C1 dialog box to
prevent laser light from applying on the specimen when scanning is stopped.
(Referto 5.2.4.)

(4) Sequence Settings

Specify the settings for the Time series Variable Delay function in the Sequence Settings area of the Laser
Control Bar dialog box. These settings are interlocked with the settings in the Acquire Settings dialog box.

Name

Function Overview

Series r

Press this button to turn on the Time series function.

=l (sequence)

Specify the settings of the Time series Variable Delay function. (For details
about the settings of the sequence, refer to 3.4.6.1.)

Note

- A FRAP sequence can be performed by using the Variable Delay function. For details, refer to
appendix A.1. “FRAP Sequence Macro.”
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3.7 Laser Power Monitor

A laser power can be monitored in the Laser Power Monitor dialog box. To display this dialog box, select the
Laser Power Monitor command in the EZ-C1 Tools menu.

Lazer Power Monitar E|

Lazer Power I under teasure | Settings ... I

Figure 3.7-1 Laser Power Monitor dialog box

Name

Function Overview

Laser Power

The latest laser power is shown 0 to 100 in steps of 0.1.

[Measure] Push this button to monitor the total power of the laser in use. The laser power
value is refreshed.
[Settings] Specify the settings to monitor the laser power. (Such as automatic monitoring
and so on.) For details, refer to 5.2.2.
Note

- When a three-laser unit is used for the system, the laser power can be monitored during scanning.
Besides, the laser power monitor value and the image at the beginning of a scanning can be saved
when appropriate settings are specified with the [Settings] button. (Monitoring is not available if the
laser is shielded (as described in 5.2.1, using the “Mask lasers during the mirror retrace” function on

the Lasers tab).)

- When a four-laser unit is used for the system, the laser power cannot be monitored during scanning.
The laser power value can be monitored only when no scanning is being performed.

3.8 Objective Bar

Objectives can be changed with the Objective Bar dialog box. To display this dialog box, select the Objective
Bar command in the EZ-C1 Tools menu.

Objective Bar [®]

Objective |1: Plan Apa WG 60x oil j LlII

Figure 3.8-1 Objective Bar dialog box

Name

Function Overview

Objective

Select the magnification of the objective to be used. The magnification is used to
calculate the x- and y-position in the field of view. When “Other ...” is selected,
the Configure Objectives dialog box appears. (Refer to 4.2.3.) Press the
[Change] button in the dialog box to change the magnification.

Press this button to change objectives sequentially. Objectives can be set up to
six sockets.
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Note
- If “None” is selected here, the value of “Calibration @ 100x Objective” on the “Mirrors” tab in the “Configure
Confocal C1” dialog box (see 5.2.4) is used to calculate the position of the field of view and X/Y position.

< When the TE2000 is used >

- When the TE2000 is used, the EZ-C1 obtains the objective database information from the TE2000 when it
starts.
Note also that you can control changes in the TE2000’s objective using the Acquire Settings tool.
To rotate the TE2000’s revolving nosepiece, click LI LI on one of the buttons or select a desired
objective from the list box to the right of “objective” using the XY control tool.

R o

field of view 350mm 4 | 1 Click to rotate the revolving

# position 0.00mm | [ | nosepiece one step at a time.

v position 0.00mm « | [ | (When a device other than the

steps  X:[ 512 v:[ 512 160 286 |[512 1024| 2048 TE2000 is used, you can

obiective  [1: 40¢ NAD10 WD:3000 Ai ~| 4] » | | —— selectthe desired objective
only by scrolling through the
list box.)

Figure 3.8-2 Scan Settings

Note that the objective-lens information stored in the “objective” list box represents the information available
at the time of EZ-C1 startup. Therefore, if any objective lens is replaced during EZ-C1 operation, you need to
startup again.

- When the TE2000 is used, its objective database is used. As a result, you cannot edit the objective
information.

<When AZ100 and RFA are used >

- When the combination of AZ100 and RFA is controlled, selection on Objective Bar includes both objective
magnification and zoom rate.
The “total magnification” (objective magnification x zoom rate x 0.6) that includes the zoom rate of AZ100 is
set for the magnification to be used.
Before selecting an objective from Objective Bar, check the zoom rate setting of AZ100 and select it
together.

Objective E‘
Mumber of Object M Piece: =
LUMmDEr o JECTIVES ON MNOSEe FIece: ﬁJ
Immersion
o5 mnj Plan Apochromat 5400 mm
B m2 Plan Apochromat 0063 3600 mm  Dry
B W3] AZ Flan Apo 4x poom 3x Plan Apochromat 027 2000 mm  Dry
B EE4| AZ Plan Fluor 2 y zo0m 4x Flan Fluor 0183 4500 mm  Dry
g Bl 5| AZ Plan Fluor 5 <| 200 Gy Plan Fluor 0410 1600 mm  Dry
5 ZHIN 6| AZ Plan Apo 4x, } oom Bx Plan Apochromat 0400 2000 mm Dy
<Objective Magnification (Zoom Rate Total Magnification >
8 Objective description in factory database, can not be edited.
Elt Recommened for confocal imagine.
Bl Recommended for spectral imaging, transmission characteristics available. Ehales Glose

Objective Bar

Objective [1: AZ Plan Apo 05x, zoom 1x Dry | lel
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3.9 CLEM Bar

When CLEM equipment is connected, select the CLEM Bar command in the Tools menu to display the CLEM
Bar dialog box. In the CLEM Bar dialog box, you can activate and deactivate CLEM functions and change the
dynamic range (Normal or Wide).

E
I CLEM Dwhamic Fange: I Mormal Wide |

Figure 3.9-1 CLEM Bar dialog box

Name

Function Overview

CLER |

Activates or deactivates CLEM functions.

I Mormal Wide |

Toggles the dynamic range (Normal or Wide).

CAUTION

- CLEM functions cannot be used when the four-laser unit is connected. They are enabled only when
the three-laser unit is connected.
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Menu Functions

Chapter 4, “Menu Functions” describes EZ-C1 menu functions. Information on the functions of EZ-C1 compliant
devices is provided in Chapter 5, “Hardware-related Settings.”

The File menu contains entries to load and store images, print images, change the information of the images and
to terminate the program.

411 Open

The File Open dialog box (Figure 4.1-1) is shown with the EZ-C1 “Open” command on the “File” menu. The
dialog is a standard Windows File Open dialog with features similar to Windows Explorer. The lower field
allows for showing all files or only those of one of the supported file types.

For supported file types, please refer to the “Appendix B. Data File Formats.” The File Open dialog box is
opened from the File bar (see 4.1.12).

open 21|
Loak ir: Il@ ty Documents j - £ Eo-
@My Pictures

File: name: || Open I
Fils af type: IImages [ isr:# HE= EE = ke awis® Bmp) j Cancel |/
4

Figure 4.1-1 Open dialog box
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4.1.2 Close

Use the “Close” command on the “File” menu to close the active image window. If the image has been
changed, a “Save and Terminate” dialog box (Figure 4.1-2) will be displayed. Note that unlike the “Exit”
command, there is no functional difference here between selecting [No] and [Save None].

Save and Terminate x|

:"2 Save changes to Average 17
Save I Cancel | Mo Save Mone

Figure 4.1-2 Save and Terminate dialog box

Name Function Overview
[Save] Causes the “Save As” dialog box to be displayed so the image can be saved to a
file.
[Cancel] Causes the window to remain open without saving the image to a file.
[No] Causes the window to close without saving the image to a file.

[Save None]

Causes the window to close without saving the image to a file.

Note

close.

- The Live window and the window created through a New command on the Window menu will not

4.1.3 Save

The EZ-C1 “Save” command on the “File” menu saves the active image to disk. Depending on the Save
Options (see 4.2.4), the “Save As” dialog box (Figure 4.1-3) will appear. The “Save” command on the “File”
menu is available on the File bar (see 4.1.12).

Note

- The table below shows the calculated maximum amount of data that can be saved into a single file.

File system
FAT32 NTFS
Maximum size 4GB 2TB
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4.1.4 Save As

The EZ-C1 “Save As” command on the “File” menu saves the active image to disk. The Save As dialog (Figure
4.1-3) appears to enter the new file name.

Path: IG:\Documenls and Settings'AdministratoriMy Documents

Save i I@ My Documents j - = ER-
My Pictures

File: name: Im Save

Save as type: IImage Cytometric D ata [* ids) j Cancel

flif

Options : prompt once, DOS5 text format, one file Options ...

Figure 4.1-3 Save As dialog

The “Save As” dialog contains the following items.

Name Function Overview
Path The full path name of the current directory
Save in The folder name to be saved in
File name The name of file
Save as type The file type to be used to save. Currently supported file types are ids, tiff, bmp, avi,

and xIs. Refer to the “B Data File Formats” for information about the file formats.
Files saved in the Data Series graph window are saved in the “esd” format.

Options The current selected Save options

[Options...] Press this button to change the save options (see 4.1.5).
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4.1.5 Save As Options

The Save As Options dialog box is shown when the [Options ...] button of the Save As dialog box is pressed.

The dialog box contains the Save Options tab (see 4.2.4), as well as, depending on the selected file type, the
Ids Options tab (see 4.1.5.1), the Tiff Options tab (see 4.1.5.2), the AVI Options tab (see 4.1.5.3), or the Excel
Options tab (see 4.1.5.4). The Bitmap format does not have any options.

4.1.5.11ds Options

The Ids Options tab (Figure 4.1-4) appears when the [Options...] button is pressed and the IDS format is
selected in the Save As dialog box. The IDS Options tab contains the following items.

Save Options  1d= Options ]

| Calor channels in separate files.

Izs Text Format
(¢ DOS / Windows fwith Gariaze Return + Line Feed)
" Unix fonly Line Feed)
[~ Huyeens Compatible

I Skip channel scale field (or old versions of Huyeens)

Figure 4.1-4 1ds Options Tab

Name Function Overview
Color channels in Check this box to save the color channels to separate files. For each color
separate files channel an ICS/IDS pair is created. In addition, the normal ICS file is written. To

reload the split image into EZ-C1 as a single color images, a file with the
extension .isr is created that holds the names of the color channels files.

lcs Text Format The ICS files can be written in DOS / Windows text format that uses carriage
return (CR) and linefeed (LF) combination as line separator, or in the Unix text
format that uses linefeed (LF) only. Use the Unix text format if your image
processing application rejects the DOS CR line separator.

Huygens Compatible Check this box to create an ICS file using the format defined for compatibility
with “Bitplane Imaris” and “SVI Huygens deconvolution” software.

Skip channel scale field | Check this box to skip writing of the channel scale field for the earlier versions of
(for old versions of Huygens compatible formatted software.
Huygens)
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4.1.5.2 Tiff Options

The Tiff Options tab (Figure 4.1-5) is shown when the TIFF format is selected and the [Options ...] button is
pressed on the Save As dialog box. The Tiff Options tab contains the following items.

Save Options  Tiff Optiong ]

Byvte Order  |Intel (PC) |
Save 3D az

Eormat: |RGEI format ﬂ

Channels: Fed Green Elue

Data Conversion Mode: |Sc:a|e Erightest Data Value ﬂ

[v Show thiz dialog when saving an image.

Tiff Filter
* Copyright (o) 1938, 1989, 1990, 1991, 1992 Sam Leffler
* Copyright (2 1891, 1892 Silicon Graphics, Inc.

" zeriez of fileg

The RGE format stores up to 3 channels Ged, ereen,
bluel. The image data iz converted to 8-bits by
matching the brightness to the B-bits ranee. The
relative intenzity iz preserved, but the absolute
intenzity is lost.

Uze thiz format to export data to applications that
do not support the Raw format.

I il =k =]

Figure 4.1-5 Tiff Options tab

Name

Function Overview

Byte Order

The following byte orders are supported.

Intel (PC)

Use this byte order when writing images using Intel-based computers.

Motorola (Mac)

Use this byte order when writing images using Motorola-based computers
(Macintosh).

Save 3D as

When 3D files are saved, the image slices can be saved in one file or in separate files.

one tiled file

Check this option to store all slices in one file.

series of files

Check this option to save each slice in a separate file with an incremented
index (**_001.tiff, **_002.tiff, ...). In addition to the slice files, an ascii file is
written with the extension .tsr (tiff series) that contains the names of the slice
files. When this file is opened with the “Open” command on the “File” menu, all
slice files are read and the 3D image is reconstructed. When copying or moving
series of files, be sure to keep the slice files and the .tsr file together.

Format
The image can be stored as.

Raw format

The Raw format stores all data without color information or conversion.
Use this format to export the image data for analysis purposes.

However, there are not many programs that are able to read the raw data
format.
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RGB format

The RGB format stores up to 3 channels (red, green, blue).

- 12-bit data for each channel is converted to 8-bit data and saved. (For a
conversion mode, see Data Conversion Mode below.)

- In this format, you can allocate color of channels. (For a setting method, see
Channels below.)

Re-opening this format image, channels are assigned in order of RGB.

Most application software supports 24-bits RGB images.

Use this format to export data to application software that does not support the

Raw format.

Bitmap format

The Bitmap format stores a copy of the currently active window. The image
data is saved as a 24-bit RGB TIFF image that appears to the eye just like the
image displayed in the window. Select this format when you wish to save
figures and text along with an image using the annotation function.

Use this format for presentation purposes.

1-Channel 8-Bit format

Specified one channel data is saved as 8-bit Gray TIFF data.
(For details on how to convert 12-bit data to 8-bit data, see Data Conversion
Mode below.)

1-Channel 16-Bit format

Specified one channel data is saved as 16-bit Gray Tiff data.
(For details on how to convert 12-bit data to 16-bit data, see Data Conversion
Mode below.)

Channels

Select the color for each channel. This option can be used only for the RGB
format.

Data Conversion Mode

12-bit data can be converted to 8-bit or 16-bit in the following modes.

Scale Brightest Data
Value

Data is adjusted based on the brightest data so that dynamic range fits in 8-bit
or 16-bit. This mode is also available even when data is not an integer type.

Scale Full Range

By cutting (adding) low four bits of (to) 12-bit data, the 12-bit data is converted
to the eight bit (16-bit) data.

Fine gradation is lost. However, dynamic range is retained.

Note that this mode is only available when data is an integer type. The Scale
Brightest Data Value setting is applied in this case.

Show this dialog when
saving an image

Check this option to show this dialog box each time save button on file save as
dialog is pushed. Use this option to check an image format and color
assignments.

Note

- All channel data of Tiff data of 1-Channel 8-Bit, 1-Channel 16-Bit, and Bitmap format can be serially
saved by batch processing using the Tiff Series Export function.
Tiff Series Export function: it is registered in the Macro menu by loading the Tiff Series Export

macro. For details, see Section A9, "Tiff Series Export Macro."
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4.1.5.3 AVI Options

The AVI Options tab (Figure 4.1-6) is shown when the avi format is selected and the [Options ...] button on the
Save As dialog box is pressed. The AVI Options tab contains the following items.

File Name A41 Options |

Axis to animate: I j

Frame rate: | 1 frames/s =]

Figure 4.1-6  AVI Options tab

Name Function Overview

Axis to animate The AVI movie is created by animated one of the axis indices and capturing the
image as drawn in the view. Select which axis is animated here.

Frame rate The number of frames per second with which the 3D image is animated when
played with the Windows Media Player or other compatible AVI movie players.

4.1.5.4 Excel Options

The Excel Options tab (Figure 4.1-7) is shown when the xIs format is selected and the [Options ..] button on
the Save As dialog box is pressed.

File Excel Optiohs |

[7  store data rows in columns

Figure 4.1-7 Excel Options tab

The Excel Options tab contains the following item.

Name Function Overview

store data rows in Check this option to transpose column data and row data. Excel can record
columns data in every 1 line only to 255 rows. However, column data is not bound by
the maximum number (255) applying to rows. Use this option to save more

than 255 lines of data.
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The EZ-C1 “Print” command on the “File” menu prints the active window. To specify the printer and print
parameters, display the default Windows Print dialog box. The image is stretched to fill the paper.

To print a smaller image, you can define a smaller paper size in the Print Setup dialog (see 4.1.8). Please refer
to the instruction manual supplied with your printer. The “Print” command on the “File” menu is also available
from the File bar (see 4.1.12).

4.1.7 Print Preview

The EZ-C1 “Print Preview” command on the “File” menu displays the image on the screen as it will be printed
to paper. The Print Preview command is also available from the File bar (see 4.1.12). The top menu bar of the
Print Preview window contains the following buttons.

Name Function Overview
Print Print the image.
Magnify Magnify the preview image by up to two levels.
Close Close the Print Preview window without printing.

4.1.8 Print Setup

The EZ-C1 “Print setup” command on the “File” menu displays the Windows Print Setup dialog box. This
dialog box allows for selection of the printer, paper size and orientation. Please refer to the instruction manual
supplied with your printer.

4.1.9 Description

Use the “Description” command on the “File” menu to open the Description dialog box (Figure 4.1-8) and enter
comments for currently active images.

The comment should reflect measurement type, sample and other experimental parameters. (The contents of
the comment may automatically be updated when the image is saved. For example, when an image is saved,
the current date and time are entered in the Date field by default.)

Note

- This dialog box can also be opened using the File menu | Description command and the View
bar| & button.

- This comment is saved in the ids or text format together with the image. No other file format can

be used.
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s of Image Live

Please enter the correct values of the description keys
The description keys will be saved with the ids and tiff images.
The date key will be generated automatically:

The <TAB> key moves the focus to the next field
Use a /' character to add a <TAB> to the ics file.

2

Ke ‘ WValue

history/gainl ol

history/gain? 0

history/gain3 0

history/gaind o]

history/dwell 31 us

history/objective Flan Aposhromat 80 0x MNAT 20 WDO 22 Water DL
history/objective/Magif.. 60.0 x

history/objective/MNA 1.200

history/objective/Warki. 0220 mm

history/objective/Imme... Water

history/shutterl closed

history/shutter? closed

history/shutter3 closed

history/laser! 438

history/laser? 543

history/laser3 561

history/pinhole 1000 um

history/hoi none

Kl I}

Add Key | Remove Key |

Close |

Figure 4.1-8 Description dialog box

4.1.10 Recent Files

The EZ-C1 “Recent File” entries 1 to 9 on the “File” menu allow easy opening of the last 9 saved images.

The EZ-C1 “Exit” command on the “File” menu terminates the program. If unsaved images are present, the
Save and Terminate dialog box (Figure 4.1-2) appears. This dialog box can also be accessed by “Close”
command on the “File” menu (see 4.1.2). The Save and Terminate Dialog contains the following buttons.

Name Function Overview
[Save] Save the unsaved image before termination.
[Cancel] Do not terminate the application.
[No] Do not save the image and terminate the application.

[Save None]

Don’t save any unsaved image and terminate the application.
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4.1.12 File Bar

The File Bar contains shortcut buttons for menu commands from the File and Help menus. The File Bar is a
Tool window (see 4.6) that can be displayed with the “File Bar” command on the EZ-C1 “Tools” menu. The File

bar contains the following buttons.

=68 2|2

Figure 4.1-9 File Bar

Name Function Overview
El File | Open Open an existing image (see 4.1.1).
|E| File | Save Save current image to file (see 4.1.3).
@I File | Print Print current image (see 4.1.6).

@[ Help |About EZ-C1 Opens About EZ-C1 for Nikon C1 Confocal Microscope. Use this Help screen to

for Nikon C1 confirm the EZ-C1 version or hardware version.
Confocal
Microscope

& Help | EZ-C1 Help: Opens EZ-C1 Help screen
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4.2 Configure

The Configure menu lets you configure the device, select objectives, or make default settings for the name of the

file in which to save an image.

- Devices (see 4.2.1)
- License (see 4.2.2)
- Objectives (see 4.2.3)

- Save Options (see 4.2.4)
- Startup Profile (see 4.2.5)
- Acquire Option (see 4.2.6)

Note

Chapter 5, “Hardware-related Settings.”

- If other modules are added, the Configure menu may also contain commands other than the above.
For more information on setting additional modules and on settings made in Confocal C1, refer to

4.2.1 Devices

The Configure Devices dialog box opened by the Devices command on the Configure menu (Figure 4.2-1)
allows for setting the installed device drivers. The configuration is stored in a file with the extension .ini.

x

Configuration:
B o]

Device Tvpe Vendor

Data Series linetaal -

Gonfocal G scanher Mikon Aetivate |
Microscope Ti-E microzcope + z-drive Hikon :

[ Z-drive RF4 2-drive Nikon DEmiiiaiiz |
[ Z-drive Simulation z-drive Mikon

Acquire acguizition-bage -

3D Vizualization vizualization -

Launcher launcher -

1] | ]

[~ Read Cnly Defaults Beset Spply Catcel | QK I

Figure 4.2-1 Configure Devices dialog box
Name Function Overview

Configuration

Shows the name of the current configuration.

Read Only

Check this option to protect the current configuration. When this option is
checked, a dialog box appears to confirm whether save changes or not when the
[OK] button is pressed.
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Device This field lists the device drivers that are available in this configuration. A leading
check mark indicates that a device is active.

[Activate] Press this button to activate the selected device.

[Deactivate] Press this button to deactivate the selected device.

[Defaults] Press this button to activate the default combination of devices.

[Reset] Press this button to reset the configuration to its initial state.

[Apply] Press this button to save the changes without closing the dialog box.

[Cancel] Press this button to discard the changes and close the dialog box.

[OK] Press this button to save your changes and close the dialog box. EZ-C1 will
restart.

Note

- The Configure Devices dialog box is available only if the user has logged in with administrator rights.

4.2.2 License

The Nikon HASP dialog box displayed by the License command under the Configure menu (Figure 4.2-2) lets
you confirm the contents of the license for the currently used dongle (hardware protect key).

Mikon HASF x|
Authorized Options:
Ke: | Option
B2F0-DE3F Ef-1
B2FO-DE3F EZ-C1 Viewer
4] I B
oo |
Figure 4.2-2 Nikon HASP dialog box
Name Function Overview
Key License number
Option Application name
[Refresh] Reloads license information from the dongle.
[Close] Closes the window.
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4.2.3 Objectives

In the Objective dialog box (Figure 4.2-3) displayed by clicking the Objective command on the Configure menu,
you can create a list of current objectives in the objective Bar dialog box (See 3.9).

Images are acquired using the objective lens for which the corresponding check box on the left edge of the
dialog box is selected (see Note).

Mumber of Objectives on Mose Piece:

) | Immersion
Achramat

SN 3 Achromat Air LWD, WD 27-1.7 mm, GGG 00 - 20 mm

5 14 Achromat Bir Fhil

EIEHIE  Achromat Air Ph2, LWD, WD 27-17, GGG 0-20 mm
o EEI6 Achromat Hir Ph1
A | 5]
8 Cbjective description in factory databaze, can not be edited. Changs ]

Recommened for confocal imagine.

Bl Recommended for spectral imaging, transmission characteristics available.

Figure 4.2-3 Objective dialog box

EJ :Objective lens data stored in EZ-C1
EL : Data for recommended confocal objective lens
[ ]|

: Data for spectral objective lens (containing transmission characteristics and enabling brightness
calibration).

To alter the list display, select and double-click on an objective, or click [Change] to display the Select New
Objective dialog box (Figure 4.2-4). Use [Select] to assign the objective to the objective mounting position
selected in the Objective dialog box. Note, however, that you cannot alter or delete information registered by
default.

Select Hew Objective

Ze=l=ci Obj=ctree on Hose FPositian 1
Descrption Tupe Wagnd. HA WD | Immarsion Gonda. | Datad -
@ Wl Pl Pl 200 Dry Plar Fla 200 = Q500 000 mm ey
@ Wl Pl Pl 20s Dry Plar Flue 200=  04B0 000 wmm ey PFS
@ WD Plan Fluor 30 Dry Plan Fhar 200 = 0450 000 mm Doy FF5
A WD Pl Fluor 20 Dry Plan Flisce 200 D450 000 mm ey FF5
i] Plan Flugr 40 Dry Flan Fhaor £00 = 0750 000 mm Dy FF5
4 m Plan Fluor 40% Dry Plan Flucr 200 = 070 000 mm Dy
S W0 Plen Flhaor 4 il Plan Fhae 200 w 1.amn e mm il PFS i
< »
ﬂ Obgective description in factory database, can not be edied
EL Fecommenad for confocal imazing
Bl Fecommendsd for spacheal imaging, ransmiszion characierstcs availsbla. Select | | Cance| I

Figure 4.2-4 Select New Objective dialog box
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Note

- Information on the objective lens used to acquire the image is saved with an image (see 4.1.9,
“history/objective” lines in the Description dialog box). The objective lens information is used to
calculate the scan area for image acquisition (see 3.3.7, “field of view”), other settings based on the
scan area (i.e., Scale on the View tab in the View Settings dialog box [see 3.5.3], the scale of the
Ruler on the Annotate menu [see 4.3.2], the value set for the Distance on the Analyze menu [see
4.3.1.1], the Spot area indication [see 4.3.6] and the like), and the SyQuest value of Z-stack (see
3.4.5).

- Before the acquired image can be correctly measured, the scanning mirror must be calibrated. (See
5.2.4, Calibration@100xobjective)

4.2.4 Save Options

Select the Save Options command from the Configure menu to display the Configure Save dialog box. Here
you can set default settings for file names to be saved, etc.

Click the Save Options tab (Figure 4.2-5) to make settings for the filenames generated automatically when
saving an image with the Save command or the Save As command from the File menu.

Gonfigure Save

Save Options

Folder for temporary files:  CaTmp J
v Show File Info dialoe on Startup

Prompt for File Mame: o always O first time 7 never

Mame Template: |a#m¢m4 ﬂ ﬂ

Replace # with index: " elobal + template

v Warh when a file iz saved with zame or lower index

[~ Show File Saved box:

o]8 | Cancel | | Help |

Figure 4.2-5 Save Options tab on Configure Save dialog box

Name Function Overview

Folder for temporary Specify a working folder for temporary storage of images during image

files acquisition.

[...]: This button lets you browse existing folders and select one from the list.

- The disk on which the working folder is located must have at least as much
free space as the file size of the acquired image.

Show File Info dialog Select this check box to display the current settings in the Description dialog box
on Startup on EZ-C1 startup.

Prompt for File Name
Specify when to display the Save As dialog box when you select the Save command on the File menu.

always The Save As dialog box is displayed each time you save an image.

first time The Save As dialog box is displayed only the first time you record an image (i.e.,
before any other images have been saved).
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never

The Save As dialog box is not displayed. Images are saved under automatically
generated filenames.

Name Template

The name template is used for automatic generation of file names. The # signs

in the file name are replaced with an index number to obtain a unique file name.

The index numbers are increased each time an image is saved with this

template. To prevent generation of files with similar names, be sure to set the

name template to a string that is unique in your laboratory.

[#]: Enter the format of the sequential numbers to be assigned to filenames.

- To avoid generating files with similar names, for each observation session,
we recommend resetting Name Template to a string that can easily be
distinguished from previously assigned names.

Replace # with index

Specify the serial number for [#] used in the Name Template.

global The number of [#] increases each time the image data is saved by the current
log-in user. Regardless of the saved filename the number increases.
template The number of [#] increases in case the image data is saved with the same file

name.

Warn when afile is
saved with same index

Select this check box to display the File Count Warning dialog box (Figure 4.2-6)
if the operator attempts to save a file under a filename assigned to an existing
file. You can also enter a setting in this dialog box to auto-increment numbers
embedded in filenames.

Deselect this check box to display an overwrite confirmation dialog instead of the
File Count Warning dialog box. This lets you change filenames manually.

Show File Saved box

Selecting this checkbox displays a dialog after you save a file that prompts for
confirmation of a filename.

Use this option to confirm the saved filename if you selected “never” for the
Prompt for Filename option.

File Count Wathing x|

Warning: a file with the name a and count 77 was saved earlier.
Thiz may cause confugion.
Change the count to 78 7

Mever | Cancel Mo

Figure 4.2-6 File Count Warning dialog box

Name Function Overview
[Never] Disables automatic incrementing of filename sequence numbers. An overwrite
confirmation dialog box is displayed. From this point on, this dialog box will not
be displayed. (The check box in Figure 4.2-5 is unselected.)
[Cancel] Returns to the File Save As dialog box, allowing you to rename the file manually.
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[No] Disables automatic incrementing of filename sequence numbers. An overwrite
confirmation dialog box is displayed.

[Yes] Saves files under different (incremented) sequence file numbers.

4.2.5 Startup Profile

Selecting a profile allows you to reuse previously saved settings, which may be in groups of each user, each
experiment, or other classification.

Each profile (ezi file) contains ini file settings.

While the EZ-C1 is in operation, the profile selected during starting of EZ-C1 can be changed to another profile.
Also, while the EZ-C1 is in operation, the profile in use can be saved.

The name of the currently selected profile is displayed in the title bar of EZ-C1.

!ﬁ EZ-G1 for Hikon G1 Gonfocal Microscope  [Experiment A1 Gl1-Live

File GConfieure Data FERAP FEET Launcher Macro  SimpleGUD  Spectral  Time Lapze

CAUTION
- Device settings are common to all profiles. Therefore, a change made to the settings in the
Configure | Devices tab causes update of device information in all profiles.

Note

- When the EZ-C1 starts, the profile selection dialog box appears, prompting you to select a
profile.

- When the EZ-C1 exits, a prompt appears for saving the profile.

4.2.5.1 Save

The settings in the current ini file are overwritten for the selected profile.

4.2.5.2 Save as

The settings in the current ini file are saved as a new profile with a desired name.
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4.2.5.3 Select

A list of profiles appears. The profile selected during starting of EZ-C1 can be changed to a different profile.

Select Startup Profile ﬁl

k¢ Show thiz dialog on startup

[ Name Fath |

| ewpariment 200T0B06 ez CWProgram Files¥Nikon¥Shared¥Profilas¥  §
! experiment_| 0708050ez1 C¥Program Files¥MkonkShared¥Profiles¥  ©
| Clez Ci¥Prosram Files¥MikongSharad¥Profilesy §

Browmse | Diefault | [

Figure 4.2-7 Select Startup Profile dialog box

Name

Function overview

Show this dialog on
startup

Shows or hides the profile selection dialog during starting of EZ-C1.

When checked: Displays the profile selection dialog during starting of EZ-C1.
When unchecked: Does not display the profile selection dialog during starting of
EZ-C1.

[Browse] Opens the file selection dialog box, allowing you to select an ezi file not shown in
the list.

[Default] Selects “C1.ezi".

[OK] Applies the settings of the selected profile. As a result, the EZ-C1 is restarted.
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4.2.6 Acquire Option

Select the Acquire Option command from the Configure menu to display the EZ-C1 Configure Acquire Option

dialog box. Here you can set default settings for file names to be saved.

x

[~ Prompt befare ovensriting 'Single' acquired data

Overvwrite: Yes -

Figure 4.2-8 Configure Acquire Options dialog box

Deselect this check box to set the following options.

Name Function Overview
Prompt before Select this check box to display the Overwrite confirmation dialog box before
overwriting ‘Single’ updating image data at the start of scanning or during image acquisition mode
acquired data setup, etc.

Overwrite confirmation dialog box.

displayed.)

Overwrite Select Yes to enable overwriting without prompting for confirmation with the

Select No to disable overwriting. (The Overwrite confirmation dialog box is not
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4.3 Data

You can analyze and process images, write character strings on images, and draw diagrams on images by using
the following commands in the Data menu of EZ-C1.

- Analyze | Distance (see 4.3.1.1)

- Analyze | Histogram (see 4.3.1.2)

- Annotate | Color Legend, Cross Hair, Ruler, Select, Spot, Text (see 4.3.2)

- Calculate | Ratio (see 4.3.3)

- Filter | Kirsch, Laplace, Low Pass, Median (see 4.3.4)

- Reduce | Bin (see 4.3.5.1)

- Reduce | Crop (see 4.3.5.2)

- Spot (see 4.3.6)

- Spot| | PolyLine (see 4.3.6.2)

- Volume | Volume Height (3 D images only) (see 4.3.7.1)

- Volume | Volume Render (3 D images only) (see 4.3.7.2)

4.3.1 Analyze

4.3.1.1 Distance

Crosshair: A cross-shaped cursor consisting of the intersection of a vertical and horizontal line.
Crosshair pair: A pair of crosshairs which are used together.

To measure a distance in the image, the “Analyze” — “Distance” command on the “Data” menu is available.
This command adds one or more Cross hair pair to the views of the active image (Figure 4.3-1). In addition,
the “Distance” tab shows up in the View Settings dialog box (see 3.5).

A Cross hair pair is used to select a position in the multi-dimensional image. To move the cross hair to the
desired position, select it with the mouse left button. The selected state is indicated by small black handles. In
the selected state, the cross hair is positioned by dragging it with the mouse left button. To move the cross hair
in two dimensions simultaneously, start the dragging in the crossing point. When dragging is started on one of
the lines, the position in one dimension is changed.

The distance can be measured in two modes: the absolute mode or the differential mode. In the absolute
mode, only one cross hair pair is present and the distance is measured with respect to the image origin (left
top corner). In the differential mode, two cross hair pairs are present: the reference cross hair pair and the
running cross hair pair. The distance is measured between the two cross hair pairs.

In addition to positioning the selected cross hair with the mouse, the position can be set using the keyboard.
First, the fields in the Distance tab can be used to set the position of the running cross hair pair. To modify the
position of the other cross hair pair, press the [Swap] button which switches the reference cross hairs and
running cross hairs. Then, the position of the selected cross hair can be modified using the following
keystrokes.

<Left>, <Right>: move in first dimension (usually X dimension).

<Up>, <Down>: move in second dimension (usually Y dimension).
<PageUp>, <PageDown>: move in third dimension (usually Z dimension or time).
<Home>, <End>: move in fourth dimension (usually time).

<Delete>: delete cross hair.

88



4 Menu Functions

Digtance |Info i Golar ] View I

—Digtance -
o 232.42 u
dy: 232.42 Ul —— -300
Repaort
—Position -0
% I TdEum <] A 2
y | 1148um 4| 1 | =100
= I i 1 ! _b!
K} 4 ! ! ._:J
---thions
¥ Show in all Views
[¥ Differential
[¥ Use Units
[T Update Pozition of Wiews
[™ Diaeonal
[™ Show Results in View i
Uge <Ctrl-arrow to swap Colors Setup I add

Figure 4.3-1

Distance tab and an image window with a two Cross Hair Pairs

The Distance tab contains the following control fields.

Name

Function Overview

Distance

This field displays the distance between the reference cross hair crossing and the running cross hair.

[New Report]

By pressing the [New Report] button, a new report document is created with the
base name of the current image and the extension .txt. The distance
measurements are added to the report in a tab-separated format. Comments
can be added and the report can be saved under the default name or under a
different name. When a report is opened, pressing the [Last Report] button will
add the new measurements to the current report file.

[Last Report]

When the last used report is not closed, the measurements will be added.
Otherwise a new report is created.

Position

The position of the current running cross hair pair. After the position is changed,
click on the image to update the cursor position on the image.

Axis

The crosshair pair to be displayed and the method used to make measurements can be selected in the box.
The display changes as follows when each checkbox is checked.

X Display the lines to measure distances in the X direction and measured value is
displayed in the “Distance” field.

y Display the lines to measure distances in the Y direction and measured value is
displayed in the “Distance” field.

z Display the lines to measure distances in the Z direction and measured value is
displayed in the “Distance” field.

t Display the lines to measure distances in the T direction and measured value is

displayed in the “Distance” field.
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Swap

Check when swapping the reference crosshair pair for the running crosshair
pair. The swap is made even if both cross hair pairs are clicked.

Options

Show in all Views

Check this options to show the cross hairs in all views. Uncheck to show it only
in the active view.

Differential Check this options to show two cross hair pairs and report the distances relative
to the reference cross hair. Uncheck to show only one crosshair and report the
measurements with respect to the image origin.

Use Units Set the Position indicator unit either um or pixels.

Update Position of
Views

When the crosshair is moved, update the view to show the part of the image that
contains the cross hair crossing point. When in the “view” option “Synchronize
position of other views” is also set, all views will move their position to show the
cross hair crossing point. Note that when the reference and running crosshair
are swapped, all positions will be changed to show the running cross hair
crossing point.

Diagonal

Only the diagonal distance between crossing points is reported.

Show Results in View

Check this option to open another window to report the linear distance between
points for each dimension. Make the window which is displaying the linear
distance for the dimension shown active, and Use the Page Up or Page Down
keys or the up or down (T, 1) cursor keys to change. Note that the relative linear
distance for each dimension is displayed when “Differential” is checked.

[Colors Setup]

Press this button to display the dialog box for setting the colors and line format.
This dialog box can also be displayed by double clicking on part of the crosshair
with the mouse.
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4.3.1.2 Histogram

The “Analyze” — “Histogram” command on the “Data” menu creates a live histogram of the active image. The
command is also available with the Histogram button El on the Data bar. The histogram is calculated by
mapping the image pixel intensities to a bin index. When the source image or the histogram window is
activated, on the View Settings dialog box (see 3.5), the Histogram tab (Figure 4.3-2) with the options for the
histogram operation is added.

Histogram ! Infa l Color l i !

I Enable

Once l

Cancel I

input image | Live

outputimage [Histogram

— Hiztagram Option:
lowwest bin [_E LLI
rurnber of Bins I_ZEB‘l]
highiest bin I-WB‘ :—‘

1.50e4

1.00e4

— Dizplay option:

soale | count vi

[ Include Lowest Bin when Scaling Vertical auis.

I Include Highest Bin when Scaling WYertical axis.

soao

1000 ; 4000

Figure 4.3-2 Histogram tab and Histogram window

The histogram options on this tab are shown below.

Name Function Overview

[Enable] Press this button to start or stop the live calculation of the histogram.

[Once] Press this button to calculate the histogram once.

[Cancel] Press this button to stop the calculation and remove the Histogram tab. The
window with the histogram graph will remain on the screen but the histogram will
not be recalculated again. To close the window with the histogram graph, press
the close button [X] on the caption bar or select the “Close” command on the
“File” menu when the window is active.

input image The name of the source image

output image

The name of the output image

lowest bin

The pixel intensity that is mapped to the lowest bin. The number of pixels with a
pixel value lower than lowest bin is counted in the first bin. This bin count is
shown as the first point of the histogram.

number of bins

The number of bins. This number determines the number of points in the graph.
Reduce this number to segment the image into a smaller number of bins.

highest bin

The pixel intensity that is mapped to the highest bin. The number of pixels with a
pixel value higher than highest bin is counted in the last bin. This bin count is

shown as the last point of the graph.
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Include Lowest Bin
when Scaling Vertical
axis

The vertical axis scaling is optimized after each calculation to show all points of
the histogram. If this option is unchecked, the first point of the histogram is
ignored, and may extend beyond the top of the graph. Uncheck this option if the
image contains a large number of pixels with an intensity lower than lowest bin
and you want to see the histogram of the intermediate pixels value at a smaller
vertical scaling.

Include Highest Bin
when Scaling Vertical
axis

The vertical axis scaling is optimized after each calculation to show all points of
the histogram. If this option is unchecked, the last point of the histogram is
ignored, and may extend beyond the top of the graph. Uncheck this option if the
image contains a large number of pixels with an intensity higher than highest bin
and you want to see the histogram of the intermediate pixels value at a smaller
vertical scaling.

scale The scale of the vertical axis can be selected.

count The number of pixels in a bin.

pro mille The relative number of pixels in a bin with respect to the total number of pixels in
1/1000 units.

units The calibration factors are used to calculate the physical area of volume that is

covered by the pixels in the bin. In 2-dimensional images, the vertical axis shows
the area covered by the pixels, for 3-dimensional images, the vertical axis shows
the volume taken in by the pixels in each bin.
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4.3.2 Annotate/ Annotate bar

The commands on the “Data” menu and buttons on the Annotate bar enable the following features.

CAUTION
- If the “Steps” in the scan settings (see 3.3.4) is changed, the drawing and text are not displayed on
the specified position. Please set the position again.

Name Function Overview

Color Legend Creates a color scale in the image. This scale shows the relationship between
display color and pixel values.

When displayed in the Single Channel Pseudo Color mode, it uses colors from
the lookup table to render Intensity display colors.

The Multi Channel Pseudo Color and the Multi Channel True Color mode use
the display colors of each channel to show images.

Cross Hair Creates a distance measuring cross hair (see 4.3.1.1) in the image. Double click
on the cross hair, or click the Color Setup button, to display a dialog box to set
the color and line format. Press the <Delete> key to remove the cross hairs.
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Ruler Click the left mouse button on an image while dragging, to create a ruler object.
The ruler is a white rectangular bar to which a length-indicating label is attached.
To delete any ruler, select the ruler, and then press the Delete key.
Double-clicking a ruler you've created brings up the Annotation Ruler Properties
dialog box (Figure 4.3-3).

Annotation Ruler Properties
Ruler
Calar
coor |
Label
[~ Show Text: |
[v Show Diztance
Size
Length f* Mot Raunded
£ Raunded
" Exact thig gize: ,750
Wisight; ’—j
Shape
W Arrow Arrow Style l—w—’,
[ ok | =et | | o~z
Figure 4.3-3 Annotation Ruler Properties dialog box
Color
Color: Specify a color of a ruler.
Label
show Text: A text comment is displayed on a ruler.
Show Distance: A length of a ruler is displayed.
Size
Not Rounded: Ruler length is displayed with a value not rounded.
Rounded: Ruler length is not rounded off. Set values are expressed in
multiples and rounded to the nearest representable
multiple. (Enter only representable values such as 5 um, 10
um, 20 um, etc. for rounded values.)
Exact this size: Enter ruler length values in the edit box.
Weight: Specify a thickness of a ruler.
Shape
Arrow: An arrow for a ruler is displayed.
Arrow Style: Specify a type of a ruler.

n To obtain an exact scale, make sure that settings of Configure|Objectives
(see 4.2.3) are made correctly, and that Calibration on the Mirrors tab of
the Configure Confocal C1 dialog box (see 5.2.4) are set correctly.

Select

Selects an annotated object displayed on the image to permit movement or size
adjustments.
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Text

Left-click on an image to display the Annotation Text Properties dialog box and
enter text for annotation. To modify an existing text annotation, double-click on
the text object in the image and revise the content in the ensuing Annotation

Text Properties dialog box. Press the Delete key to discard the text annotation.

4.3.2.1 Annotate Bar

Shortcut buttons for the Annotate function are provided on the Annotate Bar.
This bar is a part of the tool dialog box and can be displayed with the Annotate Bar command on the Tool

menu.

Following functions are available with this bar.

Annotate Bar

5]
=) wlale| E[L] o|n|a]afo] k|

Figure 4.3-4 Annotate Bar

Name

Function Overview

il Select

Press this button to select an annotation object on the image to move it or to
resize it.
(Same as Select on Annotate of Data menu)

Lasso

Selects multiple spots. Selects all spots within the specified area.

&l Cut Deletes the selected figure or character.
\ﬁl CutAll Deletes all figures or characters.
Copy Copies the selected figure or character (excluding CrossHair).

Paste

Pastes the copied annotation onto the active window.
When pasting to a different window, the XY coordinate will be inherited.

- .
J‘ Duplicate

Duplicates the selected annotation within the same window.

ﬂ Ruler

Press this button to display a ruler.
(Same as Ruler on Annotate of Data menu)

\il Text

Press this button to enter an annotation text on the image.
(Same as Text on Annotate of Data menu)

95




4 Menu Functions

Event marker
(ATE)

Specify the ATE marker E | (acquisition time event marker), which is one of
time event markers.

This marker targets only the Time Series data after the observation and is used
to set an event in the acquired data.

Clicking this button displays a difference from the time at which frame data
acquisition starts” for each frame based on “the time, for which a marker is set,
at which frame data acquisition starts.

(See 3.4.6 Time Series.)

Digplay in 2D image Display in 10 Graph

Acquisition start time Data acquisition start time far a frame for
for each frame is which an event is set iz displayed. (Figure
displayed. It is hased helomy shows the case when Axis =12

an a frame far which

aneventis set. S s Tise Tariom]

EE1-Live Ta Ees i

Display in 30 orthogonal Display in 30 tiled
Diata acguisition start time A frame for which an event is set is
for a frame for which an displayed.

event is setis displayed.

LEGI-Live Time En”il_____EE[El

|E| Color Legend

Press this button to display a color scale.
(Same as Color Legend on Annotate of Data menu)

H Cross Hair Press this button to display a cross hair for measurement of an image.
(Same as Cross Hair on Annotate of Data menu)
L) | M | (] | O | O | Information on these buttons is provided in Section 4.3.6.1, “Spot” on the Spot

command.

2|

This function works with “spectral data.”

The spectral graph for the spot data of the spectrum image is displayed. (The
horizontal axis is wavelength.)
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4.3.3 Calculate (Ratio)

The “Ratio” command on the “Data” menu makes it possible to calculate the ratio of 2 channels in a currently
active image in real time. The ratio is found by dividing one channel (numerator) by another channel
(denominator). Enter settings in the Ratio tab (Figure 4.3-5) in the View Settings dialog box.

You can also run the “Ratio” command by pressing the Ratio button | le on the Data bar.

Ratio ]Info ]Oolor ]\.-‘iew ]

Enable Once | Cancel

input image Cl-Live

output imaee |Ratio 1

Channels : |2 ﬂ Fa |1 ﬂ

¥ Mazk Pixels darker thar:

¥ fButomatic Best Calar Fit

¢ 4l i

Figure 4.3-5 Ratio tab

The filter options on this tab are shown below.

Name Function Overview

[Enable] Press this button to start calculation of image ratios. A second press cancels the
operation.

[Once] Press this button to calculate the image ratio once and create a Ratio image.

[Cancel] Press this button to stop calculation and close the Ratio tab. The Ratio window
will still be on the screen, but the Ratio image is not recalculated. To close the
Ratio window press the Close button [%] or select the “Close” command from
the “File” menu.

input image Show the window name of the image to be calculated.

output image

Show the name of the window displaying the calculation result.

Channels

Specify the channels to be used as numerator and denominator in the
calculation of image data.

Mask Pixels darker than

Low pixel values in the divider channel result in very high ratio values. Check the
“Mask Pixels darker than” to set ratios to zero when the divider channel pixel
value is lower than the specified threshold.

Automatic Best Color
Fit

Check this option to perform the “Best Intensity Fit” operation after each
calculation (same operation is obtained when button on the Color tab of
the View Settings dialog box (see 3.5.2).
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The “Filter” commands on the “Data” menu, Median, Low Pass, Kirsch and Laplace, start live filtering of the
active window. The commands are also available with the Median il and the Low Pass LP| buttons on the
Data bar. When the filtered or source image is activated, the View Settings dialog box shows the Filter tab
(Figure 4.3-6) with the options for the filter operation.

Filker Ilnfo | Colar | Wig I
Enable I Once | Cancel |
Source : |Live
Filter : IMedian j

Size : m m ¥ Square

The bedian filker set each pixel to the middle walue in the sorted
lizt of neighbour pixels. Moise iz suppressed while edges are
preserved.

[~ Update Display during Enable
v Automatic Best Color Fit

Figure 4.3-6 Filter tab

The filter options on this tab are shown below.

Name Function Overview
[Enable] Press this button to start or stop live filtering of the image.
[Once] Press this button to filter the image once.
[Cancel] Press this button to stop the calculation and remove the Filter tab. The window

with the filtered image will remain on the screen but is not recalculated again. To
close the window with the filtered image, press the close button [x] on the
caption bar or select the “Close” command on the “File” menu when the window
is active.

Source Shows the name of the source image.

Filter
Specifies the filter to be used. Filters which can currently be used are: the Kirsch filter, Laplace filter, Low
Pass filter, and Median filter.

Kirsch filter Enhances the gradient. Check the “Gradients Only” option to display only
gradients.

Laplace filter Enhances edges. Check the “Edges Only” option to display only edges

Low Pass filter The average value for adjacent pixels is set one-by-one for each pixel. Although
this eliminates noise, it also lowers brightness.
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Median filter The median value for a sorted list of pixels that touch is set one-by-one for each
pixel. Although this eliminates noise, edges are saved.

Size Set the size of the Filter window in the horizontal and vertical direction. A larger
filter window has more impact but increases the calculation time.

Square Check this option to force the Filter window to be square.

Power It is possible to increase or decrease the brightness of the processed edge
image or gradient image. (This item can only be checked when the Kirsch or
Laplace filter is selected.)

Brightness It is possible to increase or decrease the brightness of the original image with

which a gradient or edge image is to be merged. (This item can only be checked
when the Kirsch or Laplace filter is selected.)

Gradient Only

Check this option to display only the processed gradient image. If unchecked,
the gradient image is merged with the original image. (This item can only be
checked when the Kirsch filter is selected.)

Edges Only

Check this option to display only the processed edge image. If unchecked, the
edge image is merged with the original image. (This item can only be checked
when the Laplace filter is selected.)

Circular Filter

Check this option to change the shape of the filter kernel from a square shape to
a circular shape. Doing this alleviates the noise produced due to processing
regularly associated with the grid pattern. (This item can only be checked when
the Low filter is selected.)

Update Display during
Enable

Check this option to refresh the image during the calculation of the image. This
will slow down the calculation time but gives you visual feedback about the
progress.

Automatic Best Color
Fit

Check this option to perform the “Best Intensity Fit” operation after each

calculation (same operation is obtained when i" button on the Color tab of
the View Settings dialog box (see 3.5.2).
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4.3.5 Reduce

4.3.5.1Bin

Selecting the “Bin” from the Reduce command in the Data menu adds a Binning tab (Figure 4.3-7) to the View
Settings dialog box (see 3.5). This tab lets you alter the resolution by adding the brightness values of several
pixels (or pixels between two frames) and representing the sum by one pixel (or pixels between two frames).
Use this function to reduce image size or increase brightness. (This increases the intensity of all pixels,
thereby increasing the value of any particular pixel.)

Binring | Infa I Calar I Wi I

input image |51 Live
autput imane |Binned Cl-Live 1
— binning
factor zize
g [ 2= 265]
¥ [ 24 | 256
: | = =
: | = =
Optionz
r Convert to floating point data type
[T Automatic Best Color Fit
Figure 4.3-7 Binning tab
Name Function Overview
input image Shows the window name in which the original image whose resolution you are
going to alter is displayed.
output image Shows the window name in which the image with adjusted resolution is
displayed.
binning
factor Specify (or show) the number of pixels (or frames) you want to be calculated as
one set.
size Specify (or show) the pixel size (or number of frames) that you want after the
size is altered.
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Options
Convert to floating When this option is selected, the data type in which the calculated total
point data type brightness value will be stored is changed to four-byte floating-point values.

Unless this option is selected, the data type of the original data is used.

- In cases in which the original data is an 8-bit quantity, if brightness values
150 and 200, for example, are added together, the sum will exceed the
maximum value representable by 8 bits (= 255). Unless four-byte float option
is selected, the summed value cannot be stored in the original data type and
is simply replaced by the greater of the two pixel values. Selecting this option
enables storage of the entire calculated value.

Automatic Best Color When this option is selected, each time calculation is completed, the same

Fit operation is performed as would be performed when you pressed the optimum
brightness set button on the Color tab of the View Settings dialog box
(see 3.5.2).
4.3.5.2Crop

The “Crop” command on the “Data” menu can be used to create a sub-image of the current image. The
command is also available with the Crop button on the Data tool bar. The sub-image contains a part of
the active image. Create a cropping area if you want to use only a part of the active image. The sub-image can
be used as a normal image. However, changes in the sub-image will also show up in the original image.

Create a cropping area if you want to:

View a part of the original at a larger detail.

Save only a part of the original image.

Use only a part of the original image for data analysis.

When a cropping area is created, the source image window, a cropping area tracking box appears in the
source image window to specify the cropped area. Press the mouse left button in the cropping area tracking
box and move the box to set the position. Press the mouse left button on one of the black handles to resize the
cropping area.

The Cropping Area tab (Figure 4.3-8) is added to the View Settings dialog box (see 3.5) to enter the cropping
area position and size.

Infa | Calar |\u"iew CroppingAreal

input image I Live j

output image ICropped Live 1

- area
start size

chanrels I 1 j I 4ﬁ

H | 129 | 256 =]

] | 1294 | 56

? | 1= =

[V Bounding Box Visible
¥ Docurnent Yiew Visible

Figure 4.3-8 Cropping Area tab
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The Cropping Area tab contains the following items.

Name

Function Overview

input image

The name of the input image.

output image

The name of the cropping area.

area

start Sets the coordinate of the first pixel of the cropping area as well as the number
of channel.

size Sets the number of X, y, and z pixels in the cropping area as well as the number
of channel.

channels The index of the first color band (start) and the number of color bands in the

cropping area (size). To refer only to the first color band, set the “start” of the
“channel” to 1 and the “size” to 1. To refer only to the second color band, set the
channels offset to 2 and the size to 1.

For each dimension in the input image, the above two fields (starts, size) are
provided.

Bounding Box Visible

Check this option to show the area to be cropped in the currently active image
window.

Document View Visible

Uncheck this box to hide the window that shows the cropping image.

4.3.6 Spot

4.3.6.1 Spot

Using a command in Spot on the Data menu or icon button on the Annotate bar, draw a spot in the two or
more dimensional image. Then information inside the spot can be obtained. Spots can also be used as a
border for Bleach operations (see 3.6).

The Spots Of Interest tab in the View Settings dialog box allows you to obtain Intensity information and show
Intensity graphs whose horizontal axis is t and z.

The “Spot” command and the icon buttons on the Annotate bar can draw the following type of spots.

(Annotate Bar: | 0Y)

Name Function Overview
Ellipse Creates an elliptic spot. When dragging a mouse from the clicked point, a
(Annotate Bar: | O |) diameter becomes larger. Create a spot while holding down the Shift key to draw
a circular spot.
Point Click a point spot. A spot is created at the point clicked. Information can be
(Annotate Bar: | * |) acquired from a single pixel or bleach setting can be performed by this button.
Polygon Creates a polygonal spot. Click to create vertexes. Double-click at the end point

to draw a line between the starting point and the end point, which automatically
makes a polygon.
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PolyLine Creates a free polygonal line. Click to create vertexes. Double-click at the end

(Annotate Bar: ]il) point. (See 4.3.6.2.)

n This spot can be used for spectral graph display and the Bleach function
like other spots. The spot also has length measurement and Intensity
Profile functions.

Rectangle Left-click to form the starting point and hold down the button while moving the
(Annotate Bar: O |) mouse to the end point where you let go of it. The starting point and end point
form the diagonally opposite corners of the rectangle that is drawn.

Note

- The above spots can be displayed only in 2D display mode (when View = 2D image and Axis = xy, yx
are set in the View Settings dialog box).

- The square handles at the boundaries of a spot can be dragged to resize it. To change the location of
a spot, click a point inside the spot or on the boundary and drag. To delete a selected spot, press the
Delete key.

The Spots Of Interest tab (Figure 4.3-9) in the View Settings dialog box appears when a spot is drawn. This
tab provides the following information and the following settings.

Info | Color | Transmitted | Wiew  Spots Of Interest ]

Spots
Spot | Color | BL. | firea | A
1 [ e 0247 umz2 d%t oot all
2 - ok 2285 um2
3 . - on 1688 um2 q
4 4 on 2018 um2 Copy | Paste
] - ok 1471 um2 [
—_— - - .-.I
{ % Clore

¥ Use Units for the frea

fveraee £ frea

v Enable Export

chatinel [ create eraph
z axis: |create eraph =l .I
t axis: |anly visible slics =]
Line Profile
[+ Enablz

Figure 4.3-9 Spots Of Interest tab

Name Function Overview

Spots
Display the Spot data.

Spot Display the spot name. Serial numbers are assigned by default.
n Right-click Spot in the target window to open the Property page to change
the name of a spot.
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Color Select colors for spots.
n The color selected for a spot is also used in the Data Series graph window.
Bleach Specify on when the spot is bleached.
n Bleach is only available if the PC is equipped with an analog output board
(a board installed in a PC for controlling laser output).
Area Show the area occupied by a spot.
<I>:n Indicate the average brightness of each channel.
fE Delete the selected spot in a window.
;
[Cut]
Ej'#, Delete all spots in a window.
Lt Al |
[Cut All]
By Copy the selected spot.
Copy
[Copy]
q‘ Pastes the copied spot.
Pazte
[Paste]
o7 Duplicates the selected spot within the same window.
Clofe
[Duplicate]

Use Units for the Area

Switch area indicator units.
When this checkbox is selected, areas are indicated in um x um; when
deselected, areas are indicated in pixels x pixels.

Average/Area

Specify the brightness data of the spot.

[+ Enable Area, <|>:n and output graph values are recalculated during scanning and spot
[Enable] movement (and resizing) while this checkbox is checked.
channel

¥ create eraph

When this checkbox is checked, the spectral graph for the spot data of the
spectrum image is displayed. (The horizontal axis is wavelength.)
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* axis

Appears only for a window with 3D data or data with more dimensions (Z-stack

or TimeSeries data). This item is not available for 2D data.

n This axis is referred to as the z-axis for Z-stack data and as the t-axis for
TimeSeries data.

only visible slice:  An area and average brightness value of each spot on
the displayed 2D slice are calculated.
create graph: For each spot an average intensity value graph whose
horizontal axis is t or z is created. (The [z/t-axis graph]
button provides the same function.)
integrate over full range: Volumes of each spot and the brightness values of
all slices of each spot are integrated. And an
average value of them is displayed.

Export
[Export]

Spot information (areas (pixel,um2) and a brightness value of each channel) is
output in the txt file with the csv format. A pass and filename of the output file
can be specified.
When target data is 3D or 4D, contents of the output file depend on settings of
"z-axis and t-axis."
Example: when "z = create graph" and "t = only visible slice":

Z1, Spot 1, Arealpixel], Area[um2], Intensity(Ch1), Intensity(Ch2) ..

Z1, Spot 2, Area[pixel], Area[um?2], Intensity(Ch1), Intensity(Ch2) ..

Z1, Spot 3, Area[pixel], Area[lum?2], Intensity(Ch1), Intensity(Ch2) ..

Z2, Spot 1, Area[pixel], Area[lum?2], Intensity(Ch1), Intensity(Ch2) ..

Z2, Spot 2, Arealpixel], Area[lum2], Intensity(Ch1), Intensity(Ch2) ..

[t/z axis graph]

Press this button to display a time series graph or Z-stack graph of the spot data
in 3D images (an average intensity value graph whose horizontal axis is t or z).
n This button is active when “create graph” is selected in *axis.

Line Profile

Specify the Intensity Profile function when the Spot is made of PolyLines.

v Enable
[Enable]

Check this checkbox to display an Intensity Profile graph for a spot made of
PolyLnes.
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Note
- Spots are drawn according to the following rules.

(1) A spot drawn on an image created using the New command on the Window menu also appears in
existing windows in different modes, but does not appear on original images in the same mode, in
other new windows in the same mode and in new windows belonging to other groups.

(2) A spot drawn in an existing window created using the New command on the Window menu also
appears in existing windows in different modes, but not in new windows of the same mode and
new windows belonging to a different group.

Example: Open a Live window and a TimeSeries window and create a new window in each.

(1) Drawing a spot in a live window
— The same spot is also drawn in the TimeSeries window, but not in the new windows
of either mode.
(2) Drawing a spot in new window in Live mode
- —The same spot is also drawn in the TimeSeries mode, but not in the Live window and other new
windows.

4.3.6.2 PolyLine

Select the PolyLine command from “Spot” on the “Data” menu or icon button on the Annotate bar to draw a

PolyLine on a 2D or 3D image to obtain information of the line.
Like other type spots, this spot has Intensity data (graph display), the Bleach function as well as length
measurement and Intensity Profile functions.

Length measurement function: When a PolyLine is drawn, length measurement data is also displayed with a
solid line. The unit of the measurement data can be changed by using
“UseUnits” on the View tab in the View Settings dialog box. Right-click
PolyLine to display the Spot Properties dialog box, where a width and color of
a line can be changed. (See Figure 4.3-11 Spot Properties dialog box.)
Intensity Profile function: When “Line Profile” is enabled on the Spots Of Interest tab in the View Settings
dialog box, Intensity Profile graphs are displayed (see Figure 4.3-10 Intensity Profile
graph). Display setting can be changed on the View tab in the View Settings dialog
box. (See 3.5.3.6.)

Lire Profile
[+ Enable

Spot functions

Bleach function: PolyLine can be specified as “Bleach border” by setting the Bleach function like other type
spots. The setting is made on the Spots Of Interest tab in the View Settings dialog box or in
the Spot Properties dialog box displayed by right-clicking PolyLine.

Intensity data (graph display): Like other type spots, intensity data is displayed on the Spot of Interest tab in
the View Settings dialog box. When image data is 3D or spectral data, “an
Intensity graph of PolyLine whose horizontal axis is t or z” or a “spectral graph”
can be displayed.
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B ci-Live

LB Line Profiles in C1-Live Wolume 1

100

Figure 4.3-10 Intensity Profile graph

Spot Properties EJ

Paly-Line ]
Hame |ﬁ
Caler —

Eorder width 5 4::|

Iv Show Leneth

Eleaching an j

(0] 4 | Cancel | | Help |

Figure 4.3-11  Spot Properties dialog box

Name Function Overview
Name Specify the Spot number. The default value is named after other spots.
Color Specify the display color of spots.
Border width Specify the thickness of lines. Between 1 to 2,048 pixels can be set.

Show Length

Check this checkbox to show the measured data.

Bleaching

Specify “on” to bleach the spot.
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4.3.7 Volume

4.3.7.1 Volume Height

The “Volume” - “Volume Height* command on the “Data” menu creates a live height map of a 3D image. Each
pixel in the height map represents the height position of the pixel in the stack with the highest intensity. When
the source image or the height tab window is activated, the Height tab of the volume (Figure 4.3-12) is added
on the View Settings dialog box with the options for the volume height operation.

Height | Infa I Calor I iew |

Enable | Once | Cancel |

— Threszhalds

Lawer I 0%
Higher: I 100 %

— Dption

[}
[}

= =

r Ineeert Top-Bottom
[T lgnore Offset
v Autormatic Best Color Fit

Figure 4.3-12 Height tab

The volume height options on this tab are shown below.

Name

Function Overview

[Enable]

Press this button to start or stop the live calculation of the height map.

[Once]

Press this button to recalculate the height map once.

[Cancel]

Press this button to stop the calculation and remove the Volume Height tab. The
window with the height map image will remain on the screen but the height map
will not be recalculated again. To close the window with the height map window,
press the close button E on caption bar or select the “Close” command on the
“File” menu when the window is active.

Thresholds

Select the intensities thresholds used to calculate the height map. These fields
specify a threshold value relative to the highest intensity found in the source
image. Set the “Lower” to ignore lower intensities. Increasing the “Lower”
threshold will suppress noise in areas were no maximum is found. Set the
“Higher” threshold to ignore higher intensities. Decrease the “Higher” threshold
to minimize the effect of noise in the brighter parts of the images.
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Options The “Invert Top-Bottom” option will traverse the image in the opposite direction.
Use this option to visualize details that are hidden by structures on topside of the
image. The “Ignore Offset” option will ignore the offset info field and assign
pixels height value with respect to the top of the image. The “Automatic Best
Color Fit” option will perform the same effect as clicking the Best Color Fit button
ﬂ (see 3.5.2) after each calculation.

4.3.7.2Volume Render

The “Volume” - “Wolume Render” command on the “Data” menu creates a 3-dimensional object based on a
given 2D image. To create a new projection, activate a 3D image and select the “Volume” - “Volume Render”
command on the “Data.” A new 2D image is created. When the new image is activated, the Render tab (Figure
4.3-13) is added on the View Settings dialog box (see 3.5).

A cube wire-frame is drawn in the new image that represents the boundaries of the input image. The cube can
be positioned with the mouse to the desired rotation angles. Press and move the mouse left button. A
horizontal movement adjusts the spin angle. A vertical movement adjusts the tumble angle. Resizing the
output window will change the number of pixels of the output image. Note that projecting the volume to a large
2D-image will require considerably more calculation time.

When the output image is saturated or too weak, press the il button to optimize the View Color Settings
(see 3.5.2). The controls on this tab sheet can be used for manual adjustment of the color display properties of
the new image.

The sequence controls are used to create an animated rotation. The output images size will be changed to a
series of images that can be animated by pressing the |E| button on the View tab in the View Settings dialog
box (see 3.5.3). In addition the images can be viewed in a tiled fashion by selecting the Tiled display mode.

Render ||nf0 | Color | Wiew |

Enable | Once | Cancel |

input image IC1-Live Volume 1
outputimage  [Volume Render

= — Praojection
0in | a °32 method IMaximum 'l
tumble I a °E
200 I D.SE

— Sequence —Image
change Itumhle "l width B0 =
steps | = height 40 =
start | 0= [ Print Quality
sten | 5= [¥ Bounding Box Visible
current I 0

Figure 4.3-13 Render tab

The Render tab contains the following controls.

Name Function Overview

[Enable] Press this button to start or stop the render. When rendering is enabled, the
arrival of new data in the source image will trigger recalculation.
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[Once] Press this button to perform the rendering once. The arrival of new data in the
source image will not trigger recalculation.

[Cancel] Press this button to remove the render module. The rendered image will stay in
memory and can be saved to disk.

input image The name of the 3D image used as input.

output image

The name of the output image.

View

spin The rotation angle around the y-axis. This angle can also be set using the
mouse. Press the left button in the output image window and drag horizontally.

tumble The rotation angle around the x-axis. This angle can also be set using the
mouse. Press the left button in the output image window and drag vertically.

zoom The zoom factor. Increase to zoom in to the center of the 3D image.

Projection

Maximum Maximum Intensity Projection processing is carried out. In this method, a

intensity value is extracted only at the brightest point. The dynamic range in this
method becomes the same as the range of one sheet of the images. For
example, in the case of the image acquired by C1, the dynamic range of Volume
Render is set to 4096.

Accumulate

Accumulate Intensity Projection processing carried out. In this method,

calculation of addition etc. is performed about the intensity value in all points. In

this case, the more it is far, the more an intensity value is calculated by a value

decreasing.

In this method, since addition processing is carried out, a dynamic range

changes with the height of the acquired image data, width, and depth. For

example, in the case of the data acquired by C1, if image size is 256x256 and Z

step is 64, the dynamic range of Volume Render will be set to 4096x256.

- Since there is the above-mentioned feature, in Volume Render image, both
the setting value of “Coarse Saturation Level” and “Coarse Dark Level” does
not have restriction.

Sequence

steps The number of images in the sequence.

change The angle that is changed in the animation: spin or tumble.

start The start value of the angle that is changed in degrees.

step The increment step of the angle that is changed in degrees.

current This number indicates which number in a sequence of images the current image
corresponds to.

Image
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channels The number of image channels of the output image.

width The width of the output image in pixels. Resizing the output window changes the
width.

height The height of the output image in lines. Resizing the output window changes the
height.

Print Quality Check this option to perform Render calculations based on the same resolution

as the original image.

If this is unchecked, the Render calculation uses the image resolution needed to
fit the image in the window (Volume Render window) in which the result will be
displayed.

- Use this function for high-resolution results: e.g., for printing.

Bounding Box Visible Check this option to show the wire-frame of the input image boundaries in the
output image.

4.3.8 Data bar

The Data bar contains shortcut buttons to access the Data menu commands. The Data bar is one of the tool
dialog box (see 4.6) that can be displayed with the EZ-C1 “Data” on the “Tools” menu. The Data bar contains
the following buttons.

Q)
2| ELP| M| ¥

Figure 4.3-14 Data Bar

Name Function Overview

Measures a distance in the active image (see 4.3.1.1).

Creates a live histogram of the active image (see 4.3.1.2).

Creates a Cropping area of the active image (see 4.3.5.2).

Creates a live image that is filtered with median filters from the active image (see
4.34).

=8 E|l~

=

Creates a live image that is filtered with low pass filters from the active image
(see 4.3.4).

Creates a live ratio between two channels of the active image (see 4.3.3).

=
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4.4 Launcher

The Launcher function lets you launch any other application from within EZ-C1.
Select Settings from the Launcher to display the Launcher Settings dialog box (Figure 4.4-1). In this dialog box,
you can register, edit, or delete information about the application you want to launch.

Launcher Settings
Edit Launcher Settings x|
Title: IEZ—C'I Wiemer
Application: Iiles¥Nik0n¥EZ-C‘I 210¥EZCT 2exe _I
Warkine Folder: Icuments¥h‘1y Pictures¥EZ-C1¥Imase| _I
Breuments: I$P7 Uze §P for the name
of the active image
File Format: [4s -
[V Share the file with EZ-C1
Cancel I QK I Cancel | ’TI

Figure 4.4-1 Launcher Settings dialog box Figure 4.4-2 Edit Launcher Settings dialog box

The Launcher Settings and Edit Launcher Settings dialog box provides the following buttons.

Name Function Overview

[Add] Displays the Edit Launcher Settings dialog box (right-hand part of Figure 4.4-2).
Use this button when you register a new application you want to launch.

[Delete] Deletes a selected registration.

[Edit]

Displays the Edit Launcher Settings dialog box (right-hand part of Figure 4.4-2). The content of a selected
registration can be edited.

In the Edit Launcher Settings dialog box, you can set the following content.

Title Enter the name of a registration. The registration name is displayed in the list of
the Launcher Settings dialog box and below Settings on the Launcher menu.
(The registration names are displayed in the order in which they were
registered.)

Application Set the directory in which the executable file for the application you want to
launch is stored.

Working Folder Specify the folder normally used by the application you want to launch.

Arguments Specify the arguments that will be used in the application you want to launch.
When you enter “$P” here, the image in the image window selected in EZ-C1 is
passed to the application at startup.

File Format Specify the image format in which you want the image in the image window
selected in EZ-C1 to be passed to the application as it starts. (This format can be
specified only when “$P” is set for Arguments.)
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Share the file with The default file attribute setting does not allow the file to be simultaneously read
EZ-C1 from different applications.

If this option is checked, EZ-C1 disables the attribute for the image file currently
displayed in the selected EZ-C1 window, permits access to this file, and
launches the registered applications.

If this option is unchecked, EZ-C1 copies the image file currently displayed in the
selected EZ-C1 window, permits access to the copy, and launches the
registered application.

Note
- “Share the file with EZ-C1” option can be changed only when IDS file format is selected. The option is
automatically selected and cannot be unselected if any other file format is selected.

The application names registered in the Launcher Settings dialog box are added below Settings command in
the Launcher menu. Click an application name to launch.

|Launu:her Toolz MBS

i Gettings
- g 1 EZ-C1 Wiewer

Figure 4.4-3

4.5.1 Channel Tiled / Untiled

Channel Tiled shows channel images in Tiled view. The channels for the target image is shown in Tiled view.
Channel Untiled returns channel images shown in Tiled view to single frame images.

4.5.2 Ids Tiff Convert (Ids Tiff Convert Macro)

IdsTiffConvert converts an IDS file into a TIFF file continuously.

4.5.2.1 Starting Ids Tiff Convert

IdsTiffConvert is located in the default project (Default.ezm).
To start IdsTiffConvert, follow the procedure given below:

1. Click [VBA] - [Macro] - [Macros...] to display the [EZ-C1 Project] dialog box.

2. Select < All Standard Projects > in the [Macros in:] combo box to show all procedures.
3. Select “IdsTiffConvert” from the list.

4. Click the [Run] button.
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4.5.2.21dsTiff Convert dialog box

05Tt Gomerter x
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Executing “IdsTiffConvert” dis

Figure 4.5-1 |dsTiff Convert dialog box

plays the IdsTiff Convert dialog box (Figure 4.5-1).

Use this dialog box to select an IDS file from a desired folder, to convert it to a tiff file, and to save it.
Individual control functions are described below.

Name Function Overview

IDS File Path Sets the path to a folder containing an IDS file. By clicking the Browse button at
the right, a path can be set using the folder selection screen.

IDS file field Displays the list of IDS files in a specified folder.

Tiff File Path Sets the path to a folder in which to save a TIFF file. By clicking the Browse
button at the right, a path can be set using the folder selection screen.

TIFF file field Displays the list of candidate files for conversion to the TIFF.

[Add] Clicking this button after selecting a file in the IDS file field adds the selected file
to the TIFF file field.

[Remove] Clicking this button after selecting a file in the TIFF file field deletes the selected
file from the candidates of files for TIFF conversion.

Save Format

The image can be stored as:
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Raw format The Raw format stores all data without color information or conversion.
Use this format to export the image data for analysis purposes.
However, there are not many programs that are able to read the raw data
format.

RGB format The RGB format stores up to 3 channels (red, green, blue). The image data is

converted to 8-bits by matching the brightness to the 8-bits range.

In this format, you may allocate color of channels.

See the following Channels item.

Re-opening this format image, channels are assigned in order of RGB.

Most applications support 24-bits RGB images.

Use this format to export data to applications that do not support the Raw format.

Bitmap format

The image data is saved as a 24-bit RGB tiff image that appears to the eye just
like the image displayed in the window. Select this format when you wish to save
figures and text along with an image using the annotation function.

Use this format for presentation purposes.

Save 3D as

When 3D files are saved, the image slices can be saved in one file or in separate files.

one tiled file

Check this option to store all slices in one file.

series of files

Check this option to save each slice in a separate file with an incremented index
(**_001.tiff, **_002.tiff, ...).

In addition to the slice files, a text file is written with the extension .tsr (tiff series)
that contains the names of the slice files. When this file is opened with the
“Open” command on the “File” menu, all slice files are read and the 3D image is
reconstructed. When copying or moving series of files, be sure to keep the slice
files and the .tsr file together.

Byte Order

The following byte orders are supported.

Intel (PC)

Use this byte order when writing images using Intel-based computers.

Motorola (Mac)

Use this byte order when writing images using Motorola-based computers
(Macintosh).

Channels The selection which image channel is saved on each color. This item is only
shown in RGB format.

[Convert] Conversion is executed and all files in the TIFF file field are converted into tiff
files.

[Cancel] Close the dialog box without executing conversion.
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4.5.3 Switch Scanning Area procedure

The default EZ-C1 project contains a Switch Scanning Area procedure.
Switch Scanning Area performs global scanning setting. Two types of settings are available.

Note
- This default project cannot be used by Viewer.

4.5.3.1 Starting Switch Scanning Area

Switch Scanning Area procedure is located in the default project (Default.ezm).
Selecting the Switch in the VBA menu activates Switch Scanning Area procedure.

4.5.3.2 Switch Scanning Area dialog box

Swilch Scanning frea

Scan [oLve |
buttans L— | Selact Scan Settings 1 Select Scan Seffings 2

Setting selection
huttan

(Scan Setings 1

Synchronization
hutton

Settings 1 PoelOwell | 40Bus 4] |
fleldofview | 2122 um 4
1 position | 00um 4
¥ position lm Kl

steps .| 512 ¥ 512 160 256 512 4| 2 j

Settings 2— li |
=
-
-

Figure 4.5-2 Switch Scanning Area dialog box

Executing “mdISwitchSA.Switch” displays the above Switch Scanning Area dialog box (Figure 4.5-2).

The values in effect at the end of the previous session are recovered.

Switch Scanning Area can store two sets of scan area settings. The [Select Scan Settings] button lets the
user select the desired scan settings.

Click the [Synchronize] button to synchronize operations with EZ-C1.

To exit Switch Scanning Area, click the EI button in the upper right corner of the window. This saves the
current settings and closes Switch Scanning Area.
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Individual control functions are described below.

Name

Function Overview

Scan button

Starts a scan. Select [Live] or [Single], depending on the application.
When not in synchronization mode, EZ-C1 will reflect the current settings before
a scan starts.

Select Settings button

Used to select the settings to be activated. Inactive settings are grayed-out,
indicating that they cannot be modified.
When not in synchronization mode, EZ-C1 will reflect the active settings.

Settings 1, Settings 2

Used to enter settings to be reflected in EZ-C1.

Specifications such as the range of input values and the unit of input are the
same as those for EZ-C1.

If the Switch Scanning Area setting values cannot be reflected in EZ-C1 for
some reason (e.g., when setting values exceed EZ-C1 upper/lower limit values),
the settings are invalid. The setting values are automatically saved when Switch
Scanning Area closes, then automatically loaded on subsequent startup.

Synchronize button

This button has two functions:

Clicking the button reflects the current EZ-C1 settings in Switch Scanning Area.
These settings include the numerical input range and the unit of input.

Click the button before entering new settings.

Pressing and holding down this button invokes synchronization mode.

In synchronization mode, monitoring occurs in real-time to ensure the
consistency of Switch Scanning Area and EZ-C1 settings. (There may be a slight
lag in synchronization of settings during a Live scan.)

This function is used to adjust settings while checking scan results.

To exit synchronization mode, click the [Synchronize] button once again.

Switch Scanning Area settings cannot be made independently in
synchronization mode.

Before saving, click the [Synchronize] button once again to cancel
synchronization mode. Saving settings while synchronization mode is active
automatically activates synchronization with EZ-C1 on subsequent startup.

CAUTION

- Switch Scanning Area settings do not contain objectives.
The Switch Scanning Area setting may not be properly reflected when [field of view] and other upper
and lower limit values are changed due to an objective change.
To switch settings, adjust EZ-C1 objectives, or click the [Synchronize] button to reflect the upper and

lower values.
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46 Tools

The Tools menu lets you show or hide the tool dialog boxes and toolbars. This menu provides access to all
EZ-C1 dialog boxes and toolbars.

The dialog boxes and toolbars displayed on the Tools menu are listed below.

- Acquire Bar (see 3.3.10) )
- Acquire Mode Bar (see 3.3.12)

- Acquire Position Bar (see 3.3.11) *)
- Acquire Settings (see 3.3 and 3.4) (%)
- Annotate Bar (see 4.3.2)

- Bi-Directional Scan (see 3.3.9) *)
- CLEM Bar (see 3.9) *)
- Data Bar (see 4.3.8)

- File Bar (see 4.1.12)

- Function Keys (see 6.1.1.1)

- Gain Bar (see 3.2) *)
- Laser and Detector (see 3.1) *)
- Laser Control Bar (see 3.6) )
- Laser Power Monitor (see 3.7) *)
- Objective Bar (see 3.8) *)
- Perfect Focus System Bar (see 5.4.4) )
- Projects Bar (see 6.1.5)

- Stage (see 5.6.3) )
- Status Bar (see 4.6.2)

- Time Series Progress (see 3.4.6)

- View Bar (see 3.5.4)

- View Settings (see 3.5)

The dialog boxes and toolbars marked with (*) are used for C1 hardware operations.

118



4 Menu Functions

4.6.1 Layout of the Tools dialog box

4.6.1.1 Showing and hiding the dialog box

Selecting an item on the Tool menu lets you choose to show or hide the corresponding Tool dialog box or Tool
bar. If the check box for an item on the Tool menu is selected, the dialog box for that item is displayed. If the
check box is unselected, the dialog box is not displayed. A list of Tools menu items can also be displayed by
right-clicking the dialog box. (See Note.)

<A list of Tools menu items>

e — G1 Spectral Live

VBA  Window Help

D fe | 212] %]

Delete

Acquire Bar Kew

Acquire Mode Bar COMmMmon

Acquire Pozition Bar +« TYPE 2
» fcquire Settings TYPE1

» Annotate Bar
Ei-Directional Scan
Data Bar
Data Seriez Bar
« File Bar
Function Keys
v Gain Bar
v+ Laser and Detector
Laser Gontrol Bar
Lazer Power Monitor
Macros
Objective Bar
» Projects Bar
» Statuz Bar
Time Series Progress Bar
» \igw Bar
Wiew Settings

Name Function Overview
Hide All Hide all Tools dialog boxes and toolbars.
To restore the previous display status, select this item again.
Freeze Freezes Tools dialog boxes and toolbars in the position of the current display.
To cancel this setting, select Freeze again.
Layout Configures the display of the Tools dialog boxes and toolbars as desired.

Delete: Deletes the selected layout name.
n The Common layout cannot be deleted.

New: Saves the current display state of the Tools dialog box (that is, its layout
settings) with a name you enter. The layout name you create will be
added to the bottom of the Layout menu.

Flease enter the name of the new toolbar state.

(a8 WEA  Window  Help

Hide All
! Freeze I M §
Delete
New

Acquire Bar
Acquire Made Bar cammon
Cancel | (0] 4 I Acquire Position Bar

+ fcquire Settings

Layout Names (including Common):
The names of layouts created by using the New command are listed here.
Select a layout name to display it. (Common is a preset layout. It includes
the layout elements common to various dialog boxes and toolbars.)
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Note

- Hide All is also available by pressing the F12 shortcut key. Pressing the F12 key switches between
showing and hiding all Tools dialog boxes and toolbars.

- You can display a list of Tools menu items by right-clicking the dialog box. At this time, the additional
items “Hide,” “Float,” and “Dock” are displayed above the list. These functions work as follows.

Infa ]C-UIor ] Wiew ] Spots Of Interest ]

image: 1 Spectral Live Hide
file: Float
for mat: Dock. 4
date: Tuesday, July 18, 200
datatype: 16 bits Layaut 4
channels: 32 fequite Bar
Information for each dimension: Acquire Mode Bar
=i field ¢ fcquire Position Bar
# 286 286000 pixels OfF « Acquire Settines
¥ 286 256000 lines 0] Apnotate Bar
Bi-Directional Scan
GLEM Bar
Data Bar
Nata Series Rar

Hide: Hides a dialog box.
Float: Sets a tool bar to a floating position.
Dock: Sets a tool bar to a docking position. (Left, Right, Top, Bottom)

4.6.1.2 Floating and docking

Each toolbar can be set to a floating or docked position. Docked toolbars can also be moved.
Float: The toolbar is made an independent dialog box that is not associated with any other window.

Laser I@ Iﬁ W ﬁ Detector | ¢3S 'I IC—]_W ﬁ Ic_d

To make a docked dialog box a floating one, double-click on the vertical gray line at the left edge of the toolbar
(marked above with an ellipse). Or grab this part and move the toolbar from the docked position.
Right-click on the title bar to display a Tools menu list, and then select “Float.”

Docking: A Tool dialog box is “docked” to (or joined together with) the EZ-C1 proper or to another Tool dialog
box.

Laser and Detector |

aser I@lﬁlﬁlﬁ Detector IoTlllc—llc—dﬁﬁ

To dock a floating dialog box, double-click the vertical gray line at the left edge of the toolbar (marked above
with an ellipse). Or grab this part and move the toolbar into docking position.
Right-click on the title bar to display a Tools menu list, and then select “Dock.”
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4.6.2 Status bar

The Status bar (Figure 4.6-1) is a tool window at the bottom of the main window that displays information on
the cursor position on the image. The Status bar can be displayed by checking “Status bar” on the “Tools”
menu.

Status field
l Gy ©12um-215um) {752,1078,298,2961} |
Lakel Pixel coordinates Yisual field coondinates {Ch1, Ch2, Ch3, Chdl
Figure 4.6-1 Status toolbar
Name Function Overview

Status field This field shows information on mouse position, etc. when the mouse pointer is
moved over an image.

Label Shows the coordinates for the point within the image indicated by the mouse
pointer.

Pixel coordinate Shows the coordinates of the pixel for the position indicated by the mouse

pointer. For 2-dimensional images, the upper left corner coordinates are (0, 0).

Visual field coordinate | Shows the coordinates of the visual field indicated by the mouse pointer. The
center coordinates are (0 um, 0 uym).

{Ch1, Ch2, Ch3, Ch4} Shows the brightness values for Ch1, Ch2, Ch3, and Ch4 of the pixel indicated
by the mouse pointer. The brightness values for undisplayed channels are left
blank.

4.7 VBA

See “6 Visual Basic for Applications Support Functions.”
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4.8 Window

Use the Window menu to adjust the monitor brightness (for use in a dark room), as well as to reselect, copy, or
merge windows.

4.8.1 Dark Room mode

When working in a dark room, you can dim the monitor while maintaining the brightness of the image window.

Dark Room Mode Options r>_<|

v Enable Dark Foom Mode

10% I a0y
1

Uze the <Ctr[>-F12 key combination to toggle the
Dark Room Mode on and off

Cancel | | oK
Name Function Overview
Enable Dark Room Select this check box to apply the brightness setting.
Mode All parts of the monitor, with the exception of the image window, will be dimmed

to the specified brightness.

Scroll Bar Adjusts the brightness of the monitor. You can dim the monitor by 10 to 90%.
[Cancel] Closes the dialog without applying the settings.
[OK] Closes the dialog and applies the settings.

Note

- You can toggle the Dark Room Mode on and off with the key combination of <Ctrl>+F12.

4.8.2 Freeze Window Layout, Next, New, Previous, Tile, Opened Window

Name Function Overview

Freeze Window Layout | Select this command to disable moving the image windows.

Next Select this item to set the window created after the currently active window as
the active one. If this item is selected while the most recently created window is
active, then the first window created becomes active.

New Create a new window for the currently active image. The new window will show
the same image as the image that is active when the new window is created.
However, all display settings can be changed individually.
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Previous Select this item to set the window created before the currently active window as
the active one. If this item is selected while the first window created is active,
then the most recently created window becomes active.

Tile Arrange all windows in a tiled fashion, changing windows size to see all of them
at once.
Opened Window The windows currently being displayed are entered in a list, and a mark is

applied to the active window. Also, selecting a window from this list makes it
active window.

4.8.3 Merge

This function merges multiple images into one window as you display or save them. The brightness in the
overlapping image areas in the merged window is obtained by adding the brightness values of the original two
images. (Figure 4.8-1)

CEE—— Zloi= =10i x|

Merge

Figure 4.8-1 Merge
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‘windaw Merge | Infa | Color | Yiew I

Components:

Wiew Merge
C1-Live

Bemove

i

Edit

— Option
¥ Show Outlines

Brighthess: I 100% j JLl

Backaround: (+ Black " White

[T Megative contrast [subtract)

[V Tranzparant

Figure 4.8-2 Window Merge tab

The following settings are available on the Window Merge tab.

Name Function Overview
[Add] Press this button to place a new image on top of another. The procedure for
stacking images is described below.
[Remove] Deletes the selected image in the list from those displayed in the ViewMerge
window.
[Edit] Press this button to write information to the images in the ViewMerge window

during Annotate, etc. Unless this button is depressed, dragging an image only
lets you move it.

Show Outlines

Hides the white border on each image in the ViewMerge window.

Brightness Lets you change the brightness of the image selected in the ViewMerge window.
The brightness can be adjusted down to 0% with respect to a brightness scale in
which brightness immediately after merge is 100%. If the brightness in the
overlapping image areas is saturated, use this function to adjust.

Background Specify the background color other than the images in the ViewMerge window.

Select White when a white background is required when, for example, printing

images.

- If the Transparent check box is selected when Background = White, the
whole of the window will become white because the background color is
transparent.

Negative contrast

Reverses the displayed color.

Transparent

Renders transparent the image selected in the ViewMerge window.
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Note
- Follow the procedure described below to Merge.
(1) Display the image on which another image is to be stacked (let it be “image A”) and the image to be
stacked (let it be “image B”).
(2) Select the window in which image A is displayed.
(3) Select Merge from the Window menu.
The View Merge window will be displayed along with image A, with the Window Merge tab (Figure
4.8-2) displayed in View Settings.
(4) Press the [Add] button on the Window Merge tab in View Settings.
The mouse icon will change shape to =
(5) Select the window in which image B is displayed.
Image B will be displayed on top of image A in the View Merge window.
(6) Drag the image in View Merge to alter the size or position of each image.

4.9 Help

EZ-C1 Help and EZ-C1 Macro Reference is displayed in the Help menu. The application and firmware versions is
displayed too.

About E£Z-G1 for Nikon G1 Gonfocal Microscope &l

EZ-C1 for Mikon C1 Confocal
Bronze Werzion 320 build 595

| Z1 Firmware Werzion: 400
= Mikon Corporation
Copyright (=) 2002

Coord Automatizering
.. Rvan.der.Oord@Coordnl

Copyright () 1997 - 2005

Note
- EZ-C1 Help is also available by pressing the F1 shortcut key.
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5 Hardware-related Settings

Hardware-related Settings

5.1 Nikon RFA Z-drive

Select “Z-drive RFA” command on the “Configure” menu. The RFA Z-drive Configuration dialog box (Figure
5.1-1) is opened. This dialog box contains RFA and Scan tabs.

5.1.1 Installing the RFA Z-drive

Follow the instructions in the RFA Z-drive manual and “Hardware Manual” for installation.

5.1.2 The RFA tab

The RFA tab (Figure 5.1-1) is used to set RFA information.

Gonfigeure Z-drive REA &|
RF& l Z-5can ]

Conhection
Part: j Conzale
Status: | The device is not ready.

Resolution
Froduct Model (listed on the battam) 99544 -
Resolution: E|
Microscope: E&nn -
Microzcope Fing Control Pitch: 100 uma’turnE

Options
Break large steps up in chunks of: R0 umE
Initial zpeed factor [higher = slower] 200=
Acceleration factor (higher = slower) 123:

Figure 5.1-1 RFA tab

Each of the parameters has the following meaning:

Name Function Overview

Connection

Port The serial port to which the RFA port is connected. COM1 or COM2 can be
selected from the list.

Status “OK” is displayed while the system is running normally.

[Console] Pressing this button to open a console window which displays ongoing
communications between the RFA unit and the computer.
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Resolution

Product Model The RFA model number (labeled on the bottom of the device).

Resolution The unit for reading the Z-step is automatically set according to the RFA model
specified in “Product Model.” Selecting “Others” in “Product Model” permits the
entry of any numeric value.

Microscope Select the microscope model to which the Z-drive is mounted. Selecting a new

microscope model will automatically set the Microscope Fine Control Pitch.

Microscope Fine
Control Pitch

Enter the travel of the table for one full turn of the microscope fine control pitch.
When the Nikon E600FN is selected, it is set to 300 ym/turn by default. When
the model AZ100 is selected, it is set to 270 ym/turn. Other selections will set it
to 100 pym/turn. This field can be fine tuned to correct for deviations in the
calibration of the table movement.

Large Step Option

Break large steps up in
chunks of

Sets the maximum distance for a single motion when making a major change in
position using the slider bar or direct entry in the edit box. Although motion is
faster when this value is large, if the load to drive the motor is large, the motor
may not rotate normally, making it impossible to move the specified amount.
Conversely, the speed of motion is lower if a small value is used, but the error in
distance of motion can be decreased.

Initial speed factor

Set the initial speed of RFA. The higher the value, the slower the speed.
- Use this option for unusual stage loads.
- For details, refer to the instruction manual of your RFA.

Acceleration factor

Set the acceleration speed of RFA. The higher the value, the slower the speed.

5.1.3 Z-scan tab

The Z-scan tab (Figure 5.1-2) is used to set the conditions of the Z-drive scanning. This tab contains the

following controls:

Gonfigure Z-drive REA

FF4  Z-5can ]

Options
Aytornatic best Step Size: 2
Irwert Top and Bottam I~
Top and Bottom mode: |relative to reference ﬂ
Start Scan at Bottom: |
Backlash Compensation: 0 um=
Talerance: [ 48umn=]

Defaults
Top: ’W
Bottam: [ 0um=]
Step Size: T
Scan Box Height: ,m

Figure 5.1-2 Z-Scan tab
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Name

Function Overview

Options

Automatic best Step
Size

If this box is checked, the best step size is automatically calculated based on the
resolution of the objective as specified under “Objective” on the “Configure”
menu.

Invert Top and Bottom

Check this option if the direction of the movement of the microscope table and
the position shown in the scan window are not the same. This may be necessary
when the Z-drive is attached of the microscope in reverse.

Top and Bottom mode

This option is used to specify the format used when displaying the value for
“Top” and “Bottom.” A relative distance from the reference is used if “relative to
reference” is selected for the “Top” and “Bottom” values, whereas if “absolute” is
selected, just as with the “reference,” an absolute distance from the position
where the Z-drive started is used. There is no difference in operation.

Start Scan at Bottom

Check this option to start a 3D scan at the bottom instead of the top.

Backlash
Compensation

Use this function with automatic focusing control enabled to correct positioning

errors resulting from backlashes caused by gear mechanisms.

Enter a compensation value in the edit box in um. The compensation value must

be larger than any potential backlash value.

- The compensation value setting is available only with external units like the
RFA drive unit or the E1000, whose mechanisms may result in backlash
errors. No compensation feature is provided for the TE2000E autofocusing
unit, which has a control function that prevents backlash.

- For inverted microscopes, perform the 3D image acquisition by first using the
lowest objective lens, and then upper ones. For upright microscopes,
perform 3D image acquisition by moving the stage from the bottom to the top.
In both cases, always move form lower to upper positions before setting the
bottom position as scanning reference.

Tolerance Specify the permissible deviation from the Z-position indicated on screen and
the actual position observed by the microscope during 3D-image acquisition.
Enter a value in the edit box in um. (If RFA unit is connected to a manual
microscope, this setting is disabled.)

Auto Check this box to set automatically the tolerance to 1/7 of the optical resolution
along the Z direction. (If RFA unit is connected to a manual microscope, this
setting is disabled.)

Defaults

Top Specifies the default value for “Top.” This option specifies a relative distance
from the “Reference.” Press the reset button to reset “Top” based on this value.

Bottom Specifies the default value for “Bottom.” This option specifies a relative distance

from the “Reference.” Press the reset button to reset “Bottom” based on this
value.
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EZ-C1 begins operation.

because application set this parameter automatically.

Step Size Specifies the default step size value. The step size is set to this value when the

- If “Automatic best Step Size:” is checked, you can’t change default step size

Scan Box Height This value specifies the maximum value allowable in the z-axis direction for the
region displaying the scan range (the black square on the “Acquire Settings”
window.) This is the maximum value which can be set for “Range.”

5.2 Confocal C1 Settings

Nikon C1 confocal microscope system (hereafter called the “C1”) can obtain 3D images with a greater resolution
than conventional microscopes. The C1 consists of a laser box, controller, detector, and scanhead attached to

the photo port of the microscope.

For setup and installation of the entire C1 system, follow instructions given in the “Hardware Manual.” This
section describes the functions for setting up C1 hardware available on the “Configure Confocal C1” menu.
The “Configure Confocal C1” dialog box (Figure 5.2-1 to Figure 5.2-11) can be opened using the “Confocal C1”

command on the “Configure” menu of the EZ-C1. This dialog box contains the following.

5.2.1 Lasers tab

Set the laser parameters on this tab.
Lasers tabs for the three-laser unit system and four-laser unit system are shown below.

For the three-laser unit system

Configure Confocal G1

X
|
|

Trigger |  Bleach | Standard Defector | Spectral Detector
Lagers ] Fower Monitor | Piohale | Mirors | Wformation
(2) Setp
Laser _| » Wavelergth  Shutter Laser Control
Settings Fh:  [EEEem =] [clsed 1 =] satip

El
M2 [@E0om | [cleed =] [ =] et _
=

M2 [BiESom =] [closed

Options:

W Mask lasers during the mimor retrace
Masking the lagers during the retrace will dizabls
automatic laser povwer maOnitoring.
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For the four-laser unit system

Gonfigure Confocal G1

Trigger | Bleach | Standard Dietector Spactral Detector |
Lazers | Power Manitor | Prhake | Mrrars | o mation |
“l n Tiave b th Shutter Lazes Control {2] "
Laser — Fl: [@70nm =] [eutomatic =] F=]sehp.. L Settings of the laser
settings P2 [080nm =] [sutomatec =] | P output control unit
¥ 3=1: 4578 fim =] |automatic =] x| setup
¥ 3-2 |4'-'EIE| nm =] |.'.IJ":I|'|ﬂ|I: =] | setup
W 33 [1380nm =] [sutomatic =] [ | satp ..
¥ =4 |h14h nm LI |:ut:mali: L! =] s=hp .
M & [EEDnm =] [sutomatic =) | s=twp |

Use these tabs (Figure 5.2-

(1) Laser Settings

Figure 5.2-1 Lasers tab

1) to make the following settings:

Use these settings to set the wavelength and other dialog settings of the laser.

Name Function Overview
Check box Select the check box for the laser you want to use.
- In the Laser and Detector dialog box or the Laser Control Bar dialog box, you
can only perform operation on the lasers selected here.
Lasers not selected here cannot be used.
Wavelength Set the wavelength of each selected laser.

Shutter

Set the opening and closing of the laser shutter. The Shutter settings are linked
to those in the Laser and Detector dialog box.
- automatic
The shutter is automatically opened and closed. The shutter is opened when
you start scanning and closed when you finish scanning.
- open
The shutter is opened.
- close
The shutter is closed.
n The shutter setting is disabled in the spectral mode. When the laser shutter
settings described here have been made, go to the Laser and Detector
dialog and make the required settings there.

Mask lasers during the
mirror retrace

Activates or deactivates shielding from the laser light during one-way scanning

when the three-laser unit and AOM are connected, when moving the laser

scanning point from the end point of a scan to the next start point (in the return

path).

n When the four-laser unit is connected, this function is automatically
deactivated.
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(2) Laser output control unit (AOM/AOTF) settings
Set up the laser output control unit to be used with the laser.

Name

Function Overview

Laser Control

Set the laser output control unit number for each selected laser.

CAUTION

- Under normal circumstances, the settings under [setup] should not be changed.

Lazer Intensity Contro x|
Charnek (—— ~Calibration ————————————
Azsiened to: Red Lazer Power: Iuncalibrated vl
Ihitial Value: I -0.4413 ‘-.-'E Type: Icalibration table 'l
Device Type Table:  [Mikan AOM 543 cal

Erandt [ikon AOM || solect.. [ mew. | Edit. |
Reference Iexternal Y jv v Interpolate between

Dark Limit: | —0.4003 VE calibration points

B Iﬁﬂﬁﬂ% = Logarithmic Scroll: 1.D__I

fict fiz Shutter: [ Cloge |

Figure 5.2-2 Laser Intensity Control Setup dialog box

Name Function Overview
[setup] Use this button to set details about each AOM. A dialog box titled “Laser
Intensity Control Setup” (Figure 5.2-2) will be displayed.
Channel Displays the laser output control unit number to be set.
Assigned to Displays the name you entered in Name on the Laser tab.
Initial Value Set the default laser power to be assumed when EZ-C1 starts.
Device Type

Make settings for the laser output control unit.

Brand Set the type of laser or the type of laser output power control device.
Reference Set the range of DAC reference input voltages.

Dark Limit Set the lower-limit value of the DAC output voltage.

Bright Set the upper-limit value of the DAC output voltage.

Act As Shutter Specify this option when shutters are nonexistent and the laser is turned on and

off in place of a shutter. When this option is selected, the laser output power is
dropped to the lower-limit value as if a shutter were closed when the Shutter
button (see 3.1) is closed from EZ-C1. (Applies only to lasers supporting this
function)
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Calibration

For devices designed to adjust light intensity, since light intensity cannot be controlled in proportion to the set
voltage, and since adjustment characteristics vary with each device, you can use this function to correct so
that the light intensity will be controlled linearly when correction is set as a percent value.

Laser Power Set the unit of adjustment performed by the slider bar in the Laser Control Bar
dialog box. The unit is displayed in the text box to the left of the slider bar.
Uncalibrated: The set voltage is displayed.
100%: The light intensity value in the range that can be set by a device is
displayed as a percent value.
10, 15, 20, 25 mv: The set value of light intensity in the 10, 15, 20, 25 mv range
is displayed.

Type Set the correction data.
not calibrated:  No correction data is used.
calibration table: Correction data is used.

Table Displays the currently set calibration table name when “calibration table” is
selected for Type.

[Select] Displays a list of calibration data tables that the currently set Brand has. Select
one from this list.

[New] Creates a new calibration data table.

[Edit] Displays the currently selected calibration data table.

Interpolate between When this check box is selected, the light intensity is adjusted by linear
calibration points interpolation between the data points present in the calibration table.

When this check box is unselected, the light intensity is adjusted solely on the
basis of the data present in the calibration table.

Logarithmic Scroll Set the Log scale.
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5.2.2 Power Monitor tab

Set parameters relating to the Laser Power Monitor bar (see 3.7).

Gonfigure Confocal G1 &

Trigaer ] Bleach ] Standard Detector ] Spectral Detector ]
Lazers Power Manitar ] Pinhole ] Mirrars ] Tnformation ]

r ‘ihen idle, measure total lazer l—_l
power each:

| Meazure total lazer power each frame.

Time for the shutter to open: an ng
Mumber of readings to average: ] XE
Lawer Limit: 20485
Higher Limit: 40955

Figure 5.2-3 Power Monitor tab

Use the Power Monitor tab to make the following settings:

Name Function Overview
When idle, measure Specify whether you want the laser output power to be periodically measured
total laser power each (by selecting the check box) and set measurement intervals (by entering in the
list).

n When the four-laser unit system is used, this function is disabled.

Measure total laser If this option is checked, the laser power monitoring value and the image at the
power each frame start of scanning is shown in Description (see 4.1.9).
n When the four-laser unit system is used, this function is disabled.

Time for the shutter to Specify a time from when measurement started to when the shutter opens.
open More specifically, this is the wait time before measurement actually starts after a
measurement operation command is first issued (i.e., the Measure button in the
Laser Power Monitor bar (see 3.7) is pressed or the interval time specified in
“Measure Tools Power each” has elapsed).

Number of readings to | Specify the number of measurements to be performed whose values you want to
average average.

The value displayed in the Laser Power Monitor bar (see 3.7) is averaged from
multiple measurements performed as specified here.
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Lower Limit Specify the lower-limit value to be measured in the Laser Power Monitor bar
(see 3.7). Signals whose measured laser power is below this value are marked
by “Under.”

Normally, specify 2048, which is the lower-limit value of the laser power monitor.

Higher Limit Specify the upper-limit value to be measured in the Laser Power Monitor bar

(see 3.7). Signals whose measured laser power is above this value are marked
by “Over.”

Normally, specify 4095, which is the lower-limit value of the laser power monitor.

5.2.3 Pinhole tab

Use this function to make pinhole settings.

Gonfigure Confocal G1 &|

Bleach ] Standard Detector ] Spectral Detector ]
Lasers Powwer b onitor Pinhale l Pirrors ] Information ] Trigger ]
Selection
fo {se this fived pinhale; 30 um small |

" Usge the optimal pinkole

Break Delap

Mode initial zetting ﬂ
Clockwise 3
Counter Clockwize 3

Figure 5.2-4 Pinhole tab

Name

Function Overview

Selection

Selects whether automatic or manual control should be used to control the size of the pinhole.

Use this fixed pinhole

Manually controls the size of the pinhole.

Use the optimal pinhole

The application automatically controls the size of the pinhole. This is coordinated
with the objective.

Break Delay

Selects the timing for applying the break when the pinhole is rotating.
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Mode Select whether you want to use the initial factory setting for the “Break Delay”
value or if you want freely specify a value instead. When using the initial setting,
adjustment values already input to the controller are used. If a manual setting is
used, it is possible to set a “Delay” value in the field below. Use the manual
setting if the pinhole does not stop at the correct position when using the initial
setting value. It is necessary to restart the controller in order to return from using
a manual setting to using the initial setting.

Clockwise Gives the timing when the pinhole is rotating clockwise. Specifies the time to
apply the break after the pinhole starts rotating.

Counter Clockwise Gives the timing when the pinhole is rotating counterclockwise. Specifies the
time to apply the break after the pinhole starts rotating.

5.2.4 Mirrors tab

Use this tab to set details about the mirror in the C1 scan head.

Gonfigure Confocal G1 &

Trigger ] Bleach ] Standard Detector ] Spectral Detector ]
Lazers ] Pawer Manitar ] Pinhole Mirrars ] Infar mation ]

Mirror Options
= mirrar ¥ mirrar

mirror image

calibration @ 100x 1273 =
objective |

park mirrors when idle: v

Mirror Corrections

3 mirrar ¥ mirrar
offzet correction [ 00 %=1
amplitude correction 100.0 %: 1000 %:
mirror delay [initial setting =l

nor mal 4I:-i 512 4I:-i 256
| - - =

Figure 5.2-5 Mirrors tab

Name Function Overview

Mirror Options

mirror image Setting this option lets you perform reversed scanning.
Use this option when images are reversed while (for example) using an
inverted microscope.

X mirror The start and end points of scan and the direction of scan in the x direction
are reversed.
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y mirror

The start and end points of scan and the direction of scan in the y direction
are reversed.

calibration@100xobjective

This is the size of the field of view observed using a 100x objective and a
maximum zoom range. The scale for the field of view is determined based on
the calibration value and objective information (refer to the objective list in
Acquire Settings dialog box described in 4.2.3).

park mirror when idle

Use this option to move the mirror to its escape position after scanning. The
sample will not be exposed to laser light.

If this option is unselected, the mirror does not move after scanning. The
sample is exposed to laser light when the shutter is open.

Mirror Corrections

- Do not alter the Mirror Corrections value.

offset correction

Corrects the scanning position. The scanning position cannot be moved when
amplitude correction = 100%.

amplitude correction

Alters the size of the scanning area.

mirror delay

Sets a wait time per line before scanning starts in regular,
bi-directional, and fast scanning.

Select “initial setting” from the combo box to set the default value that
C1 controller has in text box for a wait time before each scanning.
Select “manual setting” from the combo box to enter a value in text box for a
wait time before each scanning. The entered wait time settings are stored in
EZ-C1 and set in the next and subsequent operations.
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5.2.5 Information tab

Use this tab to view firmware version, the IP address of connected hardware and other information.
[Controller IP address = 192.168.255.254]

CGonfieure Gonfocal G1 D_<|

Trigger | Bleach | Standard Detector | Spectral Detector |
Lasers ] Power Monitor ] Pirhole ] Mirrors Information
Information

Firmware ersion: 400

1P address: 120 168 . 285 . 254

Contraller: Hi-Speed

Lazer Box 4 Lazer with AOTF
Intenzity Gontrol: 8 channels

Standard Detector: 4 chanhnels

Spectral Detector: Serial Number 1 (MHS450
Tranzmitted Detector: Motorized

Figure 5.2-6 Information tab

This tab contains following items.

Name Function Overview
Firmware Version Shows the C1 firmware version.
IP address Shows the IP address of the C1 controller used for communications with the C1
controller.
List Shows a list of the following hardware.

- Controller: Information of the scanner
Hi-Speed (High speed scanner is installed.)
/ Standard (Standard scanner is installed.)
- Laser Box: Information of the laser unit and brightness control device
4L aser with AOTF (Four-laser unit is installed.)
/ 3Laser with AOM (Three-laser unit and AOM are installed.)
/ 3Laser (Three-laser unit is installed.)
- Intensity Control: Information of the NI Card
8channels (NI6713 board is installed.)
/ 4channels (NI6711 board is installed.)
- Standard Detector: Information of the standard detector
4channels (Two grabber boards are installed.)
/ 3 channels (One grabber board is installed.)
- Spectral Detector: Information of the spectral detector unit (order number)
- Transmitted Detector: Information of the transmission detector
Motorized (Motorized transmission detector is installed.)
/ Manual (Standard transmission detector is installed.)
/ None (No transmission detector is installed.)
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5.2.6 Trigger tab

Use this function to make trigger settings.

Lazers

Confieure Confocal G1 fg|
I

Bleach ] Standard Detector ] Spectral Detector

Start Trigger

Polarity: | negative hd
Dol TSN - |

Trigger Output

[ General Output Trigger

Polarity: | negative -

PowerMoritor | Pirhole | Mimars | Informetion Trigger

Figure 5.2-7 Trigger tab

The following items are found on the “Trigger” tab.

Name

Function Overview

Start Trigger

This option sets the timing for taking a photo image based on the input of a trigger signal.

This option sets the trigger

Polarity Specifies which level of the input signal should be used as the trigger signal.
When “positive” is set, the maximum value is used as the signal. When
“negative” is set, the minimum value is used as the signal.

Delay Specifies the time delay from the point the trigger signal input is detected until
image acquisition begins.

Trigger Output

signal to be output.

General Output Trigger

Setting this option outputs the trigger signal.

The signal is output when the frame scan starts.

(The signal is output in each frame in the Live scan mode. When Start Trigger is
set to ON, the signal is output at scan start after the delay time has passed.)

Polarity

Specifies which level should be output as a signal. When “positive” is set, the
maximum value for the output level is used as the signal. When “negative” is set,
the signal results when the level drops from its maximum to minimum value.
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5.2.7 Bleach tab

Set parameters relating to Bleach.

Gonfigure Confocal G1

Lasers |  Power Moritor | Pirhale | Mirors | Dformation |
Trigeer Bleach ] Standard Detector | Spectral Detectar
Optionz

Block Detectors during Bleachine [wi

Rizetime / Horizontal shift

08 000 us=3]  Default 514 16.00 US4::| Diefault
457 1600 us=4  Default 561 16.00 us4::| Diefault

476 1600 usg Default 637 000 us4:j| Default
488 600 us—=] _ Default |

Advanced Hardware Settings: Advanced ..

Figure 5.2-8 Bleach tab

Use the Bleach tab to make the following settings:

Name Function Overview
Block Detectors during If this box is checked, gain is automatically set to “0” when performing
Bleaching only the bleach step as part of a sequence.

If this box is unchecked, gain is never changed; The user-specified gain
value is used instead.

<Image display while performing the Bleach step as a part of a
sequence>

EZ-C1 actively switches off the gain voltage supply when incidence
laser intensity significantly increases.

When performing the bleach step as part of a sequence, check “Block
Detectors during Bleaching” on the Bleach tab in the Configure dialog
box to automatically set the gain to “0” to prevent a loss of the gain
voltage. The image is not displayed during bleaching.

Risetime/Horizontal shift Set the delay time until laser power reaches a set value in response to
the NI card output for each laser set in the Lasers tab.

[Default] Press this button to set the default delay time for the laser.

[Advanced Hardware Settings] | Pressing this button displays the Analog Out Advanced Options dialog

box (Figure 5.2-9), which lets you set up the NI-DAQ card (one that is

inserted into the PC to control the laser output power).

- Under normal circumstances, the following settings should not be
changed.
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Analog Out Advanced Options @

Device Number

External Reference Voltage
Frame Sync

Line Syhc

Pixel Sync

Horizontal Shift:

Wertical Shift:

Aol

m

Figure 5.2-9 Analog Out Advanced Options dialog box

Use the Analog Out Advanced Options dialog box to make the following settings:

Name

Function Overview

Device Number

Set the device number used for the card in EZ-CA1.
Normally, “1” is set for this entry.

External Reference
Voltage

Set the input signal voltage to be referenced from outside the card.
When using the Nikon AOM, “2.5” V is set for this entry.

Frame Sync, Line Sync,
Pixel Sync

Set the synchronizing signal for each. For C1, “1”, “~1”, and “1” are set for these
entries, from top to bottom.

Horizontal Shift

Set a variable in the horizontal direction needed for the spots in the Live window
and the bleach areas to be synchronized. Normally, “—1” is set for this entry.
(“—2" is set for the tree-laser unit system.)

Vertical Shift

Set a variable in the vertical direction needed for the spots in the Live window
and the bleach areas to be synchronized. Normally, “—1” is set for this entry.
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5.2.8 Standard Detector tab

Use these settings to make settings for the standard detector PMT output data.

Association between PMT output data and barrier filter of the standard detector is indicated by lines in
wavelength colors.

When transmission detector data is acquired, its association is also indicated by lines.

Note

- When a grabber board is installed, three channels can be set in Number of Channels. Then select a
channel to output PMT2 or DIC data in the Laser and Detector dialog box.

- When two grabber boards are installed, four channels can be set in Number of Channels.

Configure Gonlocal G1

lasers | Faweer Manibar |  Pinhale | Mirors | Iformation |
Trizmar | Bleach Standard Detector | Spectral Detector |
Trarnsmidied Light
Filters / Mirare DM 1 DM 2 B4z
|w ﬂ |DM 625 ﬂ.—-{ﬂﬁ BSOLF |
gAY | BA 2
[BAS15/30 | |BABSOED |
Orffset
i+ Manual | 1z | dgvey | 1E=sy | 1E
" Auto Offsat
Gain

W Limear Gain Mods
¥ Pixel Time Correction

Imags
Charnels | 4= [PMT1  =| [PMT3 =] [FMT2 =] [Trane x|
Label 1530 [Ea0/50 [GE0LP [Trars

oo B N EE

Figure 5.2-10 Standard Detector tab

Name Function Overview

Transmitted Light:
Indicates whether a transmitted detector is mounted.

Transmitted Detector Select this checkbox when a transmitted detector is installed. Trans appears in

is installed each Order menu and DIC output data can be assigned to EZ-C1 channels.

n This checkbox is grayed out and automatically selected when a motorized
transmitted light detector is installed.

n Please be sure to check that a transmitted illumination lamp is OFF before
setting a Transmitted Light Detector to IN.

Filters/Mirrors:
Registers the filter cube wavelength. The settings are written in the ics file.

DM 1, 2 Specify wavelengths of dichroic mirrors.

BA1,2,3 Specify wavelengths of barrier filters.

141



5 Hardware-related Settings

Offset

Specifies for each channel the offset value to use for the voltage output from the photo multiplier.

Manual Set this function to maintain a constant gain level regardless of the voltage output
by the photo multiplier.
Auto Offset Sets the offset values for PMT output voltage based on the PMT Calibration data

created by the Offset Calibration function.
The C1 Offset Calibration dialog box opens if PMT calibration data has not been
created yet.

[Auto Offset]

Press the [Auto Offset] button to open the C1 Offset Calibration dialog box.

Here, press the [Start] button. For all PMTs excepting one for the transmission

detector, the offset values for PMT output voltage are measured by adjusting gain

and pixel dwell, until a calibration table is created.

n Incident light to the PMT must be blocked when creating this calibration
table. Before creating the calibration table (pressing the [Start] button), turn
off the light in the room, so that the measurement is performed in the dark.

n The offset value for PMT output voltage of the transmission detector can only
be adjusted manually. It cannot be adjusted automatically by the Offset
Calibration function.

C1 Offzet Calibration

For measuring the offaet calibration & is important that the
debactors catch no bght.

Please suitch off the room dlumination and cover the
micrascape with & black cloth.

Ide

Figure 5.2-11 C1 Offset Calibration dialog box

Gain

Linear Gain Mode

The relationship between gain level and actual gain is indicated by logarithmic
graph. Gain varies by approximately 10x when the level is changed by 1. Note
that, when having removed the check mark from the checkbox and restored the
normal Gain mode, the value displayed changes to “0,” but the original setting
remains. This is not an error. You can continue to adjust the Gain. However, this
mode cannot be invoked for a channel set to Trans (transmission detector).
n When this mode is on, gain values on the gain bar are indicated as
logarithmic values (for example, 0.158 =10%"* and 5.08 =10°?).

Pixel Time Correction

Check this option to adjust the gain so that uniform brightness is achieved for
“Period.” When the laser scanning speed is changed, a different amount of light
than during the integration period is obtained. The observed brightness varies as
a result. Check this option to automatically adjust the PMT gain compensates for
fluctuations in image brightness.
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Image

Channel count

[pmT1 =] [PMT2

Channel assignment

] [Pz =]

Channel count:
Specify the channel count to be used.

Channel assignment:
When a grabber board is installed and the standard mode is used, channels of
EZ-C1 can be assigned for PMT output data or DIC output data. (PMT 1, 2, 3,
or Trans)
Channel 1, 2, 3, and 4 of EZ-C1 are placed from left to right. Assign PMT 1, 2,
3, and Trans to these channels.

- If these settings are changed, the layout of the channel display on the Gain
Bar dialog box is changed. (See 3.2.)

Label

Set a label name for each channel data. The band pass filter wavelength of PMT

output data are set by default.

- This label name appears on the Gain bar and on the detector buttons on the
Laser and Detector dialog box.

Default Color

Use to set the default PMT data display color.
n The colors set here become the “green-red-blue-DIC” default color list
settings in the View Settings dialog box | Color tab.

5.3 Microscope Ti

The EZ-C1 supports Ti microscopes, offering the capabilities of operating the Z-drive and selecting an objective

nosepiece.

To operate the Ti microscope from the EZ-C1, the Ti Control Software must be installed (refer to the “Software for
Inverted Microscope Ti, Ti Control” for details). Once the Ti Control Software is installed, the Configure Devices
dialog box includes an additional item, shown as “Microscope Ti-E.”

Configure Devices

%]

W Microzcope Ti-E

| Z-driwe RFA
W Aoouire
= 3D Visuslestion
» Laurcher

[T Bead Only

Confguration:

I #]
Device Type ‘Wendor
Lol [Lata Series Inetaol
»| Caonfocal C1 goanrar Nikon

] Migroscaps TE2000-1/5
L . Mir_'rn:.'mpe TE2000-E

| Prior ProScan 0 withowt Z-Dreve

_Bekite ]
Digactivata

microscope 4 2-driva Hikom
MICrasCope Hikon
rnil.'ru:l:npe- + z-drive Nikan
z-drive Wik
acquisition—base =
wisuslizatom =
lauricher =
staga Prior

»

Gancal | oK |

Defaults: I

Figure 5.3-1

Configure Device dialog box
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Specific control items depend on whether the HUB-A and other optional devices are connected. (For example, if
HUB-A is connected, shutters and filters can be controlled with the confocal mode function. They cannot be
controlled without HUB-A.)

From the Configure menu of the EZ-C1, select “Microscope Ti-E” to open the Configure Microscope Ti-E dialog
box. This dialog box allows you to view the status of communications/connections to the Ti microscope, as well
as to configure the XY stage and Z-drive.

Note

- The following considerations should be noted in case of registering new objective information which is
not originally provided in the Ti microscope (i.e., not included in the list displayed via Devices |
Objective | Change).

- If new objective lens information is registered from the Ti Control Pad, it is updated only at the
time of EZ-C1 startup. Therefore, any information registered from the Ti Control Pad during
operation of EZ-C1 is not updated in the EZ-C1. New information should be registered before
starting the EZ-C1.

- If new objective lens information is registered from the Ti Control Software, it will be updated
also during operation of EZ-C1.

- Changing the Z position significantly in Ti via the EZ-C1 may make the communications unstable. We
recommend operation with the Ti microscope when changing the Z position significantly.

5.3.1 TiTab

Use the Ti tab (Figure 5.3-2) configure information specific Ti.

Configure Microscope Ti-E

Ti  |Stage | 2-Scan |

Fort: [ : =1
Status: i;k
Deviees:  [Ber Path C:¥Program Filez¥Hi
D e argion: 103642
Magapisce: raad-arite
Dir v prezent
~Dirive: present
'~ Dv v prezent
PFS: present
Filter Block Cassetls 1 read-write

Figure 5.3-2 Titab

The parameters are defined as follows:

Name Function overview
Port Selects the USB port desired for connection to the Ti.
Status Normal operation is indicated as “ok.”
Devices Displays the connections to the nosepiece, Z-drive, XY stage, etc.
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5.3.2 Z-Scan Tab

Use the Z-Scan tab (Figure 5.3-3) to configure Z-axis scanning. The parameters are defined as follows:

Configure Microscope Ti-E

T i Stage Z-Gean |
Optionz
Butamatic bast Step Siee i
Irvert Top and Battom r
Top and Batlom mode | shoolite Ll
Start Scan at Bottom rC
Back lash Gompenzation: =3
W Tolerance: ¥ Auta =
Defaults
Top: ] U"Tl;l
Bottom [ oum=]
Slep Size =
Scan Box Hewht 76 um—]
Figure 5.3-3 Z-Scan tab

Name

Function overview

Options

Automatic best Step Size

If this box is checked, the best step size is automatically calculated based on
the resolution of the objective as specified under “Objective” on the
“Configure” menu.

Invert Top and Bottom

Check this option if the direction of the movement of the microscope table
and the position shown in the scan window are not the same. This may be
necessary when the Z-drive is attached to the microscope in reverse.

Top and Bottom mode

This option is used to specify the format used when displaying the value for
“Top” and “Bottom.” A relative distance from the “Reference” is used if
“relative to reference” is selected for the “Top” and “Bottom” values. If
“absolute” is selected, just as with the “Reference,” an absolute distance
from the position where the Z-drive started is used. There is no difference in
operation.

Start Scan at Bottom

Check this option to start a 3D scan at the bottom instead of the top.

Backlash Compensation

Use this function with automatic focusing control enabled to correct
positioning errors resulting from backlashes caused by gear mechanisms.
Enter a compensation value in the edit box in ym. The compensation value
must be larger than any potential backlash value.

- The compensation value setting is available only with external units like
the RFA drive unit or the E1000, whose mechanisms may result in
backlash errors.

No compensation feature is provided for the autofocusing unit of Ti
microscope, which has a control function that prevents backlash.
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Tolerance If this box is checked, specify the permissible deviation between the
Z-position indicated on screen and the actual position observed by the
microscope during 3D-image acquisition. Enter a value in the edit box in ym.
If this box is not checked, the Z-position error check is disabled.

Auto If this box is checked, the tolerance is automatically set to the best value.

Defaults

Top Specifies the default value for “Top.” This option specifies a relative distance
from the “Reference.” Press the reset button to reset the “Top” value based
on this value.

Bottom Specifies the default value for “Bottom.” This option specifies a relative
distance from the “Reference.” Press the reset button to reset the “Bottom”
value based on this value.

Step Size Specifies the default step size value. The step size is set to this value when

the EZ-C1 begins operation.
- If “Automatic best Step Size:” is checked, you cannot change the default
step size because the application sets this parameter automatically.

Scan Box Height

This value specifies the maximum value allowable in the Z-axis direction for
the region displaying the scan range (the black square in the “Acquire
Settings” window.) This is the maximum value which can be set for “Range.”

5.3.3 Stage Tab

Use the Stage tab to configure various settings for XY stages. The parameters are defined as follows:

Configure Microscope Ti-E

Ti  Stage |2-Scan |
Marar ™ Mimar BT Mirror
Ragolution | =
W Tolerance: |on umE

Reference Pogition: Sat Current

Name

Function overview

Mirror

Mirror X

Inverts the left and right coordinate information for stage movement.
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Mirror Y Inverts the forward and backward coordinate information for stage
movement.
Resolution Sets the level of resolution for stage movement. It is fixed to 0.1 um when the

Ti-E is connected.

Tolerance When this box checked, specify the permissible deviation between the XY
position indicated on screen and the actual position observed by the
microscope. Enter a value in the edit box in pm.

If this box is not checked, the Z-position error check is disabled.

Reference Position Sets the reference position for displaying the stage position.
[Set Current]: Uses the current position as the reference position.

5.3.4 Perfect Focus System Bar

If a motorized nosepiece with PFS is connected, the Tools menu has a Perfect Focus System Bar added to it.
Select “Perfect Focus System Bar” to display the following dialog box:

4
= | O —
) =

f

Status field Offset value Offset value adjustment bar
Name Function overview
I- Select the perfect focus system operation.
[PFS] I- : The perfect focus system is in focusing.
F'F5'|: The perfect focus system is on standby.
EJ: The offset value has been set.
Status field The control status for focusing is displayed here.
[OK]: The focusing control is enabled.
[OFF]: The focusing control is disabled.
[Moving]: The focusing position search is in progress.
[Objective Error]: The selected objective is not applicable.
[Search Error]: An error occurred in searching the focusing position.
Offset value The offset value is displayed here.
Offset value adjustment Move the scroll bar to adjust the offset value.
bar
Note

1. If one of “Top,” “Bottom,” or “Index” is selected on the Z-Stack tab in the focusing control, the view of
the [PFS] button changes to _ZJ

2. When the [PFS] button is displayed as _ZJ and the [PFS] button is pressed or “Ref” is selected,
the focusing control starts and the view of the [PFS] button changes to Ii
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5.3.5 Stage Tools Bar

To display the Stage dialog box, select Stage in the Tools menu. The EZ-C1 can be used to control the XY
stage.

Set Reference Positon !

APositon [ O0um 4] & |
¥ Position: [~ Ofum 4| =} v
Name Function overview
[Set Reference Position] Uses the current position as the reference position. The stage position is

expressed relative to the reference position.

X Position Moves the stage in the X direction.
The arrow keys at the ends cause fine movement: 1.0 um with each click.
Clicking in the scroll area causes coarse movement: 40.0 um each.

Y Position Moves the stage in the Y direction.
The arrow keys at the ends cause fine movement: 1.0 um with each click.
Clicking in the scroll area causes coarse movement: 40.0 um each.

5.3.6 TiBar

The Ti bar is displayed if the Ti Control software is installed.
The Ti bar contains the confocal mode button:

Name Function overview
Ek This button sets the optical path, filters, diascopic illumination lamp, diascopic
Confocal mode button | illumination shutter, and episcopic illumination shutter to cater for confocal
microscopy. (If HUB-A is not connected, however, only the optical path is
changed.)
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5.4 Microscope TE2000 [Vista incompatible]

You can use EZ-C1 to operate the TE2000 Z-drive and to select objective revolvers.

Besides, you can use EZ-C1 to operate the Nikon perfect focus system. (For details, refer to “TE2000 PERFECT
FOCUS SYSTEM manual.”) You can use the perfect focus system with the TE2000-E to control the focus
automatically.

To operate the TE2000 from the EZ-C1, install the TE2000 Control. (For more information, refer to the manual
“TE2000 Control Software for TE2000 Inverted Microscope.”) Installing TE2000 Control adds [Microscope
TE2000-U/S] and [Microscope TE2000-E] to the registration list of Configure Devices.

Configure Devices |
Configuration:
SN ~ | [ F-o Ol Backp | Restore |
Device Tvpe “endor
Confocal G zcahher Mikat
Microzcope TE2000-U/S microscope Nikan Ativate |
[ Microscope TE2000-E microscope + z-drive Mikaon =
I-drive RFA 2-drive Nikan Dieatiletis |
Acquire acquisition-baze -
2D Visualization vizualization -
a ]

Defaults I Beset | Bpply | Cancel I 0] 4 I

Figure 5.4-1 Configure Device Dialog Box

The TE2000-U/S does not have a Z-drive, which is the only difference from the TE2000E. When TE2000-U/S is
selected, therefore, the Z-drive RFA is turned on automatically. (It can be then manually turned off.)

The Configure TE2000-E dialog box and the Configure TE2000-U/S dialog box appear when you select the
Microscope TE2000-E and Microscope TE2000-U/S menu, respectively from the EZ-C1’s Configure menu. Each
dialog box contains the same items.

In the dialog box, enter settings related to communications with the TE2000 and settings associated with Z-Drive.

CAUTION
- To operate the perfect focus system, the latest version of TE2000 Control software must be installed.
Install the TE2000 Control software provided in the EZ-C1 installation CD.

Note

- Changing objective information from the control pad, etc., while EZ-C1 is up and running may
destabilize communications between the TE2000 and EZ-C1. Always close EZ-C1 before changing
objective information.

- Making significant changes from EZ-C1 in the Z position of the TE2000 may destabilize
communications. We recommend making any significant changes in Z position from the TE2000 itself.
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5.4.1 TE2000 tab

The TE2000 tab (Figure 5.4-2) is used to specify TE2000-specific information.

Configure Microscope TE2000-E x|

TE2000 | Z-Scan|

Fort; COR1 ﬂ
Status: demo made.
Devices: [y osEpiece; dema

Z-Drive: derma

CaontralPad demno

Figure 5.4-2 TE2000 tab

Each of the parameters has the following meaning:

Name Function Overview

Port The serial port to which the RFA port is connected. COM1 or COM2 can be
selected from the list.

Status “OK” is displayed while the system is running normally.
Devices Displays nosepiece, Z-Drive, and ControlPad connection statuses.
Note

- When “Microscope TE2000-U/S” is selected in the Configure Devices dialog box
When the Microscope TE2000-U/S check box is activated in the Configure Devices dialog box (the
dialog box displayed by selecting Device from the Configure menu), perform Z-drive settings by
selecting the Z-Drive RFA of the Configure menu.
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5.4.2 Z-Scan tab

The Scan tab (Figure 5.4-3) is used to set the conditions of the Z-drive scanning. This tab contains the

following controls:

Gonfieure Microscope TE20D00-E ['5_<|

TE2000
Option:
Automatic best Step Size: =
Invert Top and Bottom ml
Top and Bottom mode: |absolute j
Start Scan at Bottom: '
Backlash Compensation: [ Dum=]
¥ Tolerance: [T Auto ’W
Drefaults
Tom: [ oum=]
Bottom: [ oum=]
Step Size: [ 05om=]
Scan Box Height: [ 150 um—]

Figure 5.4-3 Z-Scan tab

Name

Function Overview

Options

Automatic best Step Size

If this box is checked, the best step size is automatically calculated based on
the resolution of the objective as specified under “Objective” on the
“Configure” menu.

Invert Top and Bottom

Check this option if the direction of the movement of the microscope table
and the position shown in the scan window are not the same. This may be
necessary when the Z-drive is attached of the microscope in reverse.

Top and Bottom mode

This option is used to specify the format used when displaying the value for
“Top” and “Bottom.” A relative distance from the reference is used if “relative
to reference” is selected for the “Top” and “Bottom” values, whereas if
“absolute” is selected, just as with the “reference,” an absolute distance from
the position where the Z-drive started is used. There is no difference in
operation.

Start Scan at Bottom

Check this option to start a 3D scan at the bottom instead of the top.

Backlash Compensation

Use this function with automatic focusing control enabled to correct
positioning errors resulting from backlashes caused by gear mechanisms.
Enter a compensation value in the edit box in um. The compensation value
must be larger than any potential backlash value.

- The compensation value setting is available only with external units like
the RFA drive unit or the E1000, whose mechanisms may result in
backlash errors. No compensation feature is provided for the TE2000E
autofocusing unit, which has a control function that prevents backlash.
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Tolerance Select this check box to specify the maximum permissible error between the
Z position displayed on screen and the position read out from the
microscope during 3D-image acquisition. Enter this permissible error margin
in the edit box in ym units.

Z-position errors are not verified if this box is unselected.

- This function is available only with the TE2000 firmware version (both
Hub main and Hub sub) of Ver 2.10 or later. (To check the firmware
version, refer to the TE2000 instruction manual.) In all earlier versions,
Tolerance is always enabled.

Auto Select this check box to set the optimum Tolerance value automatically.

Defaults

Top Specifies the default value for “Top.” This option specifies a relative distance
from the “Reference.” Press the reset button to reset “Top” based on this
value.

Bottom Specifies the default value for “Bottom.” This option specifies a relative

distance from the “Reference.” Press the reset button to reset “Bottom”
based on this value.

Step Size Specifies the default step size value. The step size is set to this value when

the EZ-C1 begins operation.

- If “Automatic best Step Size:” is checked, you can’t change default step
size because application set this parameter automatically.

Scan Box Height This value specifies the maximum value allowable in the z-axis direction for
the region displaying the scan range (the black square on the “Acquire
Settings” window.) This is the maximum value which can be set for “Range.”

5.4.3 TE2000 bar

The TE2000 bar is displayed when TE2000 Control is installed in your system. The TE2000 bar is a toolbar. To
display it, use the TE2000 command from the EZ-C1 Tools menu. The TE2000 bar contains the button shown
below.

TE2000 start button; it is used to start the TE2000 control application.

152



5 Hardware-related Settings

5.4.4 Perfect Focus System Bar

When the perfect focus system is installed with the system, the Perfect Focus System Bar appears on the
Tools menu. Select the Perfect Focus System Bar to show the following dialog box.

rerioct rocus Systemiae 3
PFS Ok o 4 [
| ; - F -

Status field Offset value Cffset value adjustment bar
Figure 5.4-4 Perfect Focus System Bar

Name Function Overview

Ii Select the perfect focus system operation.
[PFS] Ii: The perfect focus system is in focusing.
PFS |: The perfect focus system is on standby.
EJ: The offset value has been set.

Status field The control status for focusing is displayed here.

[OK]: The focusing control is enabled.

[OFF]: The focusing control is disabled.

[Moving]: The focusing position search is in progress.

[Objective Error]: The selected objective is not applicable.

[Search Error]: An error occurred in searching the focusing position.

Offset value The offset value is displayed here.

Offset value adjustment Move the scroll bar to adjust the offset value.
bar

Note

1. If one of “Top,” “Bottom,” or “Index” is selected on the Z-Stack tab in the focusing control, the view of
the [PFS] button changes to .ZJ This is a status that the perfect focus system is not in focusing but
only the offset value is set.

2. When the [PFS] button is displayed as Ej and the [PFS] button is pressed or “Ref” is selected, the
focusing control starts and the view of the [PFS] button changes to Ii
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5.5 Microscope i-Series (90i, 80i)

EZ-C1 enables Z-drive operation of the i-series of microscope. It also lets the user select an address of the
objective nosepiece or switch to any predetermined group of settings for microscope status.

Before operating the i-series of microscope with EZ-C1, the i-Control must be installed in your system. (For more
information, refer to the “i Series Support Tools Software Manual” for the ECLIPSE-i series of microscopes.)
Installing i-Control adds “Microscope 90i” and “Microscope 80i” to the Configure Devices dialog box.

Configure Devices

LConfiguration:
v| I BeadOnly Backup Bestore
Device Type Wendaor
focal C1 scanner
Microscope 900 microscope + 2-drive Mikon Bctivate
[ Microzcope 80 microscope Mikon
[ Z-drive RFA z-diive Miken Deactivate
Acquire acquizsition-baze -
3D Visualization visualization
M Launcher launcher
< | &
Defaults | Hezet ‘ sfuln | Cancel | ak |

Figure 5.5-1 Configure Devices dialog box

Because 80i Microscope does not have built in Z-Drive, Z-Drive RFA will be selected automatically.

Select Microscope 90i from the EZ-C1 Configure menu to display the Configure Microscope 90i dialog. Select
Microscope 80i to display the Configure Microscope 80i dialog.

Use this dialog to configure the communications with the Ti series microscope, display connection status, and set
Z-Drive.

CAUTION

- To operate the i series microscope, the latest i Series Support Tools software must be installed.
Install the i Series Support Tools software provided in the EZ-C1 installation CD.

- EZ-C1 does not support the motorized epi illuminator D-FL-E. Therefore, do not use the 80i and
D-FL-E with EZ-C1.
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5 Hardware-related Settings

5.5.1 90i tab, 80i tab

Use the 90i tab (Figure 5.5-2) to set information specific to the 90i. When it connects with 80i, it is displayed as
80i tab.

Configure Microscope 90i

30i ] Z-Gcan ]

Part: ] shan J

Stabus: ok

Devices: [Stand a0
Dligital Imaging Head: DIH-E
Mosepiece: read-write
Z-Dirive: prezent
Filter Black Cassette: read-write

Mode: [ Setup the microzcope for digital imaging
when image acquisition starts.

Figure 5.5-2 90i tab

The parameters are explained below:

Name Function Overview
Port USB port used to connect the 90i or 80i.
Status Indicates “ok” when the 90i is operating normally.
Devices Shows the connection status for the Nosepiece, Z-Drive, and ControlPad.
Mode Configured with 90i and DIH-E:

When this checkbox is checked, the following parts will be set to the condition for
the confocal microscopy at the beginning of a scan: the optical path selection,
filters, diascopic illumination, analyzer, and shutter for the diascopic illumination.

Configured with 90i or 80i and DIH-M:

When this checkbox is checked and the following parts are not set to the
condition for the confocal microscopy before the beginning of a scan, a warning
message appears: the optical path selection, filters, diascopic illumination for the
90i, and shutter for the diascopic illumination.

kode: [w ‘wamif the optical path bo the front port i
blocked when image acquigsition starts
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5 Hardware-related Settings

5.5.2 Z-Scan tab

The Z-scan tab (Figure 5.5-3) is used to set the conditions of the Z-drive scanning. This tab contains the

following controls:

Gonfieure Microscope 90i

30i

Z-5can
~ Options-

M Tolerance: V¥ Auto

~ Defaults-

Automatic best Step Size:

Invert Top and Bottom

Top and Bottom mode:;

Start Scan at Bottom:

Backlazh Compenszation:

Taop:

Battam:

Step Size:

Scan Box Height: 1 150 umEj

Figure 5.5-3 Z-Scan tab

Name

Function Overview

Options

Automatic best Step Size

If this box is checked, the best step size is automatically calculated based on
the resolution of the objective as specified under “Objective” on the
“Configure” menu.

Invert Top and Bottom

Switches the direction of microscope movement relative to the stage from
descending to ascending. Check this option if the direction of the movement
of the microscope table and the position shown in the scan window are not
the same.

Top and Bottom mode

This option is used to specify the format used when displaying the value for
“Top” and “Bottom.” A relative distance from the reference is used if “relative
to reference” is selected for the “Top” and “Bottom” values, whereas if
“absolute” is selected, just as with the “reference,” an absolute distance from
the position where the Z-drive started is used. There is no difference in
operation.

Start Scan at Bottom

Check this option to start a 3D scan at the bottom instead of the top.
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Backlash Compensation

Use this function with motorized focusing control enabled to correct
positioning errors resulting from backlashes caused by gear mechanisms.
Enter a compensation value in the edit box in um. The compensation value
must be larger than any potential backlash value.

- The compensation value setting is available only with external units like
the RFA drive unit or the E1000, whose mechanisms may result in
backlash errors.

No compensation feature is provided for the 90i motorized focus unit,
which has a control function that prevents backlash.

Tolerance Specify the permissible deviation from the Z-position indicated on screen
and the actual position observed by the microscope during 3D-image
acquisition.

Auto Check this box to set automatically the tolerance to 1/7 of the optical
resolution along the Z direction.

Do not check this box to enter a value in the edit box in um.

Defaults

Top Specifies the default value for “Top.” This option specifies a relative distance
from the “Reference.” Press the reset button to reset “Top” based on this
value.

Bottom Specifies the default value for “Bottom.” This option specifies a relative
distance from the “Reference.” Press the reset button to reset “Bottom”
based on this value.

Step Size Specifies the default step size value. The step size is set to this value when

the EZ-C1 begins operation.
- If “Automatic best Step Size:” is checked, you can’t change default step
size because application set this parameter automatically.

Scan Box Height

This value specifies the maximum value allowable in the z-axis direction for
the region displaying the scan range (the black square on the “Acquire
Settings” window.) This is the maximum value which can be set for “Range.”
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5.5.3 Microscope Tools bar

When i Series Support Tools is installed, the Microscope Tools bar is displayed.
The Microscope Tools bar contains the following buttons:

Name Function Overview
ﬂ The launcher button for i series; launches the i Control application.
\ﬁl The launcher button for i series; launches the i Setup application.
E[; Optical path, Filter, Nosepiece, Diascopic lllumination Lamp, and Analyzer are
Confocal mode button | set as the condition for confocal microscopes. (Only when it connects with
“90i+DIH-E”)

Configured with “90i and DIH-E”:

Microscope Observation modes bar can be displayed from the Microscope Observation modes command of
the Tools menu.

The Microscope Observation Modes bar contains the following buttons:

Microscope Observation Modes N A
IEF DIC [;’:'E FL|F'h|DF| 1|2| 3| 4| 5| 5

Figure 5.5-4 Microscope Observation Modes bar

Name Function Overview
[BF] (Bright Field) Microscopy for bright-field observation
[DIC] (DIC) DIC observation
[DIC FL] (DIC/FL) DIC and fluorescent simultaneous observation
[FL] (Fluorescence) Fluorescent observation
[Ph] (Phase Contrast) Phase contrast observation
[DF] (Dark Field) Dark field observation
[1 to 6] (User Option) Any observation method set by the user from i Control

Note

- You can set any desired observation method and name in User Options 1 to 6 using i Control. (For
more information, refer to the i Series Support Tools Software Manual for the ECLIPSE-i series of
microscopes.)
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5 Hardware-related Settings

The table below lists the various possible operations for each motorized unit that operates in conjunction with
the selected microscopy mode.

Table  Standard Combinations of Microscopy Methods and Interlock
90i Universal condenser | Nosepiece DIH-E
’ : y . Optical
Diascopic ND filter . Field Z-axis Turret Aperture Switching | Filter cube | . Field Shutter | Analyzer [ path | Zoom
lamp diaphragm diaphragm diaphragm switching
Bright- ON Interlocked | Interlocked | Interlocked BF/ Interlocked Addcr’?sése CLOSE | ouT
field w/ objective | w/ objective |w/ objective 2-4x lw/ objective] (DIA)(Nota) -
Address 6
DIC ON Interlpckgd Interlpckgd Interlpckgd DIC Interlpckgd or8 _ CLOSE IN
w/ objective | w/ objective |w/ objective 1/2 lw/ objective] (DIA)N®)
. Interlocked | Interlocked | Interlocked DIC Interlocked Interlocked
DIC/ epi-f O w/ objective | w/ objective |w/ objective 1/2 W/ objective] Address 1 w/ zoom OIFE 0y
. Interlocked Interlocked BF/ Interlocked
Epi-f OFFF w/ objective - w/ objective 2-4x - Address 1 w/ zoom ©IFEN || @l
Address 6
Phase Interlocked | Interlocked | Interlocked Ph
contrast O w/ objective | w/ objective |w/ objective 1/2/3 IFdlly @rpem (DIAO;(I\?MG) - Gl || er
Address 6
Interlocked | Interlocked | Interlocked DIC2/
Dark-field o w/ objective | w/ objective |w/ objective 2-4x IFully e (DIAO;‘S""’) - CGleEE | eUr

“« n

means not interlocked.

I:l Fixed: Not user-changeable
- Triggers the interlock

Interlocked w/ objective: Sets appropriate status according to the selected DIH optical path and the total
magnification combining those of the objective and the zoom (interlocked with

Interlocked w/ zoom:

objective alone in the absence of the DIH).

Sets appropriate status according to the selected zoom status.

CAUTION

- Two types of turret are available for the DIH-E; six ports turret for six filter cubes and eight ports turret for
eight filter cubes. The settings for the installed turret in the DIH-E are used for each microscopy.
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5 Hardware-related Settings

5.6 Prior ProScan [Vista incompatible]

EZ-C1 can be used to control Prior ProScan XY stages.
After a Prior ProScan is connected, select Devices in the Configure menu to display the Configure Devices dialog
box. Select [Prior ProScan Il without Z-Drive].

CGonfigure Devices b_<|
Configuration:
|C1 ﬂ [~ Bead Only Backup | Bestore |
Device Tvpe “fendor
Data Series linetool -
Confocal G1 SCanner Mikion
[ Microscope TEZ000-LI/S microscope Mikon
N _ . o . Deactivate
Microzcope TEZ000-E microzcope + 2-drive Mikon
Z-drive RF& 2-drive Wikt

O
Acquire
30 Wizualization

| ~

acquizition-bage

vizualization
launcher

Defaults

Prior

=

Cancel | QK |

Figure 5.6-1 Configure Devices dialog box

After you have activated this device, a Prior ProScan command is added to the Configure menu and a Stage
command is added to the Tools menu.

CAUTION

- The Prior ProScan driver must be installed before you can control the Prior ProScan from EZ-C1.
Install the driver from the driver CD provided with Prior ProScan.

5.6.1 Controller tab

To display the Prior ProScan dialog box, select Prior ProScan in the Configure menu. The hardware
connection status is indicated in the Controller tab.

Gonfigure Prior Proscan

Cantrallar ] Stage ]

Connection
Part: [Comd| >| _Console
Status: |OK.

Firmware verzion: 108
5P IS 2-AxIS STEFPER WERSION 2.7
OSP_2 IS WOT FITTED
DRIVE CHIPS 000011
JOYSTIGK ACTIVE
STAGE = H107/2
FOGUS = USER.
FOURTH = MOME
FILTER 1 = MOME
FILTER 2 = MOME
SHUTTERS = 000
AUTOFOCIUS = MOME
WIDED = NOME
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5 Hardware-related Settings

Name Function Overview
Port The COM port to which the Prior ProScan is connected.
[Console] Displays the Console window. In this window, you can check the commands.
Status OK indicates that the devices is working correctly.

5.6.2 Stage tab

Use the Stage tab to configure various settings for XY stages. The parameters are defined as follows.

Configure Prior Proscan &l

Controller Stage ]

Mirrar f

Re=olution | 10 um:jl
JoyEtick Off On
Reference Position: Thitialize | Set Current |

10000000 wm E|:
Stage Ranee x ‘_:? ”
¥ 10000000 umE|:

[# ‘hen resettine the Reference Position,
reset the Stage Ranee to:

® 100000.00 umEIj
Y 100000.00 umEI:

Name Function Overview
Mirror
Mirror X Inverts the left and right coordinate information for stage movement.
Mirror Y Inverts the forward and backward coordinate information for stage
movement.
Resolution Sets the level of resolution for stage movement. Specify the resolution in um.
JoyStick Activates or deactivates the joystick.

Reference Position

Sets the reference position for displaying the stage position.

Initialize:  Moves the stage to the reference position as set by the
hardware and uses that position as the reference position.

Set Current: Uses the current position as the reference position.
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5 Hardware-related Settings

Stage Range Sets the range as displayed on the scroll bar of the Stage toolbar. (If the
stage is moved beyond the range set here, the range displayed on the scroll
bar of the Stage toolbar is automatically enlarged.)

X: Stage range in the x direction

Y: Stage range in the y direction

!+ | Increases the x and y value together.

1¢+ : Decreases the x and y value together.

When restting the When resetting the Reference Position, reset the Stage Range to:

Reference Position, reset If you reset the reference position, the values for “Stage Range” are

the Stage Range to: automatically reset to the values you specify here (only if the check box is
selected).

X: Stage range in the x direction when reset
Y: Stage range in the y direction when reset

5.6.3 Stage toolbar

To display the Stage dialog box, select Stage in the Tools menu. EZ-C1 can be used to control the XY stage.

JowStick MW Set Feference Position |ﬂﬂ
_ 2J

* Pogition: 000 um ﬂ

¥ Position: [ Od0um | N
Name Function Overview
JoyStick Activates or deactivates the joystick.
[Set Reference Position] Uses the current position as the reference position. The stage position is

expressed relative to the reference position.

ﬂ Enlarges the range of movement in the scroll bars for the x and y positions.
i Reduces the range of movement in the scroll bars for the x and y positions.
X Position Moves the stage in the x direction.
Y Position Moves the stage in the y direction.
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6 Visual Basic for Applications Support Functions

Visual Basic for Applications Support
Functions

The EZ-C1 incorporates functions that support Visual Basic for Applications (hereafter abbreviated as VBA).
In addition to the default menu items, you can assign macros (procedures) created with VBA to menus or to
keystrokes.

6.1 VBA menu

The VBA menu available from the EZ-C1 main menu provides access to all VBA support functions.

Figure 6.1-1 shows the default (initial) status of the VBA menu.

The menu items located below “Keys” are custom user-defined menus which users can add to as desired (see
6.1.2).

E EZ-CG1 for Hikon G1 Confocal Microscope — G1-Live

Eile GConfieure [Data  Launcher

Tools

Cuztomize k
Macro b
Projects »
“izual Basic Editor.. YEA menu
Uzer
Uzer2
ser menuy

Figure 6.1-1 VBA menu

6.1.1 Customize menu

Select the Customize command from the VBA menu (see 6.1) to display the Customize menu (Figure 6.1-2).
The Customize command lets you register macros to a custom user menu or to a shortcut key.

WEES indow  Help

kKevs
Macro b Menu
Projectz ¥ Toolbar

YWizual Bazic Editor...

Figure 6.1-2 Customize menu
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6.1.1.1 Keys

Select the Keys command from the Customize menu (see 6.1.1) to display the Keys tab on the VBA Options
dialog box (Figure 6.1-3). Use this tab to assign macro functions to shortcut keys.

VBA Options x|

Projects  Keys IMenu |

Ke

| Marme | Macro | Praject Aidd

F11

1]

Macro. FRAP FRAFP
Bemove |
Charee |

| i

Glose

Figure 6.1-3 Keys tab on VBA Options dialog box

Name

Function Overview

Registration list

Lists registered shortcut keys. This list shows the keys and corresponding
descriptions (see With Name in Figure 6.1-4) as well as macro projects and
macros.

[Add]

Registers a new shortcut key. The command displays the Key Definition dialog
box (Figure 6.1-4).
* For more information, refer to Section, “Key Definition.”

[Remove]

Deletes a registered shortcut key.

[Change]

Modifies the information of a registered shortcut key. Select a shortcut key to
modify from the registration list, and then click this button. The command
displays the Key Definition dialog box (Figure 6.1-4) and information on the
selected shortcut key.

* For more information, refer to Section, “Key Definition.”

[Close]

Click this button to register all key assignments and close the dialog box.
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Click the [Add] or [Change] button in the Key tab of VBA Options dialog box (Figure 6.1-3) to display the Key
Definition dialog box (Figure 6.1-4). Use this dialog box to assign macro functions (procedures) to keys.

M

fzzien Key F11 |F'|'|: FRAP Macro FRAP

To Macro: E=C1_Default. md|Dezc.Description =]
EzC1_Default. md|Desc. Terminate

Ezi31_Default. mdIFour Divizion. Four Division

EzC1_Default. mdlITCony [0S _Tiff_Converter

EzC1_Default. mdlSwitch= 8. Report_Update FOW

EzC1_Default. mdlSwitch= 8. Report_Update Period

E=C1_Default. mdlSwitchS 8. Report_UpdateSteps

EzC1_Default. mdlSwitchS . Switch

. . '-'-anz:r. F F!. F LF11) LI

T

Show Macros i [ )| Standard Projects> =l

With Mame: I

Gancel | Assien I

Figure 6.1-4 Key Definition dialog box

Name Function Overview

Assign Key Enter a shortcut key to which a macro is registered. (Type the desired key from
the keyboard.) In the example in Figure 6.1-4, the shortcut key is the F11 key.
If a command is already associated with the key entered here, the existing
command association is displayed in the frame box next to the shortcut key.

To Macro Select a macro command to be registered. In the example in Figure 6.1-4,
“FRAP.Macro.FRAP” is the selected macro command.

Show Macros in Select a project name in which a macro has been saved. You can also select all
macro projects. In the example in Figure 6.1-4, all macro projects are selected.

With Name Enter a description for the macro. In the example in Figure 6.1-4, this textbox is
left blank.

[Cancel] Discards the registration made and reverts to the previous state.

[Assign] Executes the registration.

Note
- The following functions are assigned to the F1 and F12 keys in advance.
F1: Show EZ-C1 Help. (Works the same as selecting Help > EZ-C1 Help.)
F12: Hide all Tools dialog boxes and toolbars. (Works the same as selecting Tools > Hide All.)
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6.1.1.2 Menu

Select the Menu command from the Customize menu (see 6.1.1) to go to the Menu tab on the VBA Options
dialog box (Figure 6.1-5). Click this tab to assign macro functions to a custom user menu.

VBA Options x|

Projectsl Keys  Menu |

Idenu | Marme | Macro | Praject Aidd

&FRAP|EFRAP Macro FRAP FRAF
Bemove |
Charee |

4 | i

Glose

Figure 6.1-5 Menu tab on VBA Options dialog box

Name

Function Overview

Registration list

Lists all registered menus, along with descriptions (see With Name in Figure
6.1-6), as well as macro projects and macros.

[Add] Registers a new menu. Displays the dialog box shown in Figure 6.1-6.

[Remove] Deletes a registered menu.

[Change] Modifies the contents of a registered menu. Select a menu you want to modify
from the registration list and click this button. This displays the dialog box shown
in Figure 6.1-6, which provides contents on the selected menu.

[Close] Click to close the dialog box.

Click the [Add] or [Change] button in the Menu tab of VBA Options dialog box (Figure 6.1-5) to display the Key
Definition dialog box (Figure 6.1-6). Use this dialog box to assign macro functions (procedures) to menus.

oy Detiniion S x

Assin Mer  [IEWEAEN =~ FRAPIERAP FRAPMacroFRAP 1 Confocal

To Macro: E20e1_Detault mallese Descrpion - 5, BRAE | Lat
ExC1_Defsult mdlDase Termniate FRAP
E=C1_Dedsult mdlFourDivisior Four Division r -

EzC1 _I:Ie-'l-:lull md [T Cane IDS 1|11_Cmur'ler -
Bz Dedault mdlSwidchs A Feport_Lipdate POV

E2C1 Diedult mdiSwitch ASwitch

FRAF Macro FRAF SFHAFEFRAFY ;I
st Macros [0 Standard Projects? |

Figure 6.1-6 Key Definition dialog box (menu assignment and registered menus)
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Name

Function Overview

Assign Menu

Enter the menu to be registered. The menu can be registered on the VBA menu
bar or on the EZ-C1 menu bar.

Enter a menu name in the format “name A” to register the menu as A on the VBA
menu.

If you enter “name A | name B,” a menu A with submenu B is registered on the
EZ-C1 menu. (The “|” creates a menu-submenu relationship.)

In the example in Figure 6.1-6, a “FRAP” menu is registered in “FRAP.” Add an
“&” when entering a menu name to underscore the initial letter of the menu.

To Macro

Select a macro command to be registered. In the example in Figure 6.1-6,
“FRAP.Macro.FRAP” is the selected macro command.

Show Macros in

Select a project name in which a macro has been saved. You can also select all
macro projects. In the example in Figure 6.1-6, all macro projects are selected.

With Name Enter a description for the macro. In the example in Figure 6.1-6, this textbox is
left blank.

[Cancel] Discards the registration made and reverts to the previous state.

[Assign] Executes the registration.

6.1.1.3 ToolBar

Select the Toolbar command from the Customize menu (see 6.1.1) to display the ToolBar tab on the VBA
Options dialog box (Figure 6.1-7). Use this tab to assign macro functions to tool buttons.

YBA Options

Projects | Keys | Menu ToolBar ]

X

Button

Macro Project Add

Start FRET.. FRET2.17

mdIMultiSpotTime..  MultiPointTimelapse_ 09121 Remove
Chanee

Close

Figure 6.1-7 ToolBar tab of the VBA Options dialog box
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Name Function Overview

Registration list List all registered tool buttons, along with descriptions (see With Name in Figure
6.1-8), as well as macro projects and macros.

[Add] Registers a new tool button. Displays the dialog box in Figure 6.1-8.

[Remove] Deletes a registered tool button.

[Change] Modifies the contents of a registered tool button. Select a button you want to
modify from the registration list and click this button. This displays the dialog box
shown in Figure 6.1-8, which provides contents on the selected button.

[Up] Move a selected button to be displayed in one line above.

[Down] Move a selected button to be displayed in one line below.

[Close] Click to close the dialog box.

Click the [Add] or [Change] button in the ToolBar tab of VBA Options dialog box (Figure 6.1-7) to display the
Button Definition dialog box (Figure 6.1-8). Use this dialog box to assign macro functions (procedures) to tool

buttons.

Button Definition

ot dadmed

E2C1_Default mdiChannalT led ChannelT led A
EzC1_Default mdiChanreITi led ChanneUn Taled

EzC1_Defatt md|Defsutt Auta Cpen

E2C1_Detault mdDefautt Func_fverage

E2C1_Detault mdIDefautt Func Bottom

EzC Detautt md|Default Func Channel

EzC1_Default md|Defsult Func_index

E2C1_Default md|Defsult Func Lne
E2C1_Default md IDefault Fune Lve 3
Pt Prailaccht s PMalacssss

Piadaoih =l

Show Macrog 16 [0 1) Standard Projects>

e

With Mams: |

Gancal | |

Figure 6.1-8 Button Definition dialog box (tool button assignment and assigned buttons)

Name Function Overview
[Browse] Select an icon file to be specified for a tool button.
The image file specified here is displayed as a tool button in the “Macro’s” tool
dialog box.
To Macro Select a macro command to be registered.

The macro function specified here starts by a corresponding tool button in the

“Macro’s” tool dialog box.

Show Macros in

Select a project name in which a macro has been saved. You can also select all
macro projects. In the example in Figure 6.1-8, all macro projects are selected.
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With Name Enter a description for the macro.
[Cancel] Discards the registration made and reverts to the previous state.
[Assign] Executes the registration.

6.1.2 Macro menu

Select the Macro command from the VBA menu (see 6.1) to display the Macro menu (Figure 6.1-9).
The Macro command is used to create macros.

6.1.2.1 Macros

YBA  Window  Help

7 Customize A T W s e N =
Projects ¥ Pause Recording
\izual Bazic Editor.. « Becord a Mew Macro

Stop Recording

Figure 6.1-9 Macro menu

Select Macro command from the Macro menu (see 6.1.2) to display the Macros dialog box (Figure 6.1-10).
Use this dialog box to run or edit a macro.

Macro name: n

Cancel

md|Default. Auto Open
md|Default Func_fverage
mid|Default Func_Bottom Step Inta
md|Default. Func_Channel
md|Default. Func_hde:x Edit
md|Default.Func_Line =
md|Default.Func_Live
md|Default Func_Reference

md|Default Func_Single Lreate

FlLEf

md|Default. Func_Time ;I
Delete
Macrazine  |<All Standard Projectz> j
D egcription:
[—

=

Figure 6.1-10 Macros dialog box

Name Function Overview

Macro Name Select a macro to run from the list of macros displayed here.

Macros in Select a project name in which a macro has been saved. You can also select all
macro projects. Figure 6.1-10 shows an example with all macro projects
selected.

Description Enter a description for the macro. In the example in Figure 6.1-10, this textbox is
left blank.

[Run] Executes the selected macro.
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[Cancel] Closes the dialog box.
[Step Into] Invokes debug mode. The selected macro is executed line by line.
[Edit] Edits macros. The macro selected is displayed followed by the Visual Basic

Editor (see 6.1.4).

[Create] Creates a new macro. When creating a new macro, enter a name for the new
macro in Macro Name.

[Delete] Deletes the selected macro.

6.1.2.2 Pause Recording

Use the Pause Recording command from the Macro menu (see 6.1.2) to temporarily suspend the Record a
New Macro (see 6.1.2.3).

6.1.2.3 Record a New Macro

Select Record a New Macro from the Macro menu (see 6.1.2) to display the Record a new Macro dialog box
(Figure 6.1-11). Enter a name for the new macro, then begin recording the macro.

Record a new Macro §|

Project to stare the macro:
|new project ﬂ

Mame of the new macro:
|Mau:ru:u1|

Cancel | Recaord |

Figure 6.1-11 Record a new Macro dialog box

Name Function Overview

Project to store the Enter a name of the project name in which you want to save the macro.
macro

Name of the new macro | Enter the name of the new macro.

Click [Record] after entering a name in this dialog box. Subsequent operations performed via the GUI interface
are recorded as a new macro.

Select Pause Recording (see 6.1.2.2) to suspend macro recording if you want to exclude some operation from
the recorded macro.

To finish recording the macro, choose Stop Recording (see 6.1.2.4).

You can now perform the entire sequence of operations recorded as part of the macro simply by running the
recorded macro (by selecting the Macro command: see 6.1.2.1).

6.1.2.4 Stop Recording

Select Stop Recording from the Macro menu (see 6.1.2) to end macro recording.
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6.1.3 Projects menu

Select the Projects command from the VBA menu (see 6.1) to display the Projects menu (Figure 6.1-12).
Use the Projects command to create, edit, load, or save a macro project.

YEA  Window Help

i Customize » | | .
! Macro » 2 IT—.
Load

Yizual Bazic Editor... Mew
Projectz

Figure 6.1-12 Projects menu

6.1.3.1 Load

Select the Load command from the Projects menu (see 6.1.3) to load a macro project. Macro project files are
identified by the “.ezm” extension.

6.1.3.2New

Select the New command from the Projects menu (see 6.1.3) to create a new macro project. Creating a new
macro project generates a temporary project file.

6.1.3.3 Projects

Use the Projects command from the Projects menu (see 6.1.3) to go to the Project tab on the VBA Options
dialog box (Figure 6.1-13). Click this tab to create, edit, load, or save a macro project.

VBA Options

Projects | Kmys | Mo | ToolBar |

Project Path futo | Warzion Herw |
auilt Le¥Frogram Fils Lofonarady Fropecisyl. = RE

\iemar C¥Frogram FilesWhkon¥chared¥Projectizsé.  x 340635 Load _ |

SpectralProcess C¥Program Files¥Ndon¥Shared¥Projeciz¥s.  x J40.684

SutamstedGain C¥Pragram Foes¥bdon¥Sharad¥Proecis¥i. = 1110 Ed“ |

Colocalization ¥ Program Files¥Nkon¥SharedyProjecis¥5. = 1021

FRAF G¥Frogram Files¥NkonWSharad¥Project=¥F. = 1722

fret C¥Program Frles¥ldoon¥charedWProjects¥F.  x 226

lsuncher Thumbnailler  S¥Pragram Fales¥bdon¥Sharady P‘rn|u:1:¥|a. % 10 |

MultiPoin Timelapse  G¥Program Filks¥Nbon¥Shaed¥Projectis¥M.. = 120043 -

Mk Ratio G¥Program Files¥Nkon¥sharadyProjecis¥i.  x 145 Ey

SimpleGLI CMProgram Files¥hdon¥sharedyProjects¥s.  x 20029 = i |

Spen.l'rqlee Ui C¥Pragram Fuobes¥bdoon¥Sharady P‘rn|¢c15¥$ x 106

Til{Expart C¥Fragram Files¥Nkor¥Sharad¥Projecis¥T. = 204 Unload |

G _talbration Ci¥Program Files¥Nkon¥sharedyProjecis¥G. x 1173

< » v Auta-Load

Claze
Figure 6.1-13 Project tab on VBA Options dialog box
Name Function Overview
Project list Lists the macro projects loaded by EZ-C1. The information displayed consists of

“Project” (project name), “Path” (to project file), “Auto” (whether to load the file
automatically the next time EZ-C1 starts), and “Version” (of macro file).
Projects set for automatic loading are marked by an X in the “Auto” column.

171



6 Visual Basic for Applications Support Functions

[New] Creates a new macro project.
Equivalent to the New command on the Macro menu (see 6.1.3.2).

[Load] Loads a macro project file.
Equivalent to the Load command on the Macro menu (see 6.1.3.1).

[Edit] Edits a macro.
Equivalent to function available from the Visual Basic Editor menu (see 6.1.4).

[Save] This button is enabled if changes have been made to a macro project. The
modified macro project overwrites the previous version.

[Save As] This button is enabled if changes have been made to a macro project. The
modified macro project is saved under a new name.

[Unload] Disables loading by EZ-C1 for selected macro project files. Note that the files
selected here will not be loaded the next time the EZ-C1 starts, even if Auto
Load is enabled.

Auto-Load Sets macro project files selected from the list for automatic loading at
subsequent startups.

[Close] Closes the dialog box.
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6.1.4 Visual Basic Editor

Select Visual Basic Editor command from the VBA menu (see 6.1) to display the Visual Basic Editor dialog box

(Figure 6.1-14).
* For more information, refer to the Help files for the VBA development environment.

% Microsoft Visual Basic - C:¥Proeram Files¥Nikon¥EZ-C1 2.21¥Macros¥FRAP¥FRAP{ver305kezm

- Fle Edt Wew Insert Format Debug Run  Tools  AddIns  Window  Help

-l S RRM| o o] ) oo omk| NS

. B C:¥Program Files¥Nikon¥EZ-C1 2.21¥Macros¥E
| _I ™™ C:¥Program Files¥Nikon¥EZ—(]
frmDesc - -
frmTCony IPrevleITexlBux
frmLauncher Dim workl, work? As

Far | = LBoundisecti

frmSwitchS A
¥ mSuwitcd Fem pixeldwell

| B[ Modules

¢ B[ Glass Modules

E-&% FRAP (G¥Program Files¥Nik
(-7 EZ-C1 Objests

Farms

SettingForm
SettingFormz

bleach I i

reading = “secti
Rtn = GetPrivate
settingDatas{i).

Rem laser recover I ......... : IRRE
For j = 1 To 3

workl = LASE

—

zzuul.—[aam&7

E UserFormi reading = "si [ for FLIP I TR [~ Recover Yariable Mode
53 Modules Rtn = GetPri ¥ Linear Gain lode © . -
MdIW settingDatas rsav1— e

di oaule Next J

-,

RN
| I‘ m A R
Fem zrabber gair I ersph 5O Frap o iFrap

Properties — SettingForm x| resding = "secti Z00H
- Rtn = GetPrivatesz ... 0

|SeumgFurm UserForm ;l settingDatastil. B

A'DhahE“C |Categor\zad| For i =1 To 4 B l U skip l Tl

( & SettingForm - workl = GAIM

Ba:kCUIDr [ &He000000F2 | reading = "=

BarderGolar W &HE000001 2 Rtn = GetPri

BorderStyle 0 - fmBorderStylet

Captian EZ-G1 FRAP —

Cvcle 0 - fmCyclefllFore .

DrawEuffer 32000 [ E pffatches B
Enabled True | |Expression Yalue Tvpe Gont ext -
Font M3S Jireh Lor

FareGaolor W &H300000125

Height 2535

HelpContextlD 1}
KeepScrollBarsVisib D fmScral BarsM

Left

Mauselcan (None)

MouseFointer 0 - fmMousePointe

Picture {Mone) |
[T Y esp—— T dn Db \wn_l A »

(KN}

Figure 6.1-14 VBA development environment (Visual Basic Editor dialog box)

6.1.5 Projects bar

The Projects bar contains shortcut buttons for access to functions available from the VBA menu. The Projects
bar is one of the tool dialog boxes (see 4.6) that can be displayed by choosing Projects Bar from the EZ-C1

Tools menu.

Projects Bar

n| @8] »[e[n]n]

The Projects bar includes the following buttons.

Name Function Overview

Lets you create, edit, load, or save a macro project (see 6.1.3.3).

Loads a macro project (see 6.1.3.1).

Displays Visual Basic Editor (see 6.1.4).

Executes a selected macro (see 6.1.2.1).

> | |l | =2
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Begins macro recording (see 6.1.2.3).

[
LI Ends macro recording (see 6.1.2.4).
]|

Pauses macro recording (see 6.1.2.2).

6.2 Description of Macro-related Files

6.2.1 Default project

The default project is a macro file that is automatically read each time EZ-C1 starts up.
Named “Default.ezm,” this file is located in the same directory as EZC1.EXE.
The default project also automatically runs a procedure named “Auto_Open” in the Default.ezm standard
module.
The default project cannot be edited directly. To edit it, copy it to another directory, then open it as a user
project using the “Open Macro File” menu command.
The following three macro types are provided for the default project.
Switch Scanning Area procedure (see 4.5.3)
This default project applies several scanning settings simultaneously.
IdsTiffConvert (see 4.5.2)
This default project converts ids files into tiff files continuously.
Channel Tiled / Untiled (see 4.5.1)
This default project reproduces three windows based on the selected window.

6.2.2 User project

A user project is a VBA project that records macros created by users using EZ-C1.
Usually, a user project is edited by the user. A user project is also created when macro recording is executed.
The file or directory can be named by the user when a project is saved.

6.2.3 Settings files

The following settings files have been added for VBA compatibility.

6.2.3.1 Macro definition file

File name EZMACRO.TBL
Folder Folder in which EZ-C1 is installed

This is a key name definition file that can be used by the Run method. It matches the name of the window path
used by the “Configure Keys” function to the name of the key used by the VBA function.

#comment Comments are preceded by a “#.”
KEY:[Open] Name of key used by Run method
VALUE:[Command.Open] Name of window path used by Configure Key
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6.2.3.2 VBA project settings file

File name EZMACRO.INI
Folder Folder in which EZ-C1 is installed

This file contains information registered in the menu, as well as the file name of the user project to be opened
on subsequent startup.

[VBA]

NextOpenMacro=C:\Macros\user.ezm User project to be opened on subsequent startup
[Customize] Item registered in menu

Procedures=3 Number of items registered in menu

Procedure1=MenuName1;Module1.Menu1 Contents of Menu 1
Procedure2=MenuName2;Module1.Menu2 Contents of Menu 2
Procedure3=MenuName3;Module1.Menu3 Contents of Menu 3

6.2.4 Method

Refer to “EZ-C1 Macro Reference.”
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Experiment Sequence Macro

Each macro file is provided on the CD-ROM disc. These macro files are installed together with the EZ-C1
application software if the application software is installed using the EZ-C1's integrated installer (All EZ-C1 3.90
Project). The file is installed in a folder named Program Files\Nikon\Shared\Projects.

Use the following procedure to load these macro files:

- When macros are installed at the first start-up of the EZ-C1 immediately after installation, a dialog box
prompting for Auto Load settings confirmation appears. The macros set to load here are automatically loaded
at the following start-up.

Auto-—Load Hew YBA Projects

There are new projects in the shared projects folder.
Fleaze indicate which projects vou would like to load by default on startup.

Project

AutomatedGainezm
Colocalizationezm
FRAP.gzm

FRETezm

launcher Thumbrailler ezim
MultiPointTimeLapse.szm

[T s PP

Select All Select Mone Cancel

- If macros that are not set to Auto Load are installed at the second and the following start-up, Auto Load setting
is performed for each macro or a confirmation dialog box is displayed. The macros that are set here to Auto
Load are automatically loaded at the following start-up.

! E There iz a new project ‘ZlhtenzityContralezm’ in the shared projects folder.Do vou want to load it by default 7
-

R {7 (D |

- To set macros that are not automatically set to Auto Load while the EZ-C1 is starting, perform the following
procedure (example: Frap macro).
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Select “Projects” in the “VBA” menu. And then, select “Projects” in the list.

B2 E7-C1 for Hikan G1 Gonfocal W

File Configurs Data Launcher Tools

TestMacros

The “VBA Options” dialog box appears. Press the [Load] button in the box.

VEA Options X]

Frojects ]Keys } Meru } Too\Eiar]

Path Auto New

Unload

v Auto-Load

Cloze

Select the FRAP macro file, FRAP.ezm.

F7T IR PR IB Projects j - &F B
FRAP.ezm

27 IR |FRAPezm i5 0] I
7 IDIEERD:  [Praject Files txezm) B T |
=

Specify the setting to read the FRAP macro file.

VBA Options X

Projects | Keys | Meru | ToolBar |

Project Path Auto Mew
Ez2C1 _Default C:¥Proeral ojects¥Defaultezm  x
= C¥Program Files¥Mikon¥Shared¥Projects¥Viewer ezm Load
(| FRAP C¥Proeram Files¥Mikon¥Shared¥Projects¥F RAP.ezm X

Edit

Save As
Unload

v Auto-Load

Select the FRAP macro file. Check the “Auto-Load” check box.
Once the “Auto-Load” checkbox is selected, when the EZ-C1 is exited and then restarted, the FRAP macro file
will be read automatically.
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VBA Options

Frojects ]Keys | Meru | ToolBar |

5

Project Path

E=C1_Default
Wigwer
FRAP

C¥Program Files¥Nikon¥Shared¥Projects¥Defaultezm  x
C¥Proeram Files¥Mikon¥Shared®Projects¥Viewsr szm X
C¥Proeram Files¥Mikon¥Shared¥Projects¥FRAP.ezm e

Auta New

Load ..
Edit

Save As ..

Unload

v Auto-Load

R

The “FRAP” menu appears in the EZ-C1 menu automatically.

FLIP

%ﬁ
TIRYRETA |4

Note

- FRAP/FLIP Sequence Macro:

- 2 Excitation 1 Emission Ratio Sequence Macro:
- Multipoint Time-lapse Macro:

- FRET Sequence Macro:

- Colocalization Macro:

- Auto Gain Macro:

- Z-stack Intensity Control Macro:
- Tiff Series Export Macro:

- SimpleGUI Macro:

- Thumbnailler:

Launcher

FRAP.ezm

Nk Ratio.ezm

MultiPoint TimeLapse.ezm

FRET.ezm

Colocalization.ezm
AutomatedGain.ezm
ZlntensityControl.ezm

TiffExport.ezm

SimpleGUIl.ezm, SimpleGUISetup.ezm
launcherThumbnailler.ezm

A.1 FRAP Sequence Macro

To perform the fluorescence recovery after photobleaching (FRAP), carry out the following.
(Refer to 5.2.1, and specify the laser, AOM, and AOTF beforehand)

1 Check the settings of the laser, AOM, and AOTF

[For the three-laser unit]
Check the laser and AOM settings.

Select the “Confocal C1” in the “Configure” menu to show the “Configure Confocal C1” dialog box.
Select the “Lasers” tab and press the [setup] button of the laser to be bleached.
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£

Gonfigure Gonfocal G1

Lasers ] Pinhulal Mim:us] Infulmaliunl Triggerl Bleach] Grabbel]

Laserbox #1
Name Wavelenath Shutter DOrder Lazer Ch

M [Casert [488vm | |automatic =] |1 =] |1
¥ 2 [laserz [543mm > | automatc w| |2 ¥
D & o3 oo <] [awomate =] 5 ]

Check the following terms in the “Laser Intensity Control Setup” dialog box: The “Brand” of the “Device Type”
is “Nikon AOM.” The “Laser Power” of the “Calibration” is “100%.” The “Type” is “calibration table.” And the
“Table” is “Nikon AOM XXX.cal.” (Here, “XXX” must be the same number as the wavelength of the laser.)
When a 405 (408) laser diode is installed on the system, items must be set as follows: The “Brand” of the
“Device Type” is “Melles & Griot.” The “Laser Power” of the “Calibration” is “100%.” The “Type” is “calibration
table.” And the “Table” is “Melles & Griot XXX.cal.” (Here, “XXX” must be the same number as the wavelength

of the laser.)

Channel: 1

Azsigned to: Laser 2

Thitial Walue:

Device Type

Brand: Mikon ACOM bl

Reference: v Interpolate between

Dariglli mit ,ﬁ calibration points

Brisht l—:| Logarithmic Scroll 1.04::|
fict iz Shutter: [

[For the four- laser unit]

Check the laser and AOTF settings.

Select the “Confocal C1” in the “Configure” menu to show the “Configure Confocal C1” dialog box.
Select the “Lasers” tab and press the [setup] button of the laser to be bleached.
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Gonfieure Gonfocal G1 &'

Trigger I Eleach ] Standard Detector ] Spectral Detector ]
Lazers ] Power Manitor ] Pinhale ] Mirrors ] Information ]

Mame Wavelength Shutter Order Lazer Cyhtral

F’" 637 |63?-U nm |autumatic j | _A setup ...
W 2 |a03 4080 rm |automatic ~| | 1] =setup ..
7 31 [458 4579 nm |closed  ~] | 1 setup .

v 3-2 [477 4765 nm |automatic v | | 4 setup .
v 3-% [485 4820 nm |automatic v | | setup ..

IV 3-4 [615 [6145 rim
V4 [E6T [6E1.0 rim

__“ setup ..

setup ..

|aut0matlc j |
|aut0matic j |

&0 {5 {3 {0 A ]
IS} sy SN S|

Check the following terms in the “Laser Intensity Control Setup” dialog box: The “Brand” of the “Device Type”
is “Nikon AOTF.” The “Laser Power” of the “Calibration” is “100%.” The “Type” is “calibration table.” And the
“Table” is “Nikon AOTF XXX.cal.” (Here, “XXX” must be the same number as the wavelength of the laser.)
When a 405 (408), 440, or 640 (647) nm laser is installed on the system, items must be set as follows: The
“Brand” of the “Device Type” is “Melles & GriotXXX.” The “Laser Power” of the “Calibration” is “100%.” The
“Type” is “calibration table.” And the “Table” is “Melles & Griot XXX.cal.” (Here, “XXX” must be the same
number as the wavelength of the laser.)

Laser Intensity Gontrol Setup

Channel: 2
Aesighed to: 458
Ihitial Walue: 00 %=
Device Type N
Brand: 7
Reference: external +- B0V hd
D S - Interpolate between

ark Limit: 00000 V=] o pabicane ond points
Eright 40976 v—] S

Logarithmic Scroll 1.DQ

fict iz Shutter: W
Rizetime: 12 us—]

izetime: us v

CAUTION
- Do not change any other items except above.
- For the four-laser unit, the “Brand” option cannot be changed.
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The laser to be used for bleaching must be selected as follows:
Select the “Laser Control Bar” of the “Tools” menu to show the “Laser Control Bar” dialog box. Select the [In
Spots] button. And then, select the check box of the laser to be used for bleaching.

[For the three-laser unit]

Laser Gontrol Bar

Bleach: Mone | All "m Out spots | Seriez. W =] Mml:’.‘ﬂl[
laser 1 EEESE ﬂ gﬂ 'y
‘ lazer 2 [ ﬂ_| ﬂ .
laser 3 Eankll el Cllee

[For the four-laser unit]
P —————————]

Monitor

Bleach: Mone | All "m Ot spnts| Series: -E all
v\ 408 ETTTEARE [Elle
v | 488 [ fo0% | el | e
| 477 ETTTEARE | e
| 488 [ fo0% 4] 5] |
[ |515 000 % ] MG
F | 561 [ im0 % 4| (&) |
v/ 637 [ 1000 % <] s Cf

2 Load the FRAP Sequence macro

Note

- The FRAP sequence macro file is provided on the CD-ROM disc. This macro is installed together with
the EZ-C1 application software if the application software is installed using the EZ-C1’s integrated
installer (All EZ-C1 3.90 Project).
The file is installed in a folder named “Program Files\Nikon\Shared\Projects.”

For loading the macro file, refer to the head description of “A Experiment Sequence Macro.”

3 Set a spot

Scan an image and create a spot on the image.
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4 Specify the setting of bleaching on/off for the spot
Specify the setting of bleaching on/off for each spot by using the “Spots Of Interest” tab of the “View Settings”
window. (See 4.3.6.1)

The “Laser Power” value becomes “0%” regardless of settings for area other than bleached.
To carry out an experiment of iFrap, refer to the example below and define an area in a cell that will not be
bleached.

View Settings 5]

Ifa | Color | View Spots OF Iterest ]

Spots
| Spat [ Caloy] BL. | Area <A |
[+ on 0,062 um2 GSL‘H
Gt All
Copy
[¥ Usze Unite for the Area
Example of bleaching: (1) In spots (2) Out spots

S &

(3) In spot (when two spots overlap one another)

(4) Out spot (when two spots overlap one another)

5 Run the FRAP application software
Select “FRAP” in the “FRAP” menu.

- OFF

Nikon G1 Confocal Mi

!?_ R FLIP

ol v [74

Launcher

CAUTION

- The FRAP sequence macro can be used in the standard mode and the spectrum mode. But, the
FRAP sequence macro does not detect the mode change between the standard mode and the
spectrum mode when running. Therefore, if the mode is changed, the macro issues a warning
message and is aborted. To restore the system, select the menu and start the macro again.

- Do not run another macro when the FRAP sequence macro is running.

6 Select the PMT gain operation mode
Specify the PMT gain operation mode as “Linear Gain Mode” or not.
Usually, select the same mode as the PMT operation mode of the EZ-C1.
When the check box of “Show this dialog again” is checked, the macro runs with the PMT gain operation mode
set above.
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To display the dialog box again, delete the file below.
Program Files\Nikon\Shared\Projects\lineargain.ini

FRAP PMT eain mode set... [X|

[ Linear Gain Mode oK

CAUTION
- The file, Program Files\Nikon\Shared\Projects\lineargain.ini, is used in the following three macros in

common: the FRAP sequence macro, FLIP sequence macro, sequence macro for specimen excited
with lights of two wavelengths but emitting a fluorescent light of one wavelength. Therefore, the “Show
this dialog again” setting will be reflected to other sequence macros.

7 Display the FRAP application dialog box
The FRAP application dialog box appears.
In this window, specify the frame count for each phase of “Preview”, “Bleach”, and “Recover.”

EZ-G1 FRAP Ver. 2.0.0 X

Phaze

Preview lezxd
save

Bleach
Recover

@ In Spots

" Out Spots

I Show grarh at acquisition

Zoom(Area) @ 42,172 x

exec

Note

- [Preview]: This is a phase to be performed before bleaching. Normally specify one frame.

- [Bleach]: This is a phase of bleaching. Normally specify one frame.

- [Recover]: This is a phase after bleaching to observe the recovering specimen. Normally specify

several frames.
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8 Specify the “Preview” phase settings
Specify the “Preview” phase settings as follows:
A “Preview” phase starts when the [Preview] button on the FRAP application dialog box is pressed. The
“preview setting” dialog box appears. The default settings are the same as the settings of EZ-C1. To change
the settings, perform the followings: Press the [Live] button to show a live image. Check the image and specify
each setting of “pixel dwell”, “laser”, and “gain.”
To capture several frames, specify the “Time series” option in the “interval (frame) time setting. (But, the

“Variable Delay Mode” option cannot be used.)

[For the three-laser unit] [For the four-laser unit]
praveom o bbmg Fl prove sollng R]
Lk pizaldwml |l L
—_— [ 2.40 |
pixaldwell u e | oA |
L0 m ] | x| lazer in
o OER m X b | | = grin ermble
lasar
Flaser 1 #0023 4] | * Fow [ s 3y B R TR [ ]
Folaser 2| 5000 20w | i = was I 4 | (i 5| TR E| +
P iser 3] 7r00 1l 4 P&t [ si0 & 4l d w4 ]
e P & [ a0 2 4] | b | Traes | TR i *
B gain enable g
F L L | s6.00 ¥ ¢ | 8 interal(frams} Line
ih | REERE | B | *| I R | win ¥ Al 3 | Az fask as msﬂ.nblelil —_'| J
thz | a3 4l i »
- S s | carcal |
G T | 5 SR —
Trans " TR | | 3

ipLeres | (frams) |ins

g Tagl ag pokgible --” —J |
el | cancel i
Note

- Live: Press this button to start a live image display.

- pixel dwell: Specify the exposure time of the laser for each pixel.

- laser checkbox: Set the laser to be used in the “Preview” phase. This option is used when the laser
wavelength used in the “Bleach” phase differs from the laser wavelength used in the “Preview” phase.

- laser: Set the laser power used in the “Preview” phase to the right of the laser check box.

- gain: Set the PMT gain used in the “Preview” phase.

- gain enable: Check this check box to enable the PMT gain setting. Normally, this option is enabled in
the “Preview” phase.

- interval (frame) time: Select the “As fast as possible” option or the “With fixed delay” option. When
the “With fixed delay” option is used, the time interval must be set with [ms] (milliseconds), [s]
(seconds), or [m] (minutes).

[Default settings of the “Preview” phase]

- pixel dwell: Set values in EZ-C1 are copied here.
- laser checkbox: All lasers are ON.

- laser: Set values in EZ-C1 are copied here.

- gain: Set values in EZ-C1 are copied here.

- gain enable: Enabled

- interval (frame) time: “As fast as possible”

If the specimen has been checked with EZ-C1 and the image has no problem, the settings for the
“Preview” phase does not need any change.
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9 Specify the “Bleach” phase settings
Specify the “Bleach” phase settings as follows:
A “Bleach” phase starts when the [Bleach] button on the FRAP application dialog box is pressed. The “bleach
setting” dialog box appears. Specify the “laser” and “gain” settings for the “Bleach” phase. The default settings
are the followings: The “pixel dwell” value is the same as the “Preview” setting. All laser powers are “100%.” All
gains are 0.
A “Scan zoom area selection [selected]” window also appears. Scan areas to be bleached are defined on this
window. To define a scan area, create a rectangle with mouse operation. If no area is defined here, an area
will be defined automatically where all spots are included.

[For the three-laser unit] [Define hleach areas]

T | e -

ploaldes |

i
luzar

I~ ctarge LasarPows
= lamer 8 [ TOHCHD 5 = [ TLoF X

%l
k.

mhin

™ eulm srabis
™|
mi
my

Traca

-t | zarenl

[For the four-laser unit]

bisach satling

el deel |
[*
[TE min
R changs Laserfossr R
= 1] o W[ 1 = TOLEE I
o E 10, M i
(<3 | oo 2 ¢ = TOLOE X
- .o 2
=20 I T R L P
? B
w o wo e B v = TG X 2
Tranz
#ooae [em X[ v e[ TORNE X
F oss [ k[ oo« [ THEEE 2
L 11| ot A 1 =] TH.AE I
sl cancel

185



A Experiment Sequence Macro

Note
- pixel dwell: The exposure time of the laser for each pixel is shown here. (It is the same value as the

“Previous” setting.)

This value cannot be changed here. To change this value, use the “Preview Setting” dialog box.
laser checkbox: Set the laser to be used in the “Bleach” phase.

This option is used when the laser wavelength used in the “Bleach” phase differs from the laser
wavelength used in the “Preview” phase.

laser: Set the laser power used in the “Bleach” phase to the right of the laser check box. Normally,
this is “100%.”

To specify another laser power, select the [change Laser Power] option.

change Laser Power: This check box is checked to change the laser power used in the “Bleach”
phase from “100%.”

gain: Set the PMT gain used in the “Bleach” phase. Normally, this is “0.”

To specify another gain, select the [gain enable] option.

gain enable: This check box is checked to change the gain used in the “Bleach” phase from “0.”

To show the image in the “Bleach” phase, the following items must be set. Check the “gain enable”
option. Change the menu to the “Configure” menu. Select the “Confocal C1” to show the “Configure
Confocal C1” dialog box. Select the “Bleach” tab. Unselect the “Block Detectors during Bleaching”
option. But if the amount of input light is too large, EZ-C1 automatically shuts down the voltage supply
for the PMT gain. To disable the automatic shut down, the “Block Detectors during Bleaching” is
normally checked. When the checkbox is checked, the gain is set as “0” and the image does not
appear during bleaching.

[Default settings of the “Bleach” phase]

pixel dwell: Set values for the “Preview” phase are copied here.

laser checkbox: Selected lasers in step 1 “Check the settings of the laser, AOM, and AOTF” for
bleaching are set as ON.

laser: This entry is set as “100%.”

change Laser Power: This check box is not checked.

gain: This entry is set as “0.”

gain enable: Disabled

Scan area: The scan area is set as a rectangle that circumscribes all spot areas.

You don’t need any change when the default settings are effective.
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10 Specify the “Recover” phase settings
Specify the “Recover” phase settings as follows:
A “Recover” phase starts when the [Recover] button on the FRAP application dialog box is pressed. The
“recover setting” dialog box appears. Specify the “laser” and “gain” settings for the “Recover” phase. The
default settings are same as that of the “Preview” phase.

To capture several frames in the “Recover” phase, specify the “Time series” option in the “interval (frame) time

setting. (But, the “Variable Delay Mode” option cannot be used.)

[For the three-laser unit] [For the four-laser unit]
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Note

same pre setting: This check box is used to specify the “laser” and “gain” settings for the “Recover”
phase as the same settings of the “Preview” phase. To specify the settings independently, do not
check this check box. To specify the settings same as the “Preview” phase, check this check box.
Normally, check it.

But, the “pixel dwell” and “interval (frame) time” settings are not effected by this check box.

pixel dwell: The exposure time of the laser for each pixel is shown here. (It is the same value as the
“Previous” setting.)

This value cannot be changed here. To change this value, use the “Preview Setting” dialog box.
laser checkbox: Set the laser to be used in the “Recover” phase. This option is used when the laser
wavelength used in the “Recover” phase differs from the laser wavelength used in the “Preview”
phase or “Bleach” phase. To use this option, the “same pre setting” check box must be off.

laser: Set the laser power used in the “Recover” phase to the right of the laser check box. To use this
option, the “same pre setting” check box must be off.

gain: Specify the PMT gain used in the “Recover” phase. To use this option, the “same pre setting”
check box must be off.

gain enable: Check this check box to enable the PMT gain setting. To use this option, the “same pre
setting” check box must be off.

interval (frame) time: Select the “As fast as possible” option or the “With fixed delay” option. When
the “With fixed delay” option is used, the time interval must be set with [ms] (milliseconds), [s]
(seconds), or [m] (minutes).

This option is normally used in the “Recover” phase.
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[Default settings of the “Recover” phase]

- same pre setting: This check box is on. Normally, the setting for the “Recover” phase is set the same
as the “Preview” phase.

- pixel dwell: Set values for the “Preview” phase are copied here.

- laser checkbox: Set values for the “Preview” phase are copied here.

- laser: Set values for the “Preview” phase are copied here.

- gain: Set values for the “Preview” phase are copied here.

- gain enable: Set values for the “Preview” phase are copied here.

- interval (frame) time: “As fast as possible”

Normally, the settings of the “Recover” phase are the same as that of the “Preview” phase. Therefore,
the default settings are effective. But in some cases, the “interval (frame) time” setting is changed from
the default setting. The “Recover phase setting” dialog box is used for such cases.

You do not need to change settings for the “Recover” phase, if there is no problem with the option “As
fast as possible” selected for “interval (frame) time” and the other default settings the same as the
“Preview” phase.

11 Execute the FRAP sequence
After specifying settings for the “Preview”, “Bleach,” and “Recover” phase, press the [exec] button on the
FRAP application software window to start a FRAP sequence. The FRAP sequence processes each phase,

captures images, and displays images and data in graphical form.
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Note

When you use default settings for each phase, you can omit setting each phase. If you observe the
specimen with EZ-C1, the settings of EZ-C1 will be copied to the settings of the “Preview” and “Recover’
phases. And for the settings of the “Bleach” phase, the laser power will be set as “100%.” To perform a
time-lapse photographing with the “As fast as possible” setting in a FRAP experiment, specify the image
count on the FRAP application window and simply press the [exec] button.

Default settings for each phase are described as follows:

[Default settings of the “Preview” phase]

- pixel dwell: Set values in EZ-C1 are copied here.
- laser checkbox: All lasers are ON.

- laser: Set values in EZ-C1 are copied here.

- gain: Set values in EZ-C1 are copied here.

- gain enable: Enabled

- interval (frame) time: “As fast as possible”

[Default settings of the “Bleach” phase]

- pixel dwell: Set values for the “Preview” phase are copied here.

- laser checkbox: Selected lasers in step 1 “Check the settings of the laser, AOM, and AOTF” for
bleaching are set as ON.

- laser: This entry is set as “100%.”

- change Laser Power: This check box is not checked.

- gain: This entry is set as “0.”

- gain enable: Disabled

- Scan area: The scan area is set as a rectangle that circumscribes all spot areas.

[Default settings of the “Recover” phase]

- same pre setting: This check box is on. Normally, the setting for the “Recover” phase is set the same
as the “Preview” phase.

- pixel dwell: Set values for the “Preview” phase are copied here.

- laser checkbox: Set values for the “Preview” phase are copied here.

- laser: Set values for the “Preview” phase are copied here.

- gain: Set values for the “Preview” phase are copied here.

- gain enable: Set values for the “Preview” phase are copied here.

- interval (frame) time: “As fast as possible”
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12 Other functions

The FRAP application software also has following functions.
[save] [load]: These functions save/load the settings of the FRAP application software.

Show graph at acquisition:

In Spots / Out Spots:

ZOOM: This option changes

EZ-G1 FRAP Yer. 2.0.0

Phase

Preview 1

* In Spots
" Out Spots

Zoom{hrea) : 42,172 x

ERXEC

Bleach 1
Recover 10

[~ Show zraph at acquisition

This option shows a graph window together for each phase.
At the end of the steps, a graph window will be shown regardless of this option.
Normally, this option is off.
This option specifies settings of the side of bleaching, inside or outside of a
spot.

the zooming magnification in the scan area of bleaching.

X
load

Tave

Note

You can use a specific wavelength to excite a specimen with the FRAP sequence macro described as
follows: Set a wavelength for the “Preview” and “Recover” phase, and set another wavelength for the

“Bleach” phase.
Example

In case that the wavelength of 405 nm is used to excite a specimen and the wavelength 488 nm is used to
observe the specimen, specify as follows: Set the 488 nm for the “Laser Checkbox” of the “Preview” and
“Recover” phase and set the 405 nm for the “Laser Checkbox” of the “Bleach” phase. This enables
exciting a specimen instead of bleaching a specimen.
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A.2 FLIP Sequence Macro

To perform the fluorescence loss in photobleaching (FLIP), carry out the following.
(Refer to 5.2.1, and specify the laser, AOM, and AOTF beforehand)

1 Check the settings of the laser, AOM, and AOTF

Refer to A.1, “FRAP Sequence Macro.” The same settings are used in the FLIP sequence.

2 Load the FLIP Sequence macro
For loading the macro file, refer to the head description of “A Experiment Sequence Macro.”

3 Set a spot

To set a spot, refer to A.1, “FRAP Sequence Macro.” The same operation is required in the FLIP sequence.

4 Specify the setting of bleaching on/off for the spot
To specify the setting of bleaching on/off for the spot, refer to A.1, “FRAP Sequence Macro.” The same
operation is required in the FLIP sequence.

However, the FLIP sequence is not recommended for experiments that are intended to bleach wide areas and
keep a part from bleaching like iFrap.
It is possible to perform such experiments but do not try.

5 Run the FLIP application software
Select “FLIP” in the “FRAP” menu.

Niken G1 Gonfocal Mig

Data Launcher

IYRETA LR
CAUTION

- The FLIP sequence macro can be used in the standard mode and the spectrum mode. But, the FLIP
sequence macro does not detect the mode change between the standard mode and the spectrum
mode when running. Therefore, if the mode is changed, the macro issues a warning message and is
aborted. To restore the system, select the menu and start the macro again.

- Do not run another macro when the FLIP sequence macro is running.
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6 Select the PMT gain operation mode
Specify the PMT gain operation mode as “Linear Gain Mode” or not.
Usually, select the same mode as the PMT operation mode of the EZ-C1.
When the check box of “Show this dialog again” is checked, the macro runs with the PMT gain operation mode
set above.
To display the dialog box again, delete the file below.
Program Files\Nikon\Shared\Projects\lineargain.ini

FLIP PMT gain mode sett... [K|

[ Linear Gain Mode K

CAUTION

- The file, Program Files\Nikon\Shared\Projects\lineargain.ini, is used in the following three macros in
common: the FRAP sequence macro, FLIP sequence macro, sequence macro for specimen excited
with lights of two wavelengths but emitting a fluorescent light of one wavelength. Therefore, the “Show
this dialog again” setting will be reflected to other sequence macros.

7 Display the FLIP application dialog box
The FLIP application dialog box appears.
In this window, specify the frame count for the “Preview” phase.

EZ-G1 FLIP Ver. 2.0.0 X

Preview @ o]

Phase

!

ave

Note

- [Preview]: This is a phase to be performed before bleaching. Normally specify one frame

Bleach

Recover

i

1

[« 2z

Sets

|Withfixed delay j| mi“ s j

I Show grarh at acquisition

Zoom{hrea) 1 42,172

exec

x

exit
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8 Specify the “Preview” phase settings
Specify the “Preview” phase settings as follows:
A “Preview” phase starts when the [Preview] button on the FLIP application dialog box is pressed. The
“preview setting” dialog box appears. The default settings are the same as the settings of EZ-C1. To change
the settings, perform the followings: Press the [Live] button to show a live image. Check the image and specify
each setting of “pixel dwell,” “laser,” and “gain.”
To capture several frames, specify the “Time series” option in the “interval (frame) time setting. (But, the
“Variable Delay Mode” option cannot be used.)

To specify the settings, refer to A.1, “FRAP Sequence Macro.” The same operation is required in the FLIP
sequence.

9 Specify the “FLIP Set” settings in the FLIP application software dialog box
Return to the FLIP application software dialog box. Set the “FLIP Set” settings in the box. Specify the frame
counts for the “Bleach” phase and “Recover” phase in one set.
And then, specify the repeat count of sets.

EZ-CG1 FLIP Ver. 2.0.0

Preview 1

Phase

X

!

load

save
Bleach

i

Recover

|Withfixed delay j| mi“ s j

I Show grarh at acquisition

Zoom(Area) @ 42,172 x

EXEC exit

Note

- [Bleach]: This is a phase of bleaching. Normally specify one frame.

- [Recover]: This is a phase after bleaching to observe the recovering specimen. Normally specify one
frame for a FLIP experiment.

- [Sets]: This is the repeat count of “Bleach” phases and “Recover” phases. Specify several
frames for a FLIP experiment.

When the FLIP sequence macro runs, the following steps are executed: A “Preview” phase is executed. (It is
shown as “Preview” in the figure below.) “Bleach” phases (shown as “Ble” in the figure below) and “Recover”
phases (shown as “Acq” in the figure below) are repeated the number specified in the “Sets” option. Only
images captured in the “Recover” phase are saved as experiment images. This sequence replicates a FLIP
experiment practically.

The minimum processing period for one set is about one second. (It depends on the image size.)
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Min 1 sec

Preview |Ble |Acq [Ble |(Acq |Ble |Acq Ble |Acq (Ble (Acq |Ble [Acq

Intensity

Time

10 Specify the “Bleach” phase settings
Specify the “Bleach” phase settings as follows:
A “Bleach” phase starts when the [Bleach] button on the FLIP application dialog box is pressed. The “bleach
setting” dialog box appears. Specify the “laser” and “gain” settings for the “Bleach” phase. The default settings
are the followings: The “pixel dwell” value is the same as the “Preview” setting. All laser powers are “100%.” All
gains are 0.
A “Scan zoom area selection [selected]” window also appears. Scan areas to be bleached are defined on this
window. To define a scan area, create a rectangle with mouse operation. If no area is defined here, an area
will be defined automatically where all spots are included.

To specify the settings, refer to A.1, “FRAP Sequence Macro.” The same operation is required in the FLIP
sequence.

Note

- In some FLIP experiment, some “Spots” are defined for analysis, not only an area to be bleached but
also another area in the cell to be bleached, an area used as a reference, and an area in the
background.
When the automatic setting is used in this case, the area to be scanned for bleaching is set as a
rectangle including all “Spots” and circumscribing them.
This area may be too large to be scanned for bleaching. To get more suitable area, set the scan area
manually in the scan area setting window.
On the other hand, automatic bleach scan area setting like FRAP can be used when the following
steps are performed: Only the “Spot” to be bleached are specified before the processing. And the
“Spot” to be analyzed is specified after the processing.
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11 Specify the “Recover” phase settings
Specify the “Recover” phase settings as follows:
A “Recover” phase starts when the [Recover] button on the FLIP application dialog box is pressed. The
“recover setting” dialog box appears. Specify the “laser” and “gain” settings for the “Recover” phase. The
default settings are same as that of the “Preview” phase.
To capture several frames in the “Recover” phase, specify the “Time series” option in the “interval (frame) time
setting. (But, the “Variable Delay Mode” option cannot be used.)

To specify the settings, refer to A.1, “FRAP Sequence Macro.” The same operation is required in the FLIP
sequence.

Note

- With the FLIP sequence macro, a time-lapse photographing can be performed that has “Sets.” A “Set”
is defined as a combination of a “Bleach” phase and a “Recover” phase.
Therefore avoid a time-lapse setting only with a “Recover” phase but use the default setting of “As fast
as possible.”

12 Specify the time-lapse settings of the “FLIP Set” in the FLIP application software
dialog box
Return to the FLIP application software dialog box. Specify the time-lapse setting of the “FLIP Set” in the
dialog box. A time-lapse photographing is available by using the “FLIP Set.” The “FLIP Set” has a “Bleach”
phase and a “Recover” phase in a set.
With these settings, the sequence will go as: “Bleach” phase -> “Recover” phase -> time-lapse waiting.
(No time-lapse waiting is made between the “Bleach” phase and the “Recover” phase.)

EZ-C1 FLIP  Ver. 2.0.0 3]

Preview
load

i

il B

Phase
save

Bleach

Recover

U

7

Sets
|Withfixed delay j| mi” s -

I Show grach at acquisition

Zoom(hrea) @ 42,172 x

EXEC exit

Note

- interval (frame) time: Select the “As fast as possible” option or the “With fixed delay” option. When
the “With fixed delay” option is used, the time interval must be set with [ms] (milliseconds), [s]
(seconds), or [m] (minutes).
Normally this option is used in the FLIP Set time-lapse photographing. (When no time interval is
required, select the “As fast as possible” option.)
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13 Execute the FLIP sequence
After specifying settings for the “Preview”, “Bleach,” “Recover” phase, the “Flip Set” count, and the time-lapse
photographing, press the [exec] button on the FLIP application software window to start a FLIP sequence. At
first a “Preview” phase is processed. “Bleach” phases and “Recover” phases are repeated as specified in the
“Set” option. Images are captured in each phase. And then, data in graphical form is displayed.

EZ-C1 FRAF Wer. 2.0.0
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Note

When you use default settings for each phase, you can omit setting each phase. If you observe the
specimen with EZ-C1, the settings of EZ-C1 will be copied to the settings of the “Preview” and “Recover”
phases. And for the settings of the “Bleach” phase, the laser power will be set as “100%.” To perform a
time-lapse photographing with the “As fast as possible” setting in a FLIP experiment, specify the image
count on the FLIP application window and simply press the [exec] button.

Default settings for each phase are described as follows:

[Default settings of the “Preview” phase]

pixel dwell: Set values in EZ-C1 are copied here.
laser checkbox: All lasers are ON.

laser: Set values in EZ-C1 are copied here.

gain: Set values in EZ-C1 are copied here.

gain enable: Enabled

interval (frame) time: “As fast as possible”

[Default settings of the “Bleach” phase]

pixel dwell: Set values for the “Preview” phase are copied here.
laser checkbox: Selected lasers in step 1 “Check the settings of the laser, AOM, and AOTF” for
bleaching are set as ON.
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- laser: This entry is set as “100%.”

- change Laser Power: This check box is not checked.

- gain: This entry is set as “0.”

- gain enable: Disabled

- Scan area: The scan area is set as a rectangle that circumscribes all spot areas.

[Default settings of the “Recover” phase]

- same pre setting: This check box is on. Normally, the setting for the “Recover” phase is set the same
as the “Preview” phase.

- pixel dwell: Set values for the “Preview” phase are copied here.

- laser checkbox: Set values for the “Preview” phase are copied here.

- laser: Set values for the “Preview” phase are copied here.

- gain: Set values for the “Preview” phase are copied here.

- gain enable: Set values for the “Preview” phase are copied here.

- interval (frame) time: “As fast as possible”

[Default settings of the “FLIP Set”]
- interval (frame) time: “As fast as possible”

14 Other functions
The FLIP application software also has following functions.
[save] [load]: These functions save/load the settings of the FLIP application software.
Show graph at acquisition: This option shows a graph window together for each phase.
At the end of the steps, a graph window will be shown regardless of this option.
Normally, this option is off.
ZOOM: This option changes the zooming magnification in the scan area of bleaching.

EZ-G1 FLIP Ver 2.0.0 X

i
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Freview
load

Phase
save

Bleach

W

Sets

|Withfixed delay j| 1ni‘| s j

Recover

U

[~ Show zraph at acquizition

Zoom(hrea) 1 42,172 x

[ exit

Note

You can use a specific wavelength to excite a specimen with the FLIP sequence macro described as
follows: Set a wavelength for the “Preview” and “Recover” phase, and set another wavelength for the
“Bleach” phase.

Example:

In case that the wavelength of 405 nm is used to excite a specimen and the wavelength 488 nm is used to
observe the specimen, specify as follows: Set the 488 nm for the “Laser Checkbox” of the “Preview” and
“Recover” phase and set the 405 nm for the “Laser Checkbox” of the “Bleach” phase. This enables
exciting a specimen instead of bleaching a specimen.
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A.3 2 Excitation 1 Emission Ratio Sequence Macro

“2 Extension 1 Emission” fluorescent experience method is used when the intensity of the emitted fluorescent
light depends on the exciting laser wavelength. The wavelengths to excite the specimen are changed but the
wavelength to be emitted from the specimen does not change.

To run the 2 Excitation 1 Emission, perform the following.

1 Load the 2 Excitation 1 Emission Ratio Sequence macro
For loading the macro file, refer to the head description of “A Experiment Sequence Macro.”

Note

- The 2 excitation 1 emission ratio sequence macro is provided on the CD-ROM disc. This macro is
installed together with the EZ-C1 application software if the application software is installed using the
EZ-C1's integrated installer (All EZ-C1 3.90 Project).
The file is installed in a folder named Program Files\Nikon\Shared\Projects.

2 Start the fluorescence ratio application software
On the “Data” menu, point to “Calculate,” and then click “2Ex 1Em Ratio.”

EZ-C1 for Hikon C1 GConfocal Microscope - CG1 5pf
Toolz WEA  Wind
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CAUTION

- The fluorescence ratio macro can be used only in the standard mode. If the system is running in the
spectrum mode, this macro issues a warning message and is aborted. In that case, change the mode
to the standard mode. And then select the macro on the menu to start it.

- Do not run another macro when the fluorescence ratio macro is running.

3 Select the PMT gain operation mode
Specify the PMT gain operation mode as “Linear Gain Mode” or not.
Usually, select the same mode as the PMT operation mode of the EZ-C1.
When the check box of “Show this dialog again” is checked, the macro runs with the PMT gain operation mode
set above.
To display the dialog box again, delete the file below.
Program Files\Nikon\Shared\Projects\lineargain.ini
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EZ-G1 PMT Gain Gontrol... [X|

[ Linear Gain Mode oK

CAUTION

- The file, Program Files\Nikon\Shared\Projects\lineargain.ini, is used in the following three macros in
common: the FRAP sequence macro, FLIP sequence macro, fluorescence ratio sequence macro for
specimen excited with lights of two wavelengths but emitting a fluorescent light of one wavelength.
Therefore, the “Show this dialog again” setting will be reflected to other sequence macros.

4 [Step 1] Select the channel to be acquired

Setup - channel Yer. 1.3.4

hannel 430/25 GS0LF | 5a0/s0 | 0 |

Select the channel to be acquired.
And then, press the [Next] button.

Note

- [Channel] button: These buttons select the channel to be acquired.
- [Close] button: This button stops and aborts the macro.

- [Next >>] button: This button proceeds to the next step.
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5 [Step 2] Specify the laser used to excite the specimen (numerator of the ratio)

Setup — Numerator Ver. 1.3 4 §|

single Selected Channel 48025

Gain 480/25

124 4] [ 2l

Laser

405 -

sooo & 4l [ i

<< Back | Close ‘ Mext =

Specify the laser wavelength to excite the specimen. The value of this wavelength is used as a numerator of
the ratio. And the gain of the channel that is used to acquire the intensity of the laser (numerator laser) can be
set too.

Images can be previewed by pressing the [Live] or [single] button.

And then, press the [Next] button.

Note

- [Live] button: Press this button to display a live image. This function can be used to preview images
when specifying the numerator laser to excite the specimen. This is the same function as the [Live]
button in EZ-C1.

- [single] button: Press this button to capture single image. This function can be used to check an
image when specifying the numerator laser to excite the specimen. This is the same function as the
[Single] button in EZ-C1.

- [Selected Channel]: The selected channel name is displayed here.

- [Gain]: The PMT gain used to acquire the intensity of the numerator laser is specified here.

- [Laser]: The shutter of the numerator laser to excite the specimen is specified here. When one laser
shutter is selected, other laser shutters are closed.

Laser and Detector

laser [y [T466 S| N

And, the numerator laser power to excite the specimen can be set too.
- [<<Back] button: Press this button to return to the previous step.
- [Close] button: Press this button to stop and abort the macro.
- [Next >>] button: Press this button to go to the next step.
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6 [Step 3] Specify the laser used to excite the specimen (denominator of the ratio)

Setup — Denominator Ver. 1.3.4 E|

. Setup - Denominatar
Live

single Selected Channel 43025

Gain 480/25
¥ same Mumnerator

e w

Laser

455 -
200 ¢ | 2]
<4 Back | Clase ‘ Nexk =2

Specify the laser wavelength to excite the specimen. The value of this wavelength is used as a denominator of
the ratio. And the gain of the channel that is used to acquire the intensity of the laser (denominator laser) can
be set too. The default value is the same as the PMT gain value used in the [Step 2].

Images can be previewed by pressing the [Live] or [single] button.

And then, press the [Next] button.

Note

- [Live] button: Press this button to display a live image. This function can be used to preview images
when specifying the denominator laser to excite the specimen. This is the same function as the [Live]
button in EZ-C1.

- [single] button: Press this button to capture single image. This function can be used to check an
image when specifying the denominator laser to excite the specimen. This is the same function as the
[Single] button in EZ-C1.

- [Selected Channel]: The selected channel name is displayed here.

- [same Numerator]: This check box is checked when the PMT gain setting for the denominator laser
is the same as the setting for the numerator laser.

- [Gain]: The channel gain used to acquire the intensity of the denominator laser is specified here.

- [Laser]: The shutter of the denominator laser to excite the specimen is specified here. When one
laser shutter is selected, other laser shutters are closed.

Laser and Detector

e 7 TS

And, the denominator laser power to excite the specimen can be set too.
- [<<Back] button: Press this button to return to the previous step.
- [Close] button: Press this button to stop and abort the macro.
- [Next >>] button: Press this button to go to the next step.
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7 [Step 4] Specify the time-lapse photographing settings

Set up — Aquire g|

TineSeries

| With fixed delay j| 3] | msj
0 franes

<4 Back ‘ Close ‘ Mext ==

Specify the time-lapse photographing settings for the “Ratio Set.” The “Ratio Set” means one set of
photographs that consist of a picture of the numerator laser step and a picture of the denominator laser step.
Select one of the following three modes.

Acquisition mode Settings

1. Only one set of the “Ratio Set” is acquired. Do not check the “Enable Time Series.”

2. A series of “Ratio Sets” is acquired continuously. | Check the “Enable Time Series.”

Select “As fast as possible” in the “Time Series” list.
Specify the count of photographs.

3. A series of “Ratio Sets” is acquired at a specified | Check the “Enable Time Series.”
time interval. Select “With fixed delay” in the “Time Series” list.

Specify the time interval and the count of photographs.

And then, press the [Next] button.

Note

[Enable Time Series]: Select this option to enable time-lapse photographing.

[Time Lapse Mode]: Select a time-lapse photographing mode. Select the “As fast as possible” option
or the “With fixed delay” option. The “With variable delay” option cannot be selected.

It can be selected only when the “Enable Time Series” option is checked.

[Interval Time]: Specify the time interval setting for the time-lapse photographing. It can be specified
in units of milliseconds (ms), seconds (s), or minutes (m). As for the milliseconds, up to 5000 can be
specified. As for the seconds and minutes, up to 300 can be specified.

(Caution: If no image is acquired within the period specified here, the sequence will be aborted.
Specify an enough value to acquire both photographs of one “Ratio Set.”

This setting can be specified only when the “Enable Time Series” option is checked and the “With
fixed delay” is selected in the “Time Lapse Mode.”

[Frames]: The count of the “Ratio Set” for the time-lapse photographing is specified here.

It can be selected only when the “Enable Time Series” option is checked.

[<<Back] button: Press this button to return to the previous step.

[Close] button: Press this button to stop and abort the macro.

[Next >>] button: Press this button to go to the next step.
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8 [Step 5] Select the calculation method to get the ratio

Select Ratio Function E|

* Marmal Use EZ-C1 Ratio Function

™ weighted ‘weighted Ratio creates only image.

<= Back Close Mext ==

Select the calculation method to get the ratio

The following two methods are available.

Normal ratio calculation method: The normal calculation method used in EZ-C1.

The settings are specified in EZ-C1.

Weighted ratio calculation method: This is a special calculation method. Pixels are weighted in accordance
with their brightness. Therefore, brightness information that might be
ignored in the normal calculation method will be reflected to the calculation
result. (The brightness information of the denominator laser channel is
used with this method.)

CAUTION

- When the Weighted ratio calculation method is used, image data is output as RGB 24 bits data after
calculation. Therefore, no ratio information remains in the image data after calculation. And no ratio
analysis can be performed using “Spots.”
To perform a ratio analysis, select the Normal ratio calculation method.

And then, press the [Next] button.
When the Normal ratio calculation method is selected, go to Step 7.
When the Weighted ratio calculation method is selected, go to Step 6.

Note

- [Ratio calculation method]: Select the ratio calculation method to be used.
- [<<Back] button: This button returns the step to the previous step.

- [Close] button: This button stops and aborts the macro.

- [Next >>] button: This button proceeds to the next step.
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9 [Step 6] Specify the settings for the Weighted ratio calculation method

Weighted Pseudo Ratio Setup E]
Min o1 Mazx 3.0
Mask pixels darker than

& 1

Iask. pixels brighter than

2]
4096 ﬂ J_}I
LT 3 - [ Add Saturation Indicator

<= Back ‘ Close ‘ Mext ==

Specify the parameters used in the Weighted ratio calculation method. In this calculation, pixel data are
converted to RGB 24 bits data by using a look-up table that has data to assign weights to pixels.
And then, press the [Next] button.

Note

[Min]: Specify the minimum value of ratios for the look-up table.

[Max]: Specify the maximum value of ratios for the look-up table.

[Mask pixels darker than]: When brightness of a pixel is darker than this value, the pixel is set as
black in the Weighted ratio calculation.

This option is used to remove background noise.

[Mask pixels brighter than]: When brightness of a pixel is darker than this value, the pixel is set as
black in the Weighted ratio calculation.

This option is used to remove pixels that have saturated values (or that have values near saturation).
[LUT]: Select a look-up table that has the suitable weighting values for pixels. Six look-up tables are
available. They have a different gamma correction curve.

[Add Saturation Indicator]: This check box is checked to display special colors of pixels that have
values less than “Min” or larger than “Max.” When this check box is not checked, the pixel that has a
smaller value than “Min” is displayed the same color as that of the “Min” value and the pixel that has a
larger value than “Max” is displayed the same color as that of the “Max” value. When this check box is
checked, the pixel that has a smaller value than “Min” is displayed as cyan and the pixel that has a
larger value than “Max” is displayed as pink.

[<<Back] button: Press this button to return to the previous step.

[Close] button: Press this button to stop and abort the macro.

[Next >>] button: Press this button to go to the next step.
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10 [Step 7] Acquire the data and display the result

Eroeress E]

1 488nm - Acquire start
1 433nm- Acquire end
1 633nm - Acquire start
1 633nm- Acquire end

<<Back‘ Close ‘

When this dialog box is displayed, the data acquisition starts. During the data acquisition, text-based
information is displayed in the dialog box.

When the “Ratio Set” acquisition is completed, each captured image is displayed on EZ-C1 as an image of a
separate channel. This data can be handled as the same way as a fluorescence ratio experiment.

At the same time, a ratio image is displayed on the Ratio window.

When the Normal ratio calculation method is used, the ratio image can be handled as the same way as a ratio
calculation in EZ-C1.

(For settings about the Normal ratio calculation method, refer to 4.3.3.)

When the Weighted ratio calculation method is used, the ratio image in the Ratio window has RGB 24 bits data.
This image cannot be handled as a ratio image of EZ-C1. Be aware of it.

CAUTION

- Be sure to save the acquired image. (Not the ratioimage) = When the acquired image is kept, it can
be handled as the same way as a fluorescence ratio experiment. It can be used not only in the Normal
ratio calculation but also in the “Convert Weighted Ratio” macro to create a Weighted ratio image.

This is the end of the fluorescence ratio macro sequence.
To finish the macro, press the [Close] button. To acquire another image, press the [Restart] button.

Note

- [Photograph information]: During the data acquisition of “Ratio Sets,” text-based information is
displayed in the dialog box.
Four statuses are displayed here: “Acquire start” to show the start of acquiring one frame, “Acquire
end” to show the end of acquiring one frame, “Finish” to show the end of acquiring all “Ratio Sets”, and
“Error” to show an error occurrence.

- [<<Back] button: Press this button to return to the previous step.

- [Close] button: Press this button to stop and abort the macro.

- [Restart] button: Press this button to acquire another image with the same settings. To change the
settings, press the [<<Back] button to go to the corresponding step.
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During the data acquisition, four images are displayed in the window: an image of the numerator laser channel,
an image of the denominator laser channel, a ratio image, a live image (latest image acquired).

11 Weighted ratio conversion macro
The weighted ratio conversion macro is used to calculate a weighted ratio operation from multiple channel
images captured already and create a weighted ratio image.
In the fluorescence ratio sequence macro, the weighted ratio operation settings cannot be changed without
capturing images again. And captured images cannot be converted to weighted ratio images after the
processing.
In such case, use this macro to convert captured images to weighted ratio images.
This macro is also useful for other multiple channel images than images acquired with the fluorescence ratio
macro.

On the “Data” menu, point to “Calculate,” and then click “Convert weighted Ratio.”

EZ-G1 for Hikon G1 Gonfocal Microscope — G1 Spi

le  Configure BEEIEM Launcher Macro Tools VBA  Windc

~ Analyze 3 @
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The weighted ratio conversion macro starts.

Gonvert Weighted Ratio E]

Mumerator Ch 1 »| Denominator Ch = -
Min 0.1 Max =0

Mask pixels darker than

64 1 ol
Mask pixels brighter than
4096 il 1]

T 3 - [v Add Saturation Indicator

Close

Specify each setting and press the [Convert] button to show a ratio image that has calculated values of the
weighted ratio operation.

CAUTION

When the Weighted ratio calculation method is used, image data is output as RGB 24 bits data after
calculation. Therefore, no ratio information remains in the image data after calculation. And no ratio
analysis can be performed using “Spots.”

Note

[Numerator Ch]: Specify a channel that is used for the numerator data. This channel can be set
freely. Not only the channel that was specified as the numerator at the time of acquisition but also all
channel can be set here.

[Denominator Ch]: Specify a channel that is used for the denominator data. This channel can be set
freely. Not only the channel that was specified as the denominator at the time of acquisition but also
all channel can be set here.

[Min]: Specify the minimum value of ratios for the look-up table.

[Max]: Specify the maximum value of ratios for the look-up table.

[Mask pixels darker than]: When brightness of a pixel is darker than this value, the pixel is set as
black in the Weighted ratio calculation.

This option is used to remove background noise.

[Mask pixels brighter than]: When brightness of a pixel is darker than this value, the pixel is set as
black in the Weighted ratio calculation.

This option is used to remove pixels that have saturated values (or that have values near saturation).
[LUT]: Select a look-up table that has the suitable weighting values for pixels. Six look-up tables are
available. They have a different gamma correction curve.

[Add Saturation Indicator]: This check box is checked to display special colors of pixels that have
values less than “Min” or larger than “Max.” When this check box is not checked, the pixel that has a
smaller value than “Min” is displayed the same color as that of the “Min” value and the pixel that has a
larger value than “Max” is displayed the same color as that of the “Max” value. When this check box is
checked, the pixel that has a smaller value than “Min” is displayed as cyan and the pixel that has a
larger value than “Max” is displayed as pink.

[Close] button: Press this button to stop and abort the macro.

[Convert] button: Press this button to start the weighted ratio operation.
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A.4 Multipoint Time-lapse Macro

The multipoint time-lapse macro is used to capture images at several arbitrary positions with specified
time-lapse settings.

The multipoint time-lapse macro is available with the following hardware and functions.

Motorized XY stage for Ti-E microscope

- Prior Proscan2 motorized XY stage

- Perfect Focus System
- Interlock operation with observation modes of “Average,” “Channel Series,” and “Z-Stack.”
Images can be acquired in the following four sequences.
1) [Multi-Point ] — Time Series

2) Frame Ch — [ Multi-Point ] — Time Series
3) Z-Stack — [ Multi-Point ] — Time Series
4) Frame Ch — Z-Stack — [ Multi-Point] — Time Series

- Normal mode and spectrum mode

CAUTION
The settings for each observation mode ("Average,” “Channel Series,” or “Z-Stack” mode) are specified in
EZ-C1 (not in this macro).

1 Specify devices

The multipoint time-lapse macro supports the following devices:

Ml Line Channel

Wl Average
Ml Frame Ch
Wl Z-stack

Images are acquired
in the following order:

W Time - Z-stack, Multi-Point,

Time Series

Devices supporting [Multi Point Timelapse using XY-Stage Control] and [Multi Point Timelapse in field of view]

- Ti-E microscope + Motorized XY stage

- TE2000-E microscope + Prior ProScan2 XY Stage without Z-Drive
- TE2000-U/S microscope + Prior ProScan2 XY Stage without Z-Drive

Devices supporting [Multi Point Timelapse in field of view] only
- 90i microscope
- Z-drive RFA (when using a manual microscope)

Configure Devices

Configuration
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Figure A.4-1
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In case of using the TE2000 microscope, connect the PC, microscope, and Prior ProScan 2 motorized XY
stage, and then select “Microscope TE2000-E” and “Prior ProScan without Z-Drive” on the Configure Devices
dialog box.

Configure Devices |7|
GCenfguration:
| =
Device Type Wendor
[l Claia Serjas Imetlacl
» Canfocal Gl T Nikon
[ 1% Micrescope Ti-E | microscope + 2-drive Hikon :
] Microscops TE2000=U/5 micrascope Mikcom B
Ll Microsoops TE2000-E micrascope + z-drive Mikon
| Microzcops E1000 microscope + 2-drive Nikon
1 Z-drive RFA z-drive Hikom
= boqure scqusiton-base -
» 3D Viswaleation wisualization -
# Launchar launcher -
1 Price ProScan 0 withowt Z-Drive stage Prior
€ >
[ Fesd Only Defaults | | Cancal | ok |

In case of using the Ti-E microscope, connect the PC, microscope, and motorized XY stage, and then select
“Microscope Ti-E” on the Configure Devices dialog box.

CAUTION
When the Nikon Perfect Focus System (PFS) is used with the Ti-E, the “Z-Stack” settings have
special limitations.
1. The PFS does not work with the “Z-Drive” function together.
2. When an image is captured using the “Z-Stack” function, the focusing control on the PFS will be
released.

2 Load the multipoint time-lapse macro
For loading the macro file, refer to the head description of “A Experiment Sequence Macro.”

Note

- The Multipoint Time-lapse macro file is provided on the CD-ROM disc. This macro is installed together
with the EZ-C1 application software if the application software is installed using the EZ-C1’s
integrated installer (All EZ-C1 3.90 Project).
The file is installed in a folder named Program Files\Nikon\Shared\Projects.

3 Run the multipoint time-lapse application software

Select “MultiPoint” on the “Time Lapse” menu.
N

Time Lapse Todls

MultiPaint

- When a motorized XY stage is connected, the screen for multipoint time-lapse mode selection is displayed.
Select [Multi Point Timelapse using XY-Stage Control] or [Multi Point Timelapse in field of view].
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Select Multi Point mode

Tulki Point Timelapse using #-Stage Control

Multi Paint Timelapse in figld of view

Multi Point Timelapse using XY-Stage Control.: Enables observation of points coordinated to XY stage

movement.
Multi Point Timelapse in field of view: The XY stage remains fixed, and multi-point observation in
the field of view is enabled.
CAUTION
- If a motorized XY stage is not connected, [Multi Point Timelapse in field of view] is automatically
initiated.

- The multipoint time-lapse macro can be used in the standard mode and the spectrum mode. But, the
multipoint time-lapse macro does not detect the mode change between the standard mode and the
spectrum mode when running. Therefore, if the mode is changed, the macro issues a warning
message and is aborted. To restore the system, select the menu and start the macro again.

Do not run another macro when the multipoint time-lapse macro is running.

4 Image capturing setting
The dialog box below appears when the multipoint time-lapse macro starts.

Multi Point TimeLapzse

Current Position Field Stikching
%: 0.00 1 H: 0 =
Mamorize =
¥: 0.00 ¥ add ~:--J <
0.00

H Overlap | O ]

Stage Contral  Setup |

Eaze FileName
Memorized Postions (x,v,z) ;
" | " | v | z | Tem JW‘“ | Location_
Path
| C:¥lmages J
Ded all |
Load | Save L1 »

Rounds g | | |

Interval [# s Fast as possble
o A ¢

Ver 1.20.025

In the Setup tab in the image capturing settings, you can specify the destination folder and file name for
acquired time-lapse images. Use the “Stage Control” tab to control the XY stage. (With “Multi Point Timelapse
in field of view,” the observation area moves within the field of view.)

210




A Experiment Sequence Macro

(1) Setup tab to save images (2) Stage Control tab
Stage Conbrol  38tup | Stage Contral ]5&tup|
Parning Control
fase Flehiame -4+— Destination and name
| Locatan_ fields
Path - ' ’
| Ci¥images o XY stage control —pm - g
buttons
w § w“
Lower B
. . SEpE
Distance adjustment —M & Feid zoom Pl 143
i i
™ Trerementsl

When “Multi Point Timelapse in field of view” is initiated, the corresponding dialog box is displayed at the same
time as the Navigation window. Use both to specify observation points.

Note

scan button.

- In the Acquire Settings dialog box, you can also specify lines as observation points by clicking the line

B Havieation

(1) Setup tab to save images
Specify the file name and folder name to save image data.

Name

Function Overview

Base FileName

Enter the file name of the captured time-lapse image.

Path

Enter the folder name with its file path to save files.
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(2) Stage Control tab

Move the stage to specify areas for multipoint observation.

Name

Function Overview

XY stage control button

Move the XY stage with these buttons.

[Upper L]

(Enabled only when
using Multi Point
Timelapse using
XY-Stage Control)

Press this button to specify the upper left position in a large area that consists of
many sub-areas. The sub-area has the same size as the area displayed as the
Field zoom area (field of view). When this button is pressed, the current position
of the Field zoom area is set as the upper left position of the large area.

Lpper L ‘%,_“ | _ Field zoom

n [Memorize] in the Field Stitching group

When [Upper L] and [Lower R] are set, the horizontal and vertical area count
are displayed in the H (horizontal direction) and V (vertical direction) of the Field
Stitching area. And the [Memorize] button is enabled.

[Lower R]
(Enabled only when
using Multi Point
Timelapse using
XY-Stage Control)

Press this button to specify the upper left position in a large area that consists
of many sub-areas. The sub-area has the same size as the area displayed as
the Field zoom area. When this button is pressed, the current position of the field
of view is set as the lower right position of the large area. (The current field of
view is included in the large area.)

Lower B

n [Memorize] in the Field Stitching group

When [Upper L] and [Lower R] are set, the horizontal and vertical area counts
are displayed in the H (horizontal direction) and V (vertical direction) of the Field
Stitching area. And the [Memorize] button is enabled.

Field Zoom
(field of view)

When this option is selected, the traveling distance for each click of the XY stage
control buttons is defined as follows:

Full: one sub-area (the size of the Field zoom area)

1/3: one-third distance of a sub-area (the size of the Field zoom area)

Incremental

When this option is selected, the traveling distance for each click of the XY stage
control buttons is specified in micrometers.
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5 Observation point setting
The observation area specified on the stage control tab can be registered as a “Multipoint” area.
In the multipoint time-lapse observation, these registered areas are used. The stage moves to observe each

registered area automatically.

[Memorize] button: Registers the current observation area as a set of observation points. Information
describing the registered points is indicated in the Memorized Positions list. For “Multi
Point Timelapse in field of view,” observation points are specified in the Navigation

window.
[Save] button: Save the registered area data into a file.
Current Position
by 106,08 m H n f =
W -106.03 W: 1} lﬂl <
I 2,00 Crierlap u] ¥
Memarized Positions (x,y,2)
# [x [v [z [[them | vahe
M1 oo 0.00 -0.50 G40 0.00  0.00 E 0.00 B,

E2 0608 106.08 0,50 Ciffsmt 127, 127, 127, 119
B3 10608 -106.08 -0.50 Lasar 0,00 %, <1, 0,00 %, 0.0

Field Pos (106.1 um, -106.1 L
A4 1ws08  -10608 200 Steps (512, 512), Dwell 2

PF5 -

fverage  False, Count 3

Frame Ch False

Line Ch  Faks

I5tack  Fales, Top 0,00 um, Btm
GoTo | Delete E e |Lh-:|atu

Load | Save | Show slloants | ¢ >

When you are registering observation points for “Multi Point Timelapse in field of view” using the Navigation
window, the Points window is displayed for viewing the scan area.
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Name Function Overview

Current Position area
The scan start point (upper left) of the current Field zoom area (field of view) is displayed in the X, Y, and Z
field.

[Memorize] Press this button to register the point to acquire image data. The current Field
zoom area data and the settings of each observation mode are registered into
the “Memorized Positions” list.

n Data registered with the “Memorize” function

Position (X, Y, Z)

Laser power

Gain value

Offset value

Offset position of the PFS (only when PFS is used)

Field zoom area data (X, Y position, Steps, Dwell Time)

Average information (mode on/off, Count)

Frame Lambda information (mode on/off, setting to each pass)

Z-Stack data (mode on/off, Top, Reference, Bottom position)

Line Mode

Laser & Detector setting (during the Spectral mode)

Spot on Live Window (only for stage moving multipoint)

Field Stitching area
This area is provided to specify a large area that has sub-areas. One sub-area is the same size as the
current Field zoom area (field of view).
In the H and V field, total counts of sub-areas are displayed.

K | = Memorize | This button is used to register points that are used to specify a large area

(Enabled only when consisting of sub-areas.

using Multi Point To specify how to arrange the square areas, select the [Memorize] button in
Timelapse using registration.

XY-Stage Control) n The memorize function is enabled only when the large area is defined with

the [Upper L] and [Lower R] buttons on the stage control tab.
n Field Stitching functions are not available with the macro for “Multi Point
Timelapse in field of view.

Overlap Specify the extent of overlap of scan areas when points are arranged in a tiled
display.

—— Owerlap(¥)

Memorized Positions (X,Y,Z) area
In this area, points for the multipoint observation and data of each point are displayed.

Check box When the check box of a position is checked, an observation is performed at the
position in the multipoint time-lapse observation.

On: observed point

Off: not observed point
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[Goto] Move the stage to the position where the cursor is sitting.
Registered conditions to observe an image are also restored.

[Delete] Delete the position where the cursor is sitting.
[Del All] Delete all registered positions.
[Update] Overwrite the registered data of the position where the cursor is sitting. The

current settings to observe an image are registered in place.

[Load] Load the data file (.pos) of positions and restore the conditions.

n Files you save when using an XY stage in multipoint observation can only
be loaded when you start multipoint observation using an XY stage.
Similarly, files you save in multipoint observation in the field of view can
only be loaded for multipoint observation in the field of view.

[Save] Save the registered data into a file (.pos).

[Show all points] When “Multi Point Timelapse in field of view” is active, scan areas for stored
(Enabled only when using | positions are displayed in the Points window.

Muilti Point Timelapse in
field of view)

CAUTION

- If positions of the stage are reset or registered again, saved X, Y, and Z potions in the file cannot be
restored any more. Be careful.

- Display of the scan area in the Points window is based on the initial view magnification of the
Navigation window. Thus, keep in mind that if you change the view magnification of the Navigation
window (in Zoom) before switching to another display area, the scan area of stored positions cannot
be accurately reproduced.

- Frame Lambda observation settings for point information file saved with Ver1.40 or earlier of
Multipoint Macro cannot be reproduced with EZ-C1 Ver3.90. (Frame Lambda observation settings can
be reproduced for point information files saved with Ver1.40.)
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6 Time-lapse setting
Specify time-lapse settings for a multipoint observation. Time interval (Interval) and repeat count (Rounds) for
positions can be set.

Rounds |3—

Inkerval [" &s Fast as possible
0 H Ml 3

Name Function Overview

Rounds Specify the photographing count

As fast as possible Repeat the image capturing as fast as possible.

Interval Specify the time interval between image capturing sequences.
n The “Interval” value is the time interval from the start point of one
observation sequence to the start point of another observation sequence.

7 Data acquisition control
Start the multipoint time-lapse observation.

Press the [Start] button to start an observation sequence. Observations of registered points are performed
sequentially.

If the [Pause] button is clicked during the observation sequence, the observation is stopped temporally. During
the temporal stop, settings of observation points can be changed.

Skart | FPause | Skop |

Name Function Overview
[Start] Start the time-lapse observation.
[Pause] Stop the observation temporally.

n Observation position data update

The observation position data can be updated with the “Update” function of the
“Memorized Positions” list. The registered data of the position where the cursor
is sitting in the “Memorized Positions” list is overwritten. The current settings to
observe an image are registered in place.

[Stop] Abort the time-lapse observation.
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A.5 FRET Sequence Macro

To perform the fluorescence resonance energy transfer (FRET) sequence macro perform the following.

1 Load the FRET Sequence macro

For loading the macro file, refer to the head description of “A Experiment Sequence Macro.”

Note

- The FRET sequence macro file is provided on the CD-ROM disc. This macro is installed together with
the EZ-C1 application software if the application software is installed using the EZ-C1’s integrated
installer (All EZ-C1 3.90 Project).
The file is installed in a folder named “Program Files\Nikon\Shared\Projects.”

2 Start the FRET application software
On the FRET menu, click on the “FRET Wizard.”

ﬁ EZ-G1 for Hikon G1 Gonfocal Microscope - G1-L

Eile  Configure  Data BEEAM Launcher Macro  Spectral 1

sas| 2|2, )| Bjofv A

CAUTION
- The FRET sequence macro can be used in the standard mode and the spectrum mode.
- Do not run another macro when the FRET sequence macro is running.

3 Perform the FRET experiment
To capture images for the calculation of the FRET efficiency, select the “Acquisition” option. And click the
[Next>>] button.
To calculate the FRET efficiency of existing FRET experiment data, select the “Analysis” option.

zl

% Acquisition

" Analysis

Folder
|—C:¥Tmp¥FRETImages¥ Browse |

Note
- For the “Analysis” option, refer to Step 13, FRET data analysis.
- To change the destination for FRET image data, press the [Browse] button.
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4 Experiment settings
Select the experiment setting method to perform the FRET sequence.
To add data to an existing experiment data, select the “Stored FRET Setup” option.
To create new settings, select the “New FRET Setup” option. When this option is selected, lasers to excite a
specimen and the acquisition channels must be specified.

X

<< Previous | MNext »> |

Note
- When the “stored FRET Setup” option is selected, the below dialog box appears. Select the
experiment name to be used and press the [To Acquisition] button. Go to Step 10, “Capture the

“Donor” image.”

Stored FRET Setup —> Select x|

— Folder

C¥Tmp¥FRETImages¥

— Conkent

Extra Info | Parametersl

Setup | Lser I Drate |
TestOG0S08-1  a7363 2006/05/...
Test060505-2 47363 2006/05/...
| | i

Refresh |

<< Previous | To Acquisition |

5 Select the setting method
When the “New FRET Setup” option is selected, a new setting can be created.
When the “Based on current setup” option is selected, an existing setting in EZ-C1 is used as a base to create
a new setting.
When the “Based on stored setup” is selected, a saved setting is used as a base to create a new setting.

x

Create Mew Wavelength Setup

(* Based on current setup

" Based on stored setup

<< Previous I Mext > =
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Note

Mew FRET Waveleneth Setup —> &

— Folder New FRET Wavelenett
Ci¥Tmp¥FRETImages¥

Refreshl Delete |

— Content
Extra Info | Parametersl
Setup | Liser | Drate | o
TestOG0S08-1 a7363  2006/05/08... Ad
TestOG0S08-2 a7363  2006/05/08... Ad
< | D

<< Previous | To Edit Setup |

- When the “Based on stored setup” option is selected, the below dialog box appears. Select the
experiment name to be used and press the [To Edit Setup] button.

[Extra Info]: Edit the settings of the experiment.

[Delete]: Delete the experiment settings.
[Parameters]: Verify the parameters used in the experiment.

[Refresh]: Refresh the experiment names in the specified folder.

i

¥,
User

Date 1/3/2006 3:47:57 PM

Comment

‘Add 2 comment

3

Microscope Setup FRET Wavelength Setup.
Parameters  Value Parameters Value
X Field -1 mm Dener Exataton........ 308
X Steps 25 ‘Accepior Excitation 561
¥ Steps 256 Donor Emission 510 520
Gan 113 Acceptor Emissen 560 1 640
Resolution
ShortWavelen 510
Previous

n To import FRET image data or settings of an experiment in other folder, copy the whole required

folder to the specified folder. (Image data is saved to the folder specified in step 9 “Save the
settings”.)
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6 Specify the lasers to excite a specimen and the channel to acquire data
Specify the lasers to excite a specimen and the channels to acquire data.

Specify the laser to excite the “Donor” and the laser to excite the “Acceptor.”
Specify the channel that is used for the “Donor” fluorescence and the channel that is used for the “Acceptor”
fluorescence.

Edit FRET Waveleneth Setup 1'
Donor Acceptor
Laser I laser 2:488nm j I laser 3:543.5nrj

Detector I hi j | chz |

Mext ==

7 Specify the data acquisition setting method
Specify the data acquisition setting method.
To use the settings in EZ-C1, select the “Current setup of microscope” option.
To use the currently selected experiment settings, select the “Setting stored with current FRET setup.”
Following settings are copied: X field (field zoom of the field of view), X step (pixel count in the X-direction), Y
step (pixel count in the Y-direction), Gain, Resolution of the spectrum detector, shortest wavelength of the
spectrum detector.

Microscope setup ll

Select microscope setup

(' Settings stored with current FRET setup

<< Previous Mext > =

Note

- When the “Current setup of microscope” is selected and gain settings for the donor and the acceptor
are different in Step 8. “Test the setting,” the gain setting for the donor will be applied to the gain
setting for the acceptor.
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8 Test the settings
Test the settings to acquire images of the “Donor” and “Acceptor.”
To show the “Donor” image, press the [Test Donor] button. You can adjust the laser power and gain here. To
finish the “Donor” image, press the [Stop Capturing] button.
To show the “Acceptor” image, press the [Test Acceptor] button. To finish the “Acceptor” image, press the [Stop
Capturing] button.
x|

Test Donor | Test Acceptor |

Stop Capturing |

Here you can test acquisition settings.
‘fou should modify the gain settings
such that the captured images are not
saturated.

Test Donor: acquires an image using
selected settings for Donor laser,

Test Acceptor: acquires a n image using
selected settings for Acceptor laser,

<< Previous |

9 Save the settings

Save the settings into a file. Enter its name into the entry.

Save Setup x|
Sawve Setup as
’V | Testt

Choose Folder
’7C:¥Tmp¥FRETImages¥ Browse |

<< Previous Mext >

Note
- To change the destination for FRET image data, press the [Browse] button.
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10 Capture the “Donor” image
Capture the “Donor” image.
On the “Donor Sample” tab, press the [Acquire] button. An image excited by the “Donor” laser and an image
excited by the “Acceptor” laser is captured. If necessary, multiple images can be captured.

Acquisition: test [ |
Doner Sample Iacceptor sample | ERET Sample |
— Donar Sample

<< Previous | MNext => |

11 Capture the “Acceptor” image
Capture the “Acceptor” image.
On the “Acceptor Sample” tab, press the [Acquire] button. An image excited by the “Donor” laser and an image
excited by the “Acceptor” laser is captured. If necessary, multiple images can be captured.

AzpeRidisnee . abic 1 . ,.“J

Donar Sample  docepter Sample | ERET Sample |
— mwm....._—.... — e

s | [ poe |

coprevos | estsn |
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12 Capture the FRET image
Capture the FRET image.
On the “FRET Sample” tab, press the [Acquire] button. An image excited by the “Donor” laser and an image
excited by the “Acceptor” laser is captured. If necessary, multiple images can be captured.
To calculate the FRET efficiency using the captured images, press the [Next>>] button.

Boquisition: test

Denor sample | Arceptor Sample FRET Samole |
Fret Sanpbe

ey ]

= Pravious | Mexk == ]

Note
- When the [Next>>] button is pressed, go to Step 17. And calculate the FRET efficiency.

13 Analyze the FRET data
Analyze the FRET data.

x

£ Acquisition

— Folder

C¥Tmp¥FRETIMagesY Browse |

Mext => |
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14 Select the experiment

Select the experiment for the FRET efficiency. And then, press the [To Analysis] button.

Stored FRET Setup —> Select FR

— Folder

X

C:¥Tmp¥FRETImages¥

Erowse

— Cantent

Extra Info |

Parameters |

Setup | Llser | Date

ICc

Test0e05038-1
Test060505-2

4]

27363 2006/05/08...
a7363  Z006/05/05...

Ac
Ac

o

ReFreshl Delete |

< = Previous | To Analysis |

Note
Each button works as follows:

settings”.)

[Delete]: Delete the experiment settings.
[Parameters]: Verify the parameters used in the experiment.

[Extra Info]: Edit the settings of the experiment.

c1
User

1/3/2006 3:47:57 B0

Date

Comment

‘Add a comment.

Ok

x|

Microscope Setup

Parameters

FRET Setup

value Parameters value

X Field

X Steps

¥ Steps

Gain
Resolution
ShortWavelen

-1 mm
256
256
113

Dener Exdtaton . 4a8
Acceptor Exctation 561
Donor Emission 510 : 520

Acceptor Emission 580 : 640
5
510

Previous

[Refresh]: Refresh the experiment names in the specified folder.

n To import FRET image data or settings of an experiment in other folder, copy the whole required
folder to the specified folder. (Image data is saved to the folder specified in step 9 “Save the
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15 Select the “Donor” image
Select the “Donor” image used to calculate the FRET efficiency. Two or more images can be selected.

P —— i x|
Donor Samples Iameptor Sample | Fret Samples |

Donor Images: Select reference files

Images | Fd/Dd |
¥ Donord Images 0.125128588796232

Fdipd= | ©.125128588796232

Prewvious |

16 Select the “Acceptor” image
Select the “Acceptor” image used to calculate the FRET efficiency. Two or more images can be selected.

Analysis: test = ]
Donor Samples  Acceptor Sample | Fret samples |

Acceptor Images: Select reference files

| Fa [ Aa
Iv! Acceptord  Images 1
O Acceptorl  Images 3

cdl Acceptor?  Images

<Faffa>= I
/ 1 Fret Analysis Methods

Prewvious |
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17 Calculate the FRET efficiency
Select the FRET image used to calculate the FRET efficiency. Two or more images can be selected.
If necessary, change the “G” or “Thr” parameter. (For these parameters, refer to the following article.)
To calculate the FRET efficiency, press the [Calculate] button. Three types of FRET efficiency are calculated.
An image is created and each result is reflected to the channel data.

Analysis: alex488555 ) x|
Donor Samples | Acceptor Sample  Fret Samples |
— Fret Images
Fret Analysis Methods
¥ Freto Images ﬂ
[V Fret2 Images
¥ Fret3 Images j
— Calculate Effidency
G= I 1.0 Thr=| 4
Calculated Images | FD/Dd|  Fajaa | G|
Fret0_eff51.ids 0.224 0.412 U.DUI—I
Fret2_eff52.ids 0,224 0.412 0.001
‘ll— in rreme P i ,.In,;,
Calculate | Delete
Previous |

At last, the “Donor” image, the “Acceptor” image, the FRET image, and the calculation are displayed.

Donor Samples | Acceptor Sample  Fret Samples |
[~ Fret Images

I Fretd  Imae. |
[ Fret4  Imag. j

’— Calculate Efficiency

@= o The 4 Select All

Caloulated Imsges | FD/Dd | Fa/Aa G4
Fraté off4lids 0145 0416 o

Fretd eff42.ide 0145 oM Tt‘
T sl
M
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18 Display the FRET image

The result of the FRET efficiency calculation is output as three channel images.
Each channel has a different result that was acquired with different calculation method.

Channel No. Algorithm

1 Gordon algorithm

2 Youvan et al method

3 Xia et al calculation algorithm

Channel 1 is displayed in the default setting for the FRET efficiency calculation result. To display another

channel, select the channel on the Color tab in the “View Settings” dialog box.

Info  Golor I\f\ew ISDUIS Ot Interast] Iio  Golor ]ViEW |
Golor Made:  [Multi Chanrel Pseudo Colar v | Galor Mode:  |Single Charnel LUT |
Options: [~ Add saturation indicator Golor Assignment:
Channel LUT
Intensity Scaling Channel Golor | I T m—— j
Tnitey
Channel: 1
Goarse:
Giordon “fouvan Xia % Best
| I [Zset
3 —_—T
@ Fire:
¥ Apply to 1] Image Data Walues 1
& Mumber all Views
[ 3 it
of Calors: Py Dark Level i} -
r . Saturation 0 I;
Eright
Gamma 1.0 I

Parameters used in the FRET efficiency
+ G: System Constant G

The Gordon algorithm requires a system constant G. This constant determines the
scaling of the FRET image. The actual value of the G constant depends on the spectral
properties of the dyes, the ratio of the laser intensities and the ratio of the detector
sensitivities and is best determined experimentally. Typical values are between 1 and
0.01. When samples have been measured with a known FRET efficiency, the G
constant can be changed until the calculated FRET image shows the correct values.

» Thr: Threshold

The Threshold percentages indicate which darker fraction of the pixels is ignored
during the calculations. Dark pixels feature a higher signal to noise level than brighter
pixels and can result in a noisy result image. For the Reference image, a typical value
for the threshold is 20 %. The best sample reference threshold depends on the
intensity of the sample images and varies between 1 to 10 %. Increase this value if the
FRET image has noisy areas.

Click on the Calculate button to start the calculations and an image is generated with
FRET efficiency results. FRET efficiency will be calculated for files that are checked in
FRET Sample images box. The name of generated FRET efficiency image contains
the name of original FRET Sample files that has been used for efficiency calculation.
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Naming rule of images
A new folder, FRETImages, is created in the folder where the FRET sequence macro is installed. Images
are saved in this folder. Create an “experiment name” folder in the FRETImages folder and save images
into it.

“Donor,” “Acceptor,” and FRET images are named and saved as follows:

Image filename

Donor Donor<X>_Donor.ids
Donor<X>_Acceptor.ids
Acceptor Acceptor<X>_Donor.ids
Acceptor<X>_Acceptor.ids
Fret Fret<X>_Donor.ids

Fret<X>_Acceptor.ids

Here, <X> means a number created by the system. And the character string after the
underscore (_), Donor or Acceptor, represents the laser type used to capture the image.

The result image of the FRET efficiency calculation is named and saved as follows:

Image filename

Fret Fret<X>_eff<Y>.ids

Here, Fret<X> means the FRET image and <Y> means a number created by the system.

To import a FRET image from other system

- Copy the whole folder that has the “experiment name” for its name under <FRET macro
folder>/FRETImages/ of the old system to the same location of the new system. The FRET sequence
macro searches the folder at the next start-up and detects the new imported data.

Reference:

- Gordon, G.W., Berry, G., Liang, X.H., Levine, B., Herman,B. Quantitative Fluorescence
Resonance Energy Transfer Measurements Using Fluorescence Microscopy. Biophysical
Journal 47: 2702-2713 (1998)

- M. Balzar Quantitative Measurements Of FRET Using Standard Confocal Fluorescence Microscopy
(2006)
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A.6 Colocalization Macro

Follow these steps for colocalization analysis.

1 Load the Colocalization macro

For loading the macro file, refer to the head description of “A Experiment Sequence Macro.”

Note

- The colocalizaiton macro file is provided on the CD-ROM disc. This macro is installed together with
the EZ-C1 application software if the application software is installed using the EZ-C1’s integrated
installer (All EZ-C1 3.90 Project).
The file is installed in a folder named “Program Files\Nikon\Shared\Projects.”

2 Run the Colocalization macro

After selecting and activating the window of the image for colocalization analysis, choose Data > Analyze >
Colocalize.

CAUTION

- The Colocalization macro can be used on data with two or more channels. (For example, standard
data, spectral data, and unmix data.)

- Do not execute other macro applications when the Colocalization macro is running.

E EZ-G1 for Nikon Gl Gonfocal Microscope — G

File ERAF FRET Launcher
— T

|;:I_I_In % H ot I Diztance o

| )
TL ﬁ’ ,El Calculate Hiztogram

~  Filter ¥ Spectra

Configure Macra

The Colocalization dialog box and Scatter Plot window are displayed.

GH Scatter Plot G1-Live

Golocalization 1.0.27.787 | W_I'Z._!'_uarm
aoo

Erable | ones | canesd | |

Settings | annotations | Threshold | Factors | Time Coarse |

cha  Fom [N o [N
e rom [ o N2
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3 Display the spatial distribution of the colocalized data

3-1 Select two channels

On the Settings tab, select two channels of the image for colocalization analysis. To select, move both

slider bars.
Enable | Once | Cancel |
Annotations ] Threshald ] Factors ] Time Coarse ]
cha From - To -
chB From - To -
| : [— — :
‘ 1 2 3 4
| | | |
Note
A continuous channel region can be selected for the spectral data by expanding or shrinking the slider
bar.

Jettings ]nnnotations | Threshald | Facters |

cha Fram - Ta - 500.01 :549.76 nm
chE Fram - Ta - 504,53 164925 nm

3-2 Display the Scatter Plot

In the Colocalization dialog box, click the [Once] or [Enable] button to plot the data for all pixels of the
image in the Scatter Plot window. The intensity of both channels is plotted on the axes.

once |
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L8 Scatter, Plot G1-Live

Chann
1000
500

1000

Note

(a) If an image representing Z-stack data was selected, data for all slices is plotted in one Scatter Plot
window.

(b) If an image representing Time Series data was selected, data for each stack (for each T) is plotted.

---tn

(a) Z-stack data (b) Time Series data

- [Enable] button: Target and simultaneously update the data currently being acquired.

3-3 Display the spatial distribution for the colocalized data

On the Annotations tab, specify a sector. In the Scatter Plot window, specify the colocalized region.
Clicking the [Add Sector] button displays the sector in the Scatter Plot window. Use the mouse to adjust
the central angle and sector angle, as desired.

Selecting “Back Annotate Overlay” displays the colocalized data superimposed on the image. Plotted data
in the sector (and over the threshold) is displayed as colocalized data.
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Golocalization 1.0.27.787 3

Enable | Once | Cancel | |
Settings Threshold ] Factors ] Time Coarse ]
[v Back Annotate Crverlay Brightness: 30 ﬂ J j
add Seckar | Sector | Sector dnele | Gentral Ane.. | Timel | Time2 [1
1 45.00 45.00 0.3a 0.3a C

Remaove Seckor
Propetkies

B Scatter Plot G1-Live E@E B C1-Live

Note

- Back Annotate overlay:
Overlays the colocalized data on the target image. Plot data within the sector (and
over the threshold) will be displayed as the colocalized data.

- Brightness: Sets the density (%) for overalying the colocalized data.

- [Add Sector]: Displays a sector on the Scatter Plot window to specify the colocalized area. Use
the mouse to adjust the central and acute angles.

- [Remove Sector]: Click to remove selected sectors in the list.

- [Properties]: Click to specify a color and label for selected sectors in the list. The distribution of
colocalized data will be displayed in the same color as the sector.

- If an image representing Time Series data was selected, the proportion of pixels in each sector (and
over the threshold) in each set of stack data is displayed on the Annotations tab. (Time N = number of
pixels in the sector that are over the threshold / number of pixels over the threshold)

| Time2 | Time3 | Timed | TimeS | Times | Time? |
024 024 024 025 000 OOl

- Save: Images for which a spatial distribution of colocalized data is displayed can be saved as TIFF
(bitmap) or bitmap format. The content of Scatter Plot windows can be saved in IDS or TIFF
(RAW) format.
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4 Obtain the colocalization factor

4-1 Specify the threshold

On the Threshold tab, specify the intensity threshold value for each channel. (The same threshold setting
also applies to the spatial distribution of colocalized data.)

Golocalization 1.0.27.787

Enable | once | Cancel | |
Settings ] Annotations Factars ] Time Coarse ]

Channel &
T 2
0% 100%:
| z0 W | 819 Inktensity Lnits
Channel B
T 2
0% 100%:
| z0 W | 819 Inktensity Lnits

CH Scatter Plot G1-Live

4-2 Obtain the factor

On the Factors tab, obtain the correlation coefficient for Pearson, Manders A, Manders B, and Manders’s
Overlap.
If desired, click the [Export Data] button to export this data as a text file.

Golocalization 1.0.27_787

Enable | Once | Cancel | |

Settings ] Annotations ] Threshold ~ Factors lTime Coatse ]

Export Data

(=R RN (R, VY
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Note
(a) If animage representing Z-stack data was selected, the calculation applies to all slice data at once.

(b) If animage representing Time Series data was selected, the calculation applies to data for each stack

(for each T). Trends during the time of each factor are also shown on the graph. (Red: Pearson;
Green: Manders A; Blue: Manders B)

Golocalization 1.0.27.787

Enabls | once | Cancel | |
Settings ] &nnotations ] Threshaold ]

Tirne: | Pearsan | MandersH{A) | MandersH(E) | Owverlap | Manderss MandersE
1 0.343 1.189 0.531 0.794 0.869 0.379

(a) Z-stack data

Golocalization 1.0.27.787

Enable | Once | Cancel | |

Settings ] Annokations ] Threshold Time Coarse ]
Expork Data

Time | Pearson | MandersH{A) | MandersHiB) | Overlap

[+

fMandersd MandersB

0,521 1.374 0,340
2 0.521 1.375 0.513 0,547 0,543 0,362
3 0.526 1.374 0.516 0,540 0.847 0,340

Golocalization 1.0.27.787

Enable | Once | Cancel | |

Settings ] Annotakions ] Threshold ] Factors

MandersH{E) MandersE

Pearson MandersH{A)

Factors

Coeffg

Tirne

(b) Times Series data
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A.7 AutoGain Macro

The AutoGain macro automatically adjusts gain so that brightness becomes optimum for observing images.

1 Load the AutoGain macro

For loading the macro file, refer to the head description of “A Experiment Sequence Macro.”

Note

- The AutoGain macro file is provided on the CD-ROM disc. This macro is installed together with the
EZ-C1 application software if the application software is installed using the EZ-C1’s integrated
installer (All EZ-C1 3.90 Project).
The file is installed in a folder named “Program Files\Nikon\Shared\Projects.”

2 Start the AutoGain macro

Select [AutoGain] from the [Macro] menu.

SimpleGUl  Spect
4Ex4Em
AutoGain
Channel Tiled
Channel Untiled
[d= to Tiff Conwvert
Switch

The AutoGain main frame appears.

AutoGam 1.0.10

Gain Cptimization Settings
Skatus: Idle
Name Function Overview
[Gain Optimization] Press this button to adjust a gain of Detector Channel, which validates the

update, to an optimum value.

n Laser Power

When the shutter-opened laser power is set to "Min," the power is first adjusted
to an appropriate value, and then gain adjustment is started.

[Settings] The main frame is expanded and AutoGain setting items are displayed.
Status Results of gain adjustment are displayed.

CAUTION
= The AutoGain macro adjusts gain with 2D(XY) scanning. Therefore, if sequence modes (Line
Lambda, Average, Fr Lambda, Z-Stack, and Time) are set to ON when the AutoGain macro is
started, all sequence modes automatically switches to Off.
When the AutoGain macro is finished, settings of the sequence modes return to the settings when
the macro was started.
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3 AutoGain setting

After the [Settings] button is selected, a threshold value for completing gain adjustment processing can be set
on the [Settings] tab of the acquisition setting. On the [Calibration] tab, gain calculation adjustment coefficient
measurement is performed during gain adjustment and coefficients used for gain calculation are selected.

ButoGain 1.0.8 ]
Gain Ciptimzation Sektings LogHstery [
Status: [de
Settings | Calbeation | Sattngs  Calibration |
aimed Ratio of Saturated Piels Current Calbrakion
Lozt Highest
| e d FMT | Calbrat_ |
| 0.001 | 0.008 Spectral 00000
Pivels | 55 | 53
Akl Ratia
— e I Extksting Calibration Daka
B Bid & Bural .. 3
PMT Calibrat.. | Dala U
Spectraliain 000071 [ET I [User |
Clear Record | Clear All Measure Mew Calbration
Calibration Steps
il =0
(1) Settings tab
Name

Function Overview

Aimed Ratio of

Target ratio of saturated pixels to the total pixels is set for adjusting gain.
Saturated Pixels

Gain adjustment is finished when the above setting is satisfied.

Actual Ratio List

The ratio of saturated pixels when gain adjustment is finished is displayed.
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(2) Calibration tab

Name

Function Overview

Current Calibration List

Calibration data used for gain adjustment is displayed.

Existing Calibration
Data List

Measured calibration data is displayed.

When the check box is checked, its data is used for gain adjustment.

n Calibration data

When check boxes of multiple calibration data are checked, the average value of
checked data is used as calibration data.

[Clear Record]

Data selected in the current calibration list is deleted.

[Clear All]

All data in the current calibration list is deleted.

[Measure New
Calibration]

Calibration is performed.

Calibration Steps

A measurement data-acquisition count used for calibration measurement is set.
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A.8 Z-stack Intensity Control Macro

This function allows you to observe Z-stack while changing the laser power. Setting the laser power beforehand
for multiple slices to observe a thick sample enables Z-stack observation with the laser power suited for the depth
of each slice. Blight data can be acquired even at a slice far from the objective.

In addition, this function allows you to save the setting conditions and reuse them.

Execute the Z-stack Intensity Control macro using the following procedure.

1 Load the Z-stack Intensity Control macro

For loading the macro file, refer to the head description of “A Experiment Sequence Macro.”

Note

- Z-stack Intensity Control macro file is provided on the CD-ROM disc. These macro files are installed
together with the EZ-C1 application software if the application software is installed using the EZ-C1°s
integrated installer (All EZ-C1 3.90 Project).
The file is installed in a folder named Program Files\Nikon\Shared\Projects.

2 Run the Z-stack Intensity Control macro

Choose “Z Intensity Control” in the macro menu.

CAUTION
- Do not execute other macro applications when the Z-stack Intensity Control macro is running.

SimpleGll  Spect
AutoGain

2 Channel Tiled
Channel Untiled
Ide to Tiff Conwert
Switch
Tiff Series Export

Z Intenzity Control
T —_———]

“Z Intensity Control” dialog box opens.

Z Intensity Control Yer1.1.11 [Newl PS__<|
Index Z Potison 637 nm 403 nm 458 nm 47
Top Memorize
| >
¥ synchronize Clear Load
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3 Set the top position

Select the “Top” checkbox in the Z-Stack tab of the EZ-C1, and control the Z stage to determine the top
position in the Z-stack mode. Then the Z position of the top position is reflected in the macro.

®r ] Line Lambda] PNEI’&EE] Frame Lambda £ ]Time ]
Z-drive RF&
€ (P Rt 000 i‘ Pasition 1500 um
[r:' (1 Top —15.00] Sz 4=
Step Size 5.00 um=-] M
™ [ Eottom [ ] Ranee 2000 um=]
[ Index 1 j Filz Size B389 MB
Z Intensity Gontrol Yer1.1.11 [Newl [5__<|
Index £ Potison 637 nm 408 nm 458 nm 47
Top Memorize
2| -10.00 um
3| -5.00 um
Bottom 0.00 um
<) >
W synchronize Clear ‘ Load

4 Set laser power for the top position

Adjust the laser power in the Laser Control Bar dialog box concurrently with live observation with the Z
position set to “Top.” Set proper laser power and press the [Memorize] button of the macro. Then the laser
power is reflected in each “Laser” column of the Top position.

Laser Control Bar =

Monitor
Eleach: | Mone Al | Ih spots | Out Spots| Series: -E all
408 [ B0 ﬂ J ﬂ ol —
a57 [ Min ﬂ_| ﬂ ol
76 [ Min ﬂ_| ﬂ ol —
188 [ o0 ﬂ J ﬂ c
514 [ Min ﬂ_| ﬂ ol —
51 [ Min ﬂ_| ﬂ ol —
R s XTI vl —

Z Intensity Gontrol Yer1.1.11 [New]

um Memarize

um

-10.00
-5.00
0.00

um
Lim

Bottom

<)

¥ Synchronize Clear Load
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5 Set the bottom position

Select the “Bottom” checkbox in the Z-Stack tab of the EZ-C1, and control the Z stage to determine the
bottom position in the Z-stack mode. Then the bottom position and the Z position at each slice position that is
set at intervals of Steps are reflected in the macro.

HY ] Line Lambda] Hverage] Frame Lambda Z lTime ]
F-drive RFA

[ Ref 000 g ~| Position 2500 um

o () Top =T Steps . =
— Step Size BO0um=] M |
[f: 37 Bottom - | PRanee 4600 um—]

 [T] hdex 8  ~| FileSize 718574 MB

Z Intensity Gontrol Yer1.1.11 [New] r‘s_(|
Index Z Potison 637 nm 408 nm 458 nm 47
Top -15.00 um 7% 5 % 0.00 % 8] Memorize
2| -10.00 um
3| -5.00 um
4 0.00 um
5 5.00 um
6] 10,00 um
7| 1500 um
8| 20,00 um
< >
¥ synchronize Clear ‘ Load ‘ ‘

6 Set laser power for the bottom position

Adjust the laser power in the Laser Control Bar dialog box concurrently with live observation with the Z
position set to “Bottom.” Set proper laser power and press the [Memorize] button of the macro. Then the laser
power is reflected in each “Laser” column of the Bottom position.

Bleach: ,W Al | In spots | Out Spots| Series: .E MDnngr
403 [ ®0% ﬂ J j ol
457 [ Min ﬂ_| j ol
476 [ Min ﬂ_| j o
483 [ 450% ﬂ J ﬂ ol
514 [ Min ﬂ_| j ol
51 [ Min ﬂ_| j ol I
537 [ 120% ﬂ J j ol
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Z Intensity Control Yer1.1.11 [New] r's_(|
Index Z Potison 637 nm 408 nm 458 nm 47
Top -15.00 um 7% 5 % 0.00 % 8] Memorize
2| -10.00 um T
3| -5.00 um
4 0.00 um Interpolate
5 3,00 um
6] 10,00 um
7| 1500 um
8l 2000 um
[ Bottom [Se=sHul
<)
¥ synchronize Clear ‘ Load ‘

7 Set laser power for arbitrary Z positions

Select the “Synchronize” checkbox in the macro and then click the “Index” column to control the Z stage to
determine arbitrary Z positions in the Z-stack mode. (The Z stage can also be controlled by selecting the
“Synchronize” checkbox and clicking the “Index” column.)

Adjust the laser power in the Laser Control Bar dialog box concurrently with live observation at the selected Z
positions. Set proper laser power and press the [Memorize] button of the macro. Then the laser power is
reflected in each “Laser” column of the selected Z positions.

Set two or more arbitrary Z positions.

Z Intensity Gontrol Yer1.1.11 [Ne

Index Z Paotizon 637 nm
Top -15.00 um 7.00 %
| ———2] -10.00 um
) -5.00 um
34| 000 um
5 5.00 um
10.00 um
15.00 um
20.00 um

L]

(=i

o0 [~

25.00

< |
o

Laser Gontrol Bar 3]
Idonitor

Bleach: ,W Al | In spots | Out Spots| Series: .E all
403 [ 99% ﬂ J ol
487 [ Min ﬂ_| ol
476 [ Min ﬂ_| ol
484 [ 0% ﬂ J ol
514 [ Min ﬂ_| ol
51 [ Min j_| ol
637 [ 9% ﬂ J T

BB
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Z Intensity Control Yer1.1.11 [Newl PS__<|
Index Z Potison 637 nm 408 nm 458 nm 47 |
Top -15.00 um 7% 5 % 0.00 % 8] Memorize

1000 um [

-5.00 0 0 0 ]
000 um Interpolate

2
3
T
5 5.00 um
4]
7
g

10.00 um

15.00 um

20.00 um
Bottom 25.00 um 12 % 35 % 0.00 % u]
<) Ed
¥ synchronize Clear Load

« » . i
- Set “two or more” arbitrary Z positions.
Z Intensity Gontrol Ver1.1.11 [New] 3
Index Z Potison 637 nm 408 nm 498 nm 47
Top -15.00 um T % 5% 0,00 % 1} Memarize
1000 1m
[ 3| -5.00 um 10 % 10 % 0.00 % DJ
oo o Interpolate ‘
S SO0
[ ] 10.00 um 0 ]

15,00 um

8| 20.00 um
Bottom | 2500 um 12 % 35 % 0.00 % o
3| 3
¥ Synchronize Clear | Load | ‘

- To select an arbitrary Z position, click the Index column in the macro window. Do not use the
“Synchronize” checkbox in the Z-stack tab of EZ-C1.

8 Interpolation calculation

Press the [Interpolate] button to calculate curve interpolation using the set laser poser at Z positions. As a
result, the laser power of all unset Z positions is set.

Z Intensity Gontrol Yer1.1.11 [New]

Index £ Potison 637 nm 408 nm 438 nm 47

Top -15.00 um 7.00 % 5.00 % 0.00 % u} Memarize
2| -10.00 um 8.69 % G6.62 % 0.00 % u]
3| -5.00 um 10,00 % 10,00 % 0.00 % IR e
4] 000 um| 10.67%| 1622% 000% O ﬂ i llis
= 5.00 um 10,90 % 23.65 % 0.00 % u]
6| 10.00 um 11.00 % 30,00 % 0.00 % u]
7| 15.00 um 11.23 % 33.54 % 0.00 % u]
8| 20,00 um 11.58 % 34.83 % 0.00 % u]

Bottom 25,00 um 12,00 % 35.00 % 0.00 % u]

£ L) >

_ _ Skark

IV Synchronize Clear Load Save
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9 Start Z-stack observation

Press the [Start] button to perform Z-stack observation while changing the laser power according to the
setting. The Volume window for Z-stack data opens with the captured image.

Z Intensity Gontrol Yer1.1.11 [Newl g|
Index £ Potison 637 nm 408 nm 458 nm 47
Top -15.00 um 7.00 % 5.00 % 0.00 % u] Memotize
2| -10,00 um 58.69 % 5.62 % 0.00 % u]
3| -5.00 um 10,00 % 10,00 % 0.00 % u]
4| 0,00 um| 1087 %| 1622 % 0.00 % 0 Inme e |
5 5.00 um 10,90 % 23.65 % 0.00 % u]
6 10.00 um 11.00 % 30,00 % 0.00 % u]
7| 1500 um 11,23 % 33.54 % 0.00 % u]
8| 20,00 um 11.58 % 34.83 % 0.00 % u]
Bottom | 23.00 um 12,00 % 35,00 % 0,00 % u]
‘ N
W synchronize Clear Load Save ‘

CAUTION
- The Intensity Control setting of the set Z-stack can be saved and reused.
[Save]: Saves the current settings in a file with extension .zpm.
[Load]: Re-sets the saved settings. All settings including the Z-stack setting and the laser power
setting of each Z position are restored.
- All settings can be completely cleared.
[Clear]: Clears the current settings completely.

Note

- Z-stack observation can be used together with other observation modes.
Set an observation, e.g. Average, Frame Lambda Series, and Time Series using the Acquire Settings
dialog box. Then press the [Start] button on the macro to start Z-stack interlocking with the modes.

Live idle

Sinele 7 tverage 0/4
¥ e | Q2 78

Cilear I Time 0/2

- When Z-stack observation is started using macro, the “Trigger” checkbox is set to ON by default.
When the macro stops, it is set to OFF automatically.
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A.9 Tiff Series Export Macro

This function allows to serially save all channel data as Tiff data with the “1-Channel 8-Bit or 1-Channel 16-Bit”
format by batch processing. For 3D and 4D data, they can be serially saved as Tiff data with the “Bitmap” format
by batch processing.

Use the following procedure to perform “Tiff Series Export”:

1 Load the Tiff Series Export macro

For loading the macro file, refer to the head description of “A Experiment Sequence Macro.”

Note

- The Tiff Series Export macro file is provided on the CD-ROM disc. This macro is installed together
with the EZ-C1 application software if the application software is installed using the EZ-C1’s
integrated installer (All EZ-C1 3.90 Project).
The file is installed in a folder named Program Files\Nikon\Shared\Projects.

2 Start the Tiff Series Export macro

Make a window, in which the target images to be serially saved with a Tiff format exist, active and then select

[Tiff Series Export] from the Macro menu.

CAUTION

- The target images can also be changed after the Tiff Series Export macro is started.
- While the Tiff Series Export macro is running, do not start any other macro application.

% EZ-—G1 for Hikon G1 Gonfocal Microscope — G1-Live

File Gonfigure Data  Launcher BUEEEGEN Spectral  Tools

D"5-|n|§| ? | ;@| |? Channel Tiled

—  Channel Untiled
Id= to Tiff Convert
Suitch

Titf Series Export

The Tiff Series Export dialog box appears.

Tiff Series Export 2.02

Windowe 4o

| C1 Spectral Live Vokame | Time Series | -
Directary

| co#program FiesskondFor TESTEIFE J
Filetgarme:

[ Testient

Save Format
{=" it Gray TiFf (Series of Ch_Z_T)
" 16bit Gray TiFF (Series of Ch_Z_T)
Data Corpeersion Mode:
Scalle Brightest Data Yalue ;E

(" Bitmap Tiff  (Series of Z_T) ok,

canced
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3 Confirm target images
Confirm the target images to be serially saved. Other window which is currently opened can be selected from

the pull-down menu.
When the target images are 3D or 4D, all data is saved by batch processing.

Tiff Series Export 2.02

Windawe 40
| €1 Spectral Live Vokme | Time Series 1 -]

4 Specify a saving destination and a file name

To serially save images, set a save destination and file name.

Titft Series Export 2.02

Window 4D
| <1 Spectral Live Value | Time Series | =l
,B"E\'-bl’?
| co¥pragram Files¥hikanieor TESTETIFE M:]J
FieMame
|| Testisba

5 Set the Tiff format

To serially save images, set a Tiff format.
Select an appropriate format from “8bit Gray Tiff,” “16bit Gray Tiff,” and “Bitmap Tiff.”

Tiff Serizs Export 2.02

Window 10

[ 1 Specteal Live volume | Time Series | =l
Directary

| co#Program Files¥hkoriFor TESTETIFFE _..—ll
Filetame

| Testieh

Save Format
(¢ gbit Gray Tiff (Series of Ch_Z_T)

" 16bit Gray TiFF (Series of Ch_Z_T)

Data Corrversion Mode:
canced
| Scabe Brightest Diata Yakue ;f
ak,

" Bitmap Tiff  (Series of Z_T)
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Note

- 8bit Gray Tiff: Save all channel data in the 8 bit Gray Tiff format. When the target images are 3D
or 4D, they are saved serially in the order of z, t, and ch.

- 16bit Gray Tiff: Save all channel data in the 16 bit Gray Tiff format. When the target images are 3D
or 4D, they are saved serially in the order of z, t, and ch.

- Data Conversion Mode: Set the method for converting data into 8-bit data or 16-bit data.

Scale Brightest Data Value: Data is adjusted based on the brightest data so that the dynamic
range fits in 8-bit or 16-bit.

Scale Full Range: By truncating (adding) lower four bits of (to) 12-bit data, the 12-bit
data is converted to the 8 bit (16-bit) data.
- Bitmap Tiff: Save all slice data in Bitmap format. They are saved serially in the order of z and t.

6 Serially Saving

Press the [OK] button to serially save images with a Tiff format.
k.,

Note
- When the “8bit Gray Tiff” or “16bit Gray Tiff” format is used, each dimensional data is expressed in the
format of “file name_chN_tN_zN.tif.”
Examples of saved data:
XXX_ch1_t1_z1.tif
XXX_ch1_t1_z2 tif
XXX_ch1_t1_z3.tif
XXX_ch1_t2_z1.tif
XXX_ch1_t2_z2 tif
XXX_ch1_t2_z3.tif
XXX_ch2_t1_z1.tif
XXX_ch2_t1_z2 tif
XXX_ch2_t1_z3.tif
- When the “Bitmap Tiff” format is used, each dimensional data is expressed in the format of “file
name_tN_zN.tif.”
Examples of saved data:
XXX _t1_z1.tif
XXX _t1_2z2 tif
XXX_t2_z1.tif
XXX_t2_z2 tif
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A.10 SimpleGUI Macro

SimpleGUI is an application for easy image acquisition using C1 or C1si systems. This application is used to
observe images of specimens obtained using the 1 excitation 1 emission ratio sequence macro, and consists of
functions necessary for image acquisition and minimum setting items.

The application supports the following functions in a GUI, integrating each in a series of steps:
- Optical path setting — field of view setting — brightness setting — image acquisition setting — image
acquisition

Compatible hardware is as follows.

- Ti-E microscope

- TE2000-E microscope

- |-Series microscope

- Z-drive RFA
Prior ProScan Il XY Stage without Z-Drive
Perfect Focus System

CAUTION
This section solely describes how to start the program. For details on SimpleGUI functions, see the Help
file in the SimpleGUI program.

1 Operate environment
Use the following version of EZ-C1 when using SimpleGUI.

- EZ-C1: Ver. 3.90 or later

Note
- Complete the required hardware-related settings beforehand in the Configure menu of EZ-C1.

2 Load Simple GUI macro

For loading the macro file, refer to the head description of “A Experiment Sequence Macro.”

Note

- The Simple GUI macro file is provided on the CD-ROM disc. This macro is installed together with the
EZ-C1 application software if the application software is installed using the EZ-C1's integrated
installer (All EZ-C1 3.90 Project).
The file is installed in a folder named Program Files\Nikon\Shared\Projects.
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3 Run the SimpleGUI macro

In the [SimpleGUI] menu of EZ-C1, select [SimpleGUI].

=18

Help
Profile k

SimpleGLI

After you start the SimpleGUI macro, the following screen is displayed.

Config  Hawi  Intensity  Acqure

ot i

For details on SimpleGUI functions, see the Help command in the [SimpleGUI] menu.

4 End the SimpleGUI macro

To end SimpleGUI, click the [Close] button in the Main dialog box of SimpleGUI.
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A.11 Thumbnailler

Thumbnailler is a standalone application that can be used independently of EZ-C1 or EZ-C1 Viewer.
The application supports the following functions.

Thumbnail list: Displays image data acquired by EZ-C1 as thumbnails.
Detailed information: Displays details of image files in IDS format.
Reuse functions: Applies hardware settings at the time of image data acquisition of selected files for reuse
by EZ-C1.
CAUTION

This section solely describes how to start the program. For details on Thumbnailler functions, see the
Help file in the Thumbnailler program.

1 Operate environment

Use the following version of EZ-C1 or EZ-C1 Viewer when using Thumbnailler.
- EZ-C1: Ver. 3.90 or later
- EZ-C1 Viewer: Ver. 3.90 or later

2 Load the Thumbnailler launch macro
For loading the macro file, refer to the head description of “A Experiment Sequence Macro.”
Note
- The Thumbnailler software is provided on the CD-ROM disc. The Thumbnailler launch macro is
installed together with the EZ-C1 application software if the application software is installed using the

EZ-C1's integrated installer (All EZ-C1 3.90 Project).
The file is installed in a folder named Program Files\Nikon\Shared\Projects.

The [Thumbnailler] button is added to the EZ-C1 toolbar buttons.
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3 Start Thumbnailler

To start Thumbnailler from EZ-C1, click the [Thumbnailler] button in EZ-C1. To start Thumbnailler as a
stand-alone application, click the Windows [Start] button and select Programs > Nikon > EZ-C1 Thumbnailler,
or double-click the EZ-C1 Thumbnailler icon on the desktop.

The following dialog box is displayed.

) GFP_YFP_RFP_ex488 543 Snm.ids - EZ-G1 Thumbnailler
Eile Edit Miew Toolz Help
E E G E D il @ Bddress (C¥Documents and Settings¥aB8215%¥My Documents¥EZ-C1¥ime¥ j
& TANT A Section Data ~
B ¥ -4 File
+ _ﬁ a5 A F FD (A Ei:egamat %:¥Documents and Settings¥ab2 bdM.
g —H, T : ileForma ids
R .F';_' ﬁ;';b?w o DateTime Thursday, Novermber 04, 2004 170116
-
5 BIOS Image
+-{5) COMPAG SB‘its jlé[‘IJIF\vIB
= FE ize
1D Confie i ) CreateDate Tuesday, October 26, 2004 150305
=5 Documents and Settings N5 WRezolution 512 picel
=3 6215 el ; YResolution 512 pixel
) freemind A Dimenzion 20
Channels 32 ch

+-5) gimp-20

+ ) MirtualBox TotallaserPow.. 00 %

+-5) Application Data Software
i Mame EZ-C1
Vergion Silver Version 232 build 354
15 My Suoicuments e
Al Detectar
Application Tvpe Standard 2
EZ-C1 DemaCarnbmp dchid.ids Transmitted Out ¥
03 4EX4EM 266 x 267 512 x 512 - )| G
3 bmp < ¥ Z-stack ] ']I'imeSeries J T‘r'Slage aLL
=) GLEM v Objective Average ChannelSeries
< = 1 15 141 Filz ] Image ] Software ] Laser ] Detector ] Scanner ]

GC¥Documents and Settings¥a3215¥My Documents¥EZ-C1¥img¥GFP_YFP_RFP 15 /18

For details on Thumbnailler functions, see the Help file in the Thumbnailler program.

4 End Thumbnailler

To end Thumbnailler, select File > Exit in the Thumbnailler program.
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Data File Formats

The supported file formats include:

*.ics/*.ids: Image Cytometric Data File Format: (see B.1)
* tiff/*.tif. Adobe Tagged Image File Format (see B.2)
*.avi: Audio Video Interleaved Format (see B.3)

*.bmp: Windows Bitmap (see B.4)

* xls: Excel Worksheet (see B.5)

*.txt: Ascii Text Format (see B.6)

B.1 Image Cytometric Structure

The ics format was presented by Ph. Dean et al. in Cytometric 11:561-569 (1990). An ics image is stored in two
files. One file is written in ASCII to include information about the format of the image data and optionally,
information about the sample, experiment, equipment etc. The extension of the ASCII file is ics. The image data
are written separately into a binary file. The extension of the binary file is ids. EZ-C1 uses the ics format as the
default image format. All data types used in EZ-C1 can be stored in the ics format without loss of information.

B.2 Adobe Tagged Image File Format

The Tagged Image File Format —known as TIFF— was developed by Aldus which has now merged with Adobe
Systems. The Tiff format is a versatile format that can handle all bitmapped images. Few programs are able to
read all supported formats. However, most programs do support the 24-bits RGB format. For the highest level of
compatibility, check the RGB format on the “Options” of “Save As” dialog box (see 4.1.5.2).

B.3 Audio Video Interleaved Format

The Microsoft Audio Video Interleaved Format (avi) is capable of storing a sequence of bitmap images that can
be played with the Microsoft Media Player at a present frame rate. To store a 3D image in the avi format, select
the *.avi format in the Save As dialog box and press the [Options...] button to specify the frame rate (see 4.1.5.4).
The avi format stores images up to 3 channels and 8-bits accuracy without loss of information. However, the
image descriptions tags (see 4.1.9) are not stored.

B.4 Windows Bitmap File Format

The Microsoft Bitmap Format (bmp) can be used to save the image as it appears on the screen. The format of
the image equals the characteristics of the active window.
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B.5 Excel Worksheet

Excel Worksheet is a spreadsheet format used by Microsoft Excel. Some restrictions apply with this format: it is
only possible to secure data for up to 255 columns. For this reason, images obtained by the EZ-C1 which have
data larger than 255 pixels cannot be saved in this format. Use this format when saving graphs obtained for a
particular position.

B.6 Ascii Text Format

The Ascii Text Format can be use to edit plain dos text files. This file format is used for the report files. In addition,
the integrated text editor can be used to view and edit the .ics files that describe the ics image format.
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Troubleshooting

The EZ-C1 does not start.

[Cause] The program file is corrupted.
Following instructions in this manual, re-install the EZ-C1 and configure the software.

The image does not appear.

[Cause 1] Not connected to the network.

A. Check whether the system is connected to the network.
Follow the procedure described below to check whether the system is connected to

the network.

1. Select “Start” — “Programs” — “Accessories” and then execute “Command Prompt”.

2. Execute the following command from the command prompt.
Ping 192.168.255.254
If results such as shown in the Figure C-1 are displayed, the system is connected to the
network. If the system is connected to the network, go to [CauseZ2]. If the system is not
connected to the network, continue beginning with Solution B to re-connect.

c+| Command Prompt

C:w>ping 172.168.255.254
Pinging 192 _.168_.255.254 with 32 bytes of data:

Reply from 192.168.255.254: hytes=32 timed<ims TTL=255G
Reply from 192_.168.255_.254: bhytes=32 time<ims TTL=255%
Reply from 192.168.255.254: hytes=32 time<ims TTL=25L5
Reply from 192.168.255.254: hytes=32 time<ims TTL=255

Ping statistics for 192.168.255.254:
Packets: Sent = 4. Received = 4. Lost = 8 (8X loss>.

-
Approximate round trip times in milli-seconds:
Hinimum = Bms. Maximum = Bms. Average = Bms

RS-

Figure C-1 Result of Ping command
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Check that the “ready” lamp on the controller is lit.
Check that the Power lamp is lit. The controller is not turned on if the Power lamp is not
lit. Check the condition of the power cord connection and the Power switch.

Check whether the network card is functioning.

Some network card may have a lamp on the board that flashes during communications.
Look at the board through the rear of the PC and check if this lamp is flashing.

If you can confirm that the lamp is flashing, go to Solution F. If you cannot confirm that it
is flashing, go to Solution D.

Check that the network card driver is correctly installed.
Use the following procedure to check whether the network card driver is correctly
installed.

1. Select “Start” — “Settings” — “Control Panel”.

2. Double click “System” on the “Control Panel”, and display the “Hardware” tab on the
dialog box that opens.

3. Click the [Device Manager] button in the middle of the “Hardware” tab.

4. Double click “Network adaptor” on the dialog box which appears as a result of Step 3,
and check whether the network card driver is installed.

The driver has not been installed properly if no driver for the network adaptor is listed on
the “Device Manager” dialog box or if it is listed, but a question mark appears next to it.
Please re-install the driver for the network.

Check whether the LAN cable is securely connected.

Check that the LAN cable is securely connected to the connectors on the computer and
the C1 controller.

If the cable is securely connected, use a different cable and check again if the system is
connected to the network following the instructions in Solution A.

Check the IP addresses of the computer and the controller.
Check the IP addresses of the computer and the controller based on information given
in Chapter 1 of this manual.

[Cause 2] Problem due to over-gain of the photo multiplier.
Check whether the reset button on the Gain bar is flashing red.
If the reset button is flashing red, too much gain is being applied to the illumination level. If
too much gain is being applied to the illumination level, the gain is cut-off to protect the
Photo Multiplier, and the reset button flashes red. Press the reset button to reset the gain
value to “0”, and set a new value for the gain.

[Cause 3] The laser box switch is not turned on.
Check the power and switch setting of the laser box.

[Cause 4] The pinhole is not stopping in the correct location.
It is possible that the pinhole is not stopping in the correct location.
You can hear a catching sound when the pinhole stops in the correct location as the
protrusion on the pinhole catches on the stopper. If you cannot hear this sound, adjust the
movement of the pinhole according to the following procedure.

1.

A Sl

Open the “Pinhole” tab.

Set the “Break Delay” mode to “manual setting”.

Change the “Break Delay” value.

Change the size of the pinhole using the “Laser and Detector” tool bar.

Check that the catching sound occurs and that the pinhole stops in the correct location.
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[Cause 5] The channel is turned OFF.
Check whether the channel is turned off.
Use Channel in the Standard Detector tab in the Configure Confocal C1 dialog box or the
Channel settings in the Color tab in the View Settings dialog box to check.

The image is rough.

[Cause] The illumination is not enough.
Use application settings to increase the gain.
Focus the image.
The illumination may drop drastically if the image is out of focus.
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